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1 Introduction 

1.1 About this Manual 

This manual comprises all important information about MC_Rack. It is assumed that you have 
already a basic understanding of technical and software terms, but no special skills are required  
to read this manual. 

Start practicing with the Tutorial. We offer you the opportunity of Learning by Doing, which 
means that you start directly with practicing without much reading beforehand. We suggest that 
you start MC_Rack and then follow the Guided Tour step by step, either using the integrated Help 
or the printed manual. Just decide what you like to do, read all necessary information in short and 
put this information directly into practice. 

If you need further information or like to review specific topics as an already experienced user, 
please confer to the "MC_Rack Features" part, where you can find more precise information 
about all topics. 

The printed manual and Help are basically the same, so it is up to you which one you will use. 
The Help offers you the advantage of scrolling through the text in a non-linear fashion, picking up 
all information you need, especially if you use the Index, and the Search function. If you are 
going to read larger text passages, however, you may prefer the printed manual. 

The device and the software are part of an ongoing developmental process. Please understand 
that the provided documentation is not always up to date. The latest information can be found 
in the Help. 
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1.2 Terms of Use 

You are free to use MC_Rack for its intended purpose. You agree that you will not decompile, 
reverse engineer, or otherwise attempt to discover the source code of the software. 

1.3 Limitation of Liability 

Multi Channel Systems MCS GmbH makes no guarantee as to the accuracy of any and all tests  
and data generated by the use the MC_Rack software. It is up to the user to use good laboratory 
practice to establish the validity of his findings. 

To the maximum extent permitted by applicable law, in no event shall Multi Channel Systems  
MCS GmbH or its suppliers be liable for any special, incidental, indirect, or consequential damages 
whatsoever (including, without limitation, injuries, damages for data loss, loss of business profits, 
business interruption, loss of business information, or any other pecuniary loss) arising out of the 
use of or inability to use MC_Rack or the provision of or failure to provide Support Services, even 
if Multi Channel Systems MCS GmbH has been advised of the possibility of such damages. 

1.4 Important Safety Advice 

 

Warning: Make sure to read the following advices prior to install or to use MC_Rack. If you do 
not fulfill all requirements stated below, this may lead to malfunctions or breakage of connected 
hardware, or even fatal injuries. Obey always the rules of local regulations and laws. Only 
qualified personnel should be allowed to perform laboratory work. Work according to good 
laboratory practice to obtain best results and to minimize risks. Make always sure to validate your 
findings. Prepare backup copies on a regular basis to avoid data loss. 

 The operator is obliged to ensure that MC_Rack is only be used for its intended purpose and that 
it is only used by qualified personnel. 

 MC_Rack is not intended for medical uses and must not be used on humans, especially not for 
uses that could impair health. 
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2 First Use of MC_Rack 

2.1 Welcome to MC_Rack 

Please read the following paragraphs to understand the general idea behind the MC_Rack 
program before going on with the tutorial or application examples. 

MC_Rack is a data acquisition and analysis software. Combined with the hardware, for example 
MEA2100-System, (USB-) ME-Systems or (USB-) MEA-Systems, it forms a complete data acquisition 
system for measuring extracellular activities of excitable cells, in vitro and in vivo. It has been 
developed especially for use with the (USB-) ME- and the (USB-) MEA-System, but is also ideally 
suited to work with other experimental setups. 

Together with the data acquisition device, MC_Rack fully replaces a complete hardware set for 
data acquisition. For example, you do not need an oscilloscope, a filter, or a spike detector device 
anymore, because all this functions are integral part of the software. You set up a virtual 
instrument rack, which is comfortable, easy to use, and saves space on your workbench. 

The main power of MC_Rack is its great flexibility. You can combine various virtual instruments 
according to your experimental setup. You can decide about the fate of each single data stream 
separately. It is up to you, which data streams are displayed on the screen, which are saved, 
which are analyzed, and so on. This concept saves disk space and computer performance and 
makes handling of up to 256 channels with up to 50 kHz sampling rate easy. A status bar 
informs you on the actual performance of your computer when you record or replay data. 

Please note that the high flexibility of MC_Rack makes a complex configuration of the software 
necessary. As a fresh user of MC_Rack, this may present some difficulties to you. But the 
straightforward user interface will soon make you feel comfortable with the general concept  
and learn to appreciate the advantages of the system. This documentation tries to help you on 
your way. 

It is very important to note, that all virtual instruments in your rack work independently  
from each other. As a consequence, they have to be configured separately. For example,  
you have to select the input streams for each instrument separately. 

Generally, you will arrange the virtual instruments in your rack in a hierarchical order. The 
selected data streams flow from your data acquisition or from the Replayer (recorded data) 
into the virtual instrument highest in the hierarchy. Similar to a production line in a plant, this 
instrument picks up only those channels from the data streams that you have assigned to it.  
It processes this data and produces an output stream that is lead to the virtual instrument(s) next 
in the hierarchy, and so on. When you build a rack, make yourself clear, which data streams flow 
to which instrument and what output you should expect. If you change the selection of channels 
for a virtual instrument, you may have to adjust the selection for instruments that depend on its 
output as well. If you have not specified an input for a tool, an error message will inform you. 

In MC_Rack, the rack you use to record and analyze data online and offline, and the data files are 
as a matter of principle independent from each other. You can save and reuse a rack for several 
experiments and generate separate data files. You can then load the generated data file with 
another rack for further offline analysis later. 
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The MC_Rack help is divided into the following main sections: 

 Step by Step Tutorial: The tutorial introduces basic MC_Rack features for directly setting up  
a basic experiment. 

 MEA (In Vitro) Application Examples (please see separate document): Main MC_Rack features 
are explained in detail on the basis of typical applications and demo data files. We 
recommend to study especially the applications that you are interested in before starting an 
experiment, so that you learn about the possibilities and how to configure MC_Rack for different 
applications. This section is more detailed than the tutorial. Also, it is easier to understand the 
software features when playing around with demo data. 

 MC_Rack Features: All MC_Rack features are explained in detail. This section is especially useful 
if you want to learn more about a specific software feature. 

 Data Export: Summarizes the export options of MC_Rack and MC_DataTool and provides 
recommendations for third party programs for offline data analysis. 

 Troubleshooting: Lists typical minor problems that might occur during operation and gives hints 
how to solve them. 

2.2 Installing MC_Rack 

The data acquisition computer with the data acquisition device, for example MEA2100-Systems or 
USB-MEA256, comes preinstalled and preconfigured by MCS for a flawless operation. You should 
contact your local retailer for assistance if you want to install additional hard- or software, or  
if you want to replace the computer, as incompatibilities of hardware components or software 
settings with MC_Rack may occur. 

Caution: You have acquired a high performance data acquisition and analysis computer. Do not 
modify the system, do not install new hard- or software, or another operating system without 
asking MCS or your local retailer for advice. Especially do not install virus scanners or firewalls 
because these programs are known to interfere with the data transfer to the hard disk.  
MCS cannot guarantee that a modified system is fully operational. Even data loss may occur. 

System requirements 

Software:  

One of the following Microsoft Windows ® operating systems is required: Windows 10, 8.1,  
Windows 7, Vista, or XP (English and German versions supported) with the NT file  
system (NTFS). Other language versions may lead to software errors. 

Hardware:  

The MEA2100-Systems. (Not required for offline analysis or demo mode). The MEA2100-System 
consists of two main devices: The interface board with integrated signal processor and the 
headstage equipped with amplifier, A / D converter and stimulus generator. It is possible to 
connect one headstage only or two headstages to one interface board. If you are dealing with 
two headstages, each headstage can be operated independently by opening the data acquisition 
software MC_Rack for each headstage separately. Recording from up to 240 channels is possible. 

The USB-ME-Systems or the USB-MEA-Systems. (Not required for offline analysis or demo 
mode). These systems are equipped with an internal data acquisition. The analog input signals 
from up to 256 channels are acquired and digitized by the systems and the digital electrode 
signals are transmitted to the connected computer via universal serial bus (High Speed USB 2.0). 

The data acquisition board MC_Card. (Not required for offline analysis or demo mode). If no 
MC_Card is present, MC_Rack opens in a simulation mode. A computer with low performance  
may lead to performance limits more often; therefore, MCS recommends an up-to-date computer.  
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Please note that there are sometimes hardware incompatibilities of the data acquisition and 
computer components; or that an inappropriate computer power supply may lead to artifact 
signals. Please contact your local retailer for more information on recommended computer 
hardware. 

Important: You need to have installed the latest driver to operate the data acquisition device, 
which is automatically installed with MC_Rack. The installation may be invalid if the data 
acquisition device does not respond. Please contact Multi Channel Systems or your local retailer  
in this case. 

Recommended operating system settings 

The following automatic services of the Windows operating system interfere with the data 
storage on the hard disk and can lead to severe performance limits in MC_Rack. These routines 
were designed for use on office computers, but are not very useful for a data acquisition 
computer. 

 Turn off automatic Windows Update. 

 Windows Indexing Service deselected for all local disks. 

 Optimize hard disk when idle (automatic disk fragmentation) turn off. 

 It is also not recommended to run any applications in the background when using MC_Rack. 
Remove all applications from the Autostart folder. 

 Be careful when using a Virus Scanner. These programs are known to disturb MC_Rack,  
and even data loss may occur. 

 When using an USB-ME-System or an USB-MEA-System it is recommended to connect  
a high performance computer with a separate hard disc for program files and data storage.  
The provided possibility to use up to 256 channels with a sample rate of up to 40 kHz needs  
high memory capacity. Please remove data and defragment the hard disc regularly to ensure 
optimal performance. 

 

Warning: The operating system settings of the data acquisition computer were preconfigured  
by MCS and should not be changed by the user. Changing these settings can lead to program 
instabilities and data loss. 

Switching on the connected computer 

(Applicable only if you use a data acquisition computer from Multi Channel Systems.) 

1. Power up the connected computer and wait until it is ready. The Login dialog box appears. 

2. Enter "mcs" both as the user name and as the user password. You do not have to enter an 
administrator password. (You may change the passwords later, of course.) The Windows desktop  
is displayed. 

Installing the software 

Please check the system requirements before you install the software. MCS cannot guarantee  
that the software works properly if these requirements are not fulfilled. 

Important: Please make sure that you have full control over your computer as an administrator. 
Otherwise, it is possible that the installed software does not work properly. 

1. Double-click Setup.exe on the installation volume. The installation assistant will show up  
and guide you through the installation procedure. 

2. Follow the instructions of the installation assistant. The hardware driver and MC_Rack are 
installed (or updated) automatically. 
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3 Step by Step Tutorial 

3.1 Using the Step by Step Tutorial 

In the following tutorial, you will set up virtual racks for different applications from scratch.  
The goal is that you learn about MC_Rack features by doing. The racks are quite simple to give 
you an idea of the software's philosophy and how things work. All racks described in the tutorial 
are also available on the installation volume. So, if you prefer to start with a preconfigured rack, 
you can load the rack of interest first, and then go through this tutorial to see how to adapt the 
rack's settings and parameters to your needs, but we recommend that you take a bit time to build 
it yourself to learn the principle of operation. 

Both racks discussed in the Step by Step Tutorial are basic racks for monitoring and recording 
data. The only difference is, that Monitoring and Recording Activity Continuously describes how 
to monitor and record activity continuously (generally used for spontaneous activity). Monitoring 
and Recording Triggered Activity describes how to monitor and record activity triggered by an 
event, that is, for evoked responses, for example, in an LTP experiment. All important information 
is repeated in each section, so you may freely choose the rack that is suitable for your application 
without missing information. 

The difference to the MEA application examples (see separate document) is that the racks that  
we set up in this tutorial can be used directly in a real experiment. Without demo data, they may 
appear somehow a bit abstract. If you are new to the extracellular recording technique and want 
to get an impression how MC_Rack works and how signals can look like, you may prefer to have a 
look at the MEA application examples and demo racks first. Also, in the MEA application examples 
section, more advanced MC_Rack features are explained in detail and very near to the application. 

You will find a list and a short description of all sample racks in the MC_Rack Sample Racks topic. 

The MEA Signal Generator 

The MEA Signal Generator MEA–SG is a convenient tool for MEA-Systems first time users.  
The device has the same dimensions and connector layout as a 60-channel MEA chip and is 
compatible with all MEA1060 amplifier types and with the MEA2100-60 / MEA2100-2x60-Systems. 
The MEA–SG can produce sine waves, or replay a variety of biological signals. These signals are 
fed into the MEA amplifier as analog signals. With this artificial data, you are able to test the 
functionality of the hardware and software system, without the need for a biological sample. 
Please use the 256MEA-SG for the USB-MEA256-System and the 120MEA-SG for MEA2100-120-
Systems. 
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3.2 Monitoring and Recording Activity 

3.2.1 Starting MC_Rack 

 Double-click the MC_Rack icon or select MC_Rack from the Start menu. 
The program starts. One window opens automatically. This is your virtual rack configuration, 
which is blank after program start. Therefore, most commands and buttons are unavailable. 
You can choose from various software features, so-called virtual instruments, and assemble the 
virtual rack according to your specific application. You will learn in this tutorial how to set up 
racks for some typical applications. 

MC_Rack main window (empty) 

 

The virtual rack 

The title bar shows the file name of the virtual rack (the default name before saving the rack 
under a custom name is Rack1). The white pane on the left of the virtual rack window holds  
the virtual rack tree view pane, where all virtual instruments that are part of this rack are 
represented by icons and (customizable) individual instrument names. 

After program start, the virtual rack is almost empty. It holds only a single virtual instrument the 
Recorder, represented by a small cassette player icon. The context-sensitive grey pane on the 
right shows the virtual instrument settings (organized in tab pages) of the virtual instrument 
that is selected (highlighted in blue) in the virtual rack tree view pane on the left. If you have 
added more instruments to the rack, you were able to click through the instruments in the tree 
view pane, and click the tabbed pages to review or change any settings. 

At this point, only the Recorder settings are available. The first Rack tabbed page is always  
the same for all virtual instruments here, you can start and stop MC_Rack (that is, the data 
acquisition or the Replayer), and activate the recording (that is, writing data to hard disk). 

The Lag status bar gives you information on the computer performance; the lower the Lag,  
the better the performance. When the Lag exceeds the maximum, MC_Rack will be stopped 
automatically, and you will be informed about a performance limit of the computer by an error 
message. The complexity limit of the virtual rack depends directly on the computer performance. 
To avoid data loss during over night recordings, for example, test the rack configuration 
thoroughly under realistic conditions (that is, the signal rate should be as expected in the real 
experiment) before starting the experiment. If you have trouble with the computer performance, 
please see the chapter Error Messages in the Troubleshooting section for more information on 
how to optimize the rack configuration. 
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In the Recorder settings, you select the data streams and channels that you want to save to the 
hard disk. You define the path and the file in which the acquired data will be saved, and you 
define other parameters like the recording mode (continuous or triggered), and the maximum 
file size. 

The Recorder shows you the currently available disk space on the target hard disk. Please check 
the disk space and estimate how long you still can write data to the hard disk always before 
starting an experiment. Otherwise, data loss will occur when the disk is full. For example, if you 
record 60 electrode channels at a sampling frequency of 25 kHz, the data rate is 3 MB/s, that is 
10.8 GB/h. 

 

MC_Rack toolbar. For more detailed information on the toolbar buttons, please see "Toolbar" 
under General User Interface. 

The MC_Rack toolbar shows all main functions available in MC_Rack. You can click on a virtual 
instrument button to insert a virtual instrument into your rack configuration. Please note  
that virtual instruments that need an input data stream that is generated by another virtual 
instrument (for example, the Spike Analyzer, which needs a Spike data stream generated by  
the Spike Sorter) can only be placed in series with the required virtual instrument and are 
otherwise not available (indicated by a gray button color). In an empty rack, only the data source, 
that is, the data acquisition or the replayer, are available to start with. After the data source 
was inserted into the rack, other virtual instruments will be available. 

3.2.2 Defining the Data Source 

MC_Rack is the universal data analysis program for all ME- and MEA-Systems with PCI card as  
well as with USB based data acquisition. To ensure correct display of the data of your system,  
it is therefore necessary to configure the data source accordingly. This has to be done only once 
for a given rack. See the MEA-System manual or the ME-System manual for the MC_Rack features 
that are supported by your system. 

On the Edit menu, click Data Source Setup to configure the software according to your data 
acquisition and amplifier hardware. Data Source Setup is only available as long as no data 
source is included in a new rack file. Configure the channel layout first and then set up the  
rack for your experiment. The data source setup and channel layout information is saved  
together with the rack. 
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MEA60-System 

Select 2 dimensional (MEA) if you are performing extracellular recordings from microelectrode 
arrays (MEA) with a MEA60-System with 60 electrode channels. The number and layout of 
channels is pre-configured and cannot be altered. You have three additional analog channels  
(A1, A2, A3), and an additional 16-bit digital channel available. The standard BNC connectors for 
the digital channel on the data acquisition computer support only three digital input bits (0, 1, 2). 
A digital IN / OUT extension is available that supports all 16 digital in- and output bits.  
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MEA120-System 

Select 2 dimensional (MEA) if you are performing extracellular recordings from microelectrode 
arrays (MEA) with a MEA120-System with 120 electrode channels. The number and layout of 
channels is pre-configured and cannot be altered. The MC_Card supports seven additional analog 
channels, but the BNC connectors on the data acquisition computer support only 3 additional 
analog channels (A1, A2, A3). You have an additional 16-bit digital channel available. The 
standard BNC connectors for the digital channel on the data acquisition computer support only 
three digital input bits (0, 1, 2). A digital IN/OUT extension is available that supports all 16 digital 
in-and output bits.  
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ME-Systems 

Select 1 dimensional if you are using a ME-System (generally used for in vivo or special in vitro 
applications). ME-Systems are available with different channel numbers. Define the number  
of channels provided by the data acquisition (MC_Card or USB-ME), and specify how many 
electrodes (data amplified by the main amplifiers, for example, a MPA and a following filter 
amplifier) and how many analog inputs (for example, from a temperature controller or  
a microphone) are present. For the electrode channels, the original signal is calculated 
automatically according to the gain settings in MC_Rack. Signals on the analog channels  
are recorded "as is", with no respect to the gain. 

Deselect the option Digital Input Channel, if you do not want to use the digital input channel. 
One of the digital input bits can be used for triggering the recording on a TTL output of the 
stimulator, for example. A typical configuration of a ME64-System would be 63 electrodes and  
a digital channel. Please note that the use of the digital input channel is available on the cost  
of an analog channel, that is, if you have an ME16-System and want to use the digital channel,  
for example for synchronizing stimulation and recording, you could only use a maximum of 15 
electrode channels. Make sure that you select the digital channel if you want to trigger the data 
analysis and/or the recording. 

Hint: Deselect the option Digital Input Channel, if you do not need a digital channel. Otherwise 
the number of electrode recording channels is reduced by 1! 
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Data Source Configuration 

Click "Configuration".  

Configuration is an option that can also be used with MC_Card data acquisition (64 or 128 
channels), but is recommended for the USB based data acquisition systems USB-ME64 / USB-
ME/128 / USB-ME256 or MEA2100-System. When selecting the configuration option, it is first 
necessary to adjust the number of channels available. After that you can select the amplifier(s) 
and MEA(s) in use from a drop down menu. To configure the MEA layout, please use the right 
drop down menu "MEA". To configure the amplifier, please use the left drop down menu "Amp" 
(MEA1060 without blanking circuit, gain factor 1200, and MEA1060BC with blanking circuit, gain 
factor 1100 for MEA-Systems, and FA64I/S, FA32I/S for ME-Systems, MEA2100-H60 or MEA2100-
H120 for MEA2100-System). 
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In MEA120-System it is possible to configure both amplifiers independent of each other. 
Additionally it is possible to configure the MEA layouts of MEA A and MEA B individually. 

Note: Setting up the configuration of the data source is important for having the correct layouts 
for MEA A and MEA B during the complete experiment. 
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USB-ME16-FAI-System 

The USB-ME16-FAI System uses an internal data acquisition. Data can be transferred via USB 2.0 
port to any data acquisition computer. Please see USB-ME16-FAI Manual for detailed information. 
Select USB-MEA from the left Data Source drop down list. The USB-MEA device will be specified 
on the right Data Source drop down menu: USB-ME16 (S/N: 00001). The number in brackets is the 
serial number of the device. The data source layout is 1 dimensional, with 16 electrode channels, 
and an additional digital channel. 
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USB-ME32-FAI-System 

The USB-ME32-FAI System uses an internal data acquisition. Data can be transferred via USB 2.0 
port to any computer. Please see USB-ME32-FAI Manual for detailed information. Select USB-MEA 
from the left Data Source drop down list. The USB-MEA device will be specified on the right Data 
Source drop down menu: USB-ME32 (S/N: 00001). The number in brackets is the serial number of 
the device. The data source layout is 1 dimensional, with 32 electrode channels, and an additional 
digital channel. 
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USB-ME64 / USB-ME128 / USB-ME256 Data Acquisition 

The USB-ME64 / 128 / 256 data acquisition systems are in principle the same devices, except  
for the total number of channels. 

USB-ME256 Data Acquisition 

The USB-ME256 is an external data acquisition device that uses USB 2.0 connection to transfer 
digitized data to any connected computer. Please see USB-ME256-System manual for detailed 
information. Select USB-MEA from the left Data Source drop down list. The USB MEA device  
will be specified on the right Data Source drop down menu: USB-ME256 (S/N: 0004). The number 
in brackets is the serial number of the device. Adjust the number of channels available. 
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Click Configuration in Source Layout. Choose 256 as total number of channels from the drop down 
list under No. of Channels. 

 

In USB-ME256-System it is possible to configure four MEA1060 / MEA1060BC amplifiers 
independent of each other. Click the Amplifier drop down menus on the left side. Additionally  
it is possible to configure the MEA layouts for up to four MEAs A and B, C and D independent  
of each other. Click the MEA drop down menus on the right side. 
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On the Edit menu, click Advanced Configuration to configure the software according to the  
USB-ME256 hardware. Please see Advanced Configuration for detailed information. The dialog 
Advanced Configuration is for optionally defining as many instances of MC_Rack software  
as necessary. That means, you are able to work with several MC_Rack versions in parallel, for 
example, when using the USB-ME256 with up to four MEA1060 amplifiers. With setting "Max. 
Number of MC_Rack Instances = 4" in Advanced Configuration you can control each of the four 
amplifiers independent from the others with its own MC_Rack software. 

Note: Setting up the configuration of the data source is important for having the correct layouts 
for MEA A, B, C and D during the complete experiment. 

USB-ME128 Data Acquisition 

The USB-ME128 device is in principle the same device as the USB-ME256, except for the total 
number of channels that is 128.  

The USB-ME128 is an external data acquisition device that uses USB 2.0 connection to transfer 
digitized data to any connected computer. Please see USB-ME128 Manual for detailed 
information. Select USB MEA from the Data Source drop down list. The USB MEA device will  
be specified on the right Data Source drop down menu: USB-ME128 (S/N: 0002), for example.  
The number in brackets is the serial number of the device. 

In USB-ME128-System it is possible to configure two MEA1060 / MEA1060BC amplifiers 
independent of each other. Additionally it is possible to configure the MEA layouts for MEA A  
and MEA B independent of each other.  

On the Edit menu, click Advanced Configuration to configure the software according to the  
USB-ME128 hardware. The dialog Advanced Configuration is for optionally defining as many 
instances of MC_Rack software as necessary. That means, you are able to work with several 
MC_Rack versions in parallel, for example, when using the USB-ME128 with two MEA1060 
amplifiers. With setting "Max. Number of MC_Rack Instances = 2" in Advanced Configuration  
you can control each of the two amplifiers independent from the other with its own MC_Rack 
software. 

Note: Setting up the configuration of the data source is important for having the correct layouts 
for MEA A and B during the complete experiment. 

USB-ME64 Data Acquisition 

The USB-ME64 device is in principle the same device as the USB-ME256, except for the total 
number of channels, that is 64.  

The USB-ME64 is an external data acquisition device that uses USB 2.0 connection to transfer 
digitized data to any connected computer. Please see USB-ME64 Manual for detailed information. 
Select USB MEA from the Data Source drop down list. The USB MEA device will be specified on 
the right Data Source drop down menu: USB-ME64 (S/N: 0002), for example. The number in 
brackets is the serial number of the device. 

In USB-ME64-System it is possible to configure the MEA1060 / MEA1060BC amplifier. Additionally 
it is possible to configure the layout of MEA A. 

Note: Setting up the configuration of the data source is important for having the correct layout 
for MEA A during the complete experiment. 
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USB-MEA256 Data Acquisition and Filter Amplification 

The USB-MEA256 is an external data acquisition device with integrated filter amplifier that uses 
USB 2.0 connection to transfer digitized data to any connected computer. Please see USB-MEA256 
Manual for detailed information. Select USB-MEA from the left Data Source drop down list.  
The USB-MEA device will be specified on the right Data Source drop down menu: USB-MEA256 
(S/N: 00007). The number in brackets is the serial number of the device. 
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 Wireless Recording System 

The wireless in vivo recording system is the all-in one solution for amplifying, recording, and 
analyzing in vivo data from eight channels that uses a wireless connection between headstage 
and receiver and an USB 2.0 connection to transfer digitized data to any connected computer. 
Please read the Wireless-System manual for detailed information. Select USB MEA from the left 
Data Source drop down list. The wireless system device, W8 for example, will be specified on the 
right Data Source drop down menu: MCS WPA8 (S/N: 00001). The number in brackets is the serial 
number of the system. The data source layout is 1 dimensional, with 8 electrode channels and an 
additional digital channel. 

Note: With all electrode channels, the maximum sampling rate for the 8-channel Wireless 
Recording System W8-System is 20 kHz. It is possible to increase the maximum sampling rate  
up to 40 kHz by deactivating at least four electrode channels. Please pay attention to the 
sampling rate respectively, when using the W4-, W16- or W32-System. 
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MEA2100-System 

The MEA2100 recording system is an all-in one solution consisting of headstage and interface 
board. The MEA2100-System with integrated amplification, data acquisition, online signal 
processing, and integrated stimulus generator. You can connect one or two headstages to  
the interface board. The MEA2100-System uses an USB 2.0 connector per headstage to transfer 
digitized data to any computer. Please read the MEA2100-System manual for detailed 
information. Please read also chapter "Data Source Setup" in "MEA2100-System". 

Select USB MEA from the left Data Source drop down list. The MEA2100 device will be specified 
on the right Data Source drop down menu: MEA2100 (S/N: 0000-A).The number in brackets is  
the serial number of the system, the character A labels the connected headstage, A is the first 
headstage, B is the second headstage. It is possible to run up to two instances of MC_Rack per 
headstage. Please read chapter "Advanced Configuration". Specify the “Number of Channels” 
first: 32 electrode channels, when connecting one headstage with 32 recording and 12 stimulation 
electrodes (MEA2100-HS32), 64 when connecting one headstage with 60 channels (MEA2100-
HS60) or 128 electrode channels when connecting two headstages with 60 channels (MEA2100-
HS60) or one headstage with 120 channels (MEA2100-HS2x60 or MEA2100-HS120) to the interface 
board. Choose “Configuration” in the data source layout. Enable the check box for the digital 
input channels. Select the correct headstage in the “Amplifier” drop down menu and specify 
the type of MEA. 
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In MEA2100-System it is possible to configure two headstages independent of each other. 
MC_Rack identifies two connected headstages as completely different devices. They are defined 
via the character A or B in the serial number in the right "Data Source" drop down menu.  

It is also possible to run two MC_Rack instances per headstage, for example for recording  
from the 2x60 channels of the MEA2100-HS2x60 headstage separately. Please read chapter 
"Advanced Configuration". Click the Amplifier drop down menus on the left side to configure  
the "Amplifier". Additionally it is possible to configure the MEA layouts for up to two MEAs A  
and B independent of each other. Click the MEA drop down menus on the right side. 

 

MEA2100-32-System 

The MEA2100-32-System is a descendant of the MEA2100-System with the same functions except 
of the real-time feedback. Please read the MEA2100 Manual for detailed information. Select USB 
from the left Data Source drop down list. The MEA2100-32 device will be specified on the right 
Data Source drop down menu: MEA2100-32 (S/N: 00018-A). The number in brackets is the serial 
number of the device. The data source layout is Configuration, with 32 electrode channels. It does 
not matter whether you select the digital input channel or not. 
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3.2.3 Advanced Configuration 

Important: This feature can only be used when working with the USB based data acquisition 
systems USB-ME256 and USB-ME128. If you use a MC_Card or an USB-ME-16/32-FAI, please do  
not change the default setting of  "Max. Number of MC_Rack Instances = 1". 

On the Edit menu, click Advanced Configuration to select the maximum number of instances of 
MC_Rack that can run simultaneously. These instances operate independently from each other. 

This feature is meant to be used with the new USB based data acquisition systems USB-ME256 
and USB-ME128. When two or four amplifiers are connected to the data acquisition, it is possible 
to operate each amplifier independently with one instance of MC_Rack. It is also possible to 
operate 128 or 256 channels with one instance of MC_Rack, for example, when working with an 
USB-MEA256 amplifier and a MEA with 256 electrodes. See Data Source Setup for details on the 
configuration. Up to four instances of MC_Rack can be started in parallel. 

 

If the option "Stop on Data Loss" is selected, the MC_Rack program stops recording  
if it encounters problems during recording of a file. An error message will be displayed  
in the status bar. 
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Operating 256 channels with USB-ME256 device with one instance of MC_Rack 

Using an USB-ME256 device, it is possible to operate 256 channels with one instance of MC_Rack.  

1. Connect an USB-ME256 device to the data acquisition computer. Start MC_Rack software program.  

2. Click Edit: Advanced Configuration and keep the default setting: Max. Number of MC_Rack 
Instances = 1. 

3. Click Edit: Data Source Setup and select USB MEA under Data Source.  

4. Virtual Device Configuration: Click 1 x 256 from the drop down list on the left. In Virtual Device 
Configuration drop down list on the right Block 1 (Channel 1...256) is displayed.  

5. Source Layout: Choose Configuration in Source Layout and the total number of 256 from the drop 
down list in No. of Channels. 

6. Configure the connected amplifiers and MEA layouts independently from each other from the 
available drop down menus. 

The same proceeding is possible with USB-ME128 device. The total number of channel is reduced 
to 128 channels, respectively. 

 

Important: If working with one instance of MC_Rack, data acquisition from all four amplifiers  
can only be started in parallel, and all data will be saved in the same file. 
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Operating 256 channels with USB-ME256 device with four instances of MC_Rack 

Using an USB-ME256 or an USB-ME128 device, it is possible to operate 128 or 256 channels  
with two or four instances of MC_Rack. 

Click Advanced Configuration to select the number of instances of MC_Rack that you want  
to run simultaneously. Please see screen shot above. 

Example: Operating an USB-ME256 device with four amplifiers and with four instances  
of MC_Rack. 

 

 

1. Connect an USB-ME256 device to the data acquisition computer. Start the first instance of 
MC_Rack. Click Edit: Advanced Configuration and define Max. Number of MC_Rack Instances = 4. 

2. Click Edit: Data Source Setup and select USB MEA under Data Source. Choose 4 x 64 channels  
from the left drop down menu in Virtual Device Configuration, and Block 1 (Channel 1...64)  
from the right drop down menu. Block 1 corresponds with input A of the USB-ME256. 

3. Configure the correct amplifier type and electrode layout for input A  

4. Open the second instance of MC_Rack software program. 

5. Click Edit: Data Source Setup and select Block 2 (Channel 65...128) from the right drop down 
menu. Block 2 corresponds with input B of the USB-ME256. 

6. Configure the correct amplifier type and electrode layout for input B. 

7. Open the third instance of MC_Rack software program. 
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8. Click Edit: Data Source Setup and select Block 3 (Channel 129...192) from the right drop down 
menu. Block 3 corresponds with input C of the USB-ME256. 

9. Configure the correct amplifier type and electrode layout for input C. 

10. Open the fourth instance of MC_Rack software program. 

11. Click Edit: Data Source Setup and select Block 4 (Channel 193...256) from the right drop down 
menu. Block 4 corresponds with input D of the USB-ME256. 

12. Configure the correct amplifier type and electrode layout for input D. 

13. If you try to open a fifth instance of MC_Rack an error message will be displayed. Please see 
Troubleshooting. 

Now you are able to operate the different blocks of 4 x 64 channels with independent MC_Rack 
instances, and with independent configured amplifiers and MEA layouts. 

The same proceeding is possible with USB-ME128 device. The total number of channel is reduced 
to 128 channels and two blocks and inputs (A and B), respectively. 

 

The Reuse of an existing Rack File with multiple Instances of MC_Rack  

The reuse of an existing rack file with multiple instances of MC_Rack running on the same 
computer is explained, using the example of the USB-ME256-System. If you are working with  
an MEA2100-32-System, please operate in the same principle.  
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Opening an existing Rack File with USB-ME256 and multiple Instances of MC_Rack 

If you build up (and saved) a complicated rack in the first instance of MC_Rack which you want  
to reuse in the second instance of MC_Rack, please do the following: 

1. Start the second instance of MC_Rack.  

2. Click "Open" in File menu. The dialog "Open Rack Files" appears. Select the desired rack file. 

3. Before the selected file will open in the second instance of MC_Rack, you have to change the  
data source specification from the copied file. That is why the dialog "Channel Layout" in  
"Data Source Setup" will automatically appear again. Please choose the appropriate MEA 
amplifier via block number, assigned the second instance of MC_Rack. 

 

4. Now the reused rack file will be opened in the second instance of MC_Rack. The data source  
used for the rack is shown in the blue header of the dialog and after the data source icon. 

 

Note: Please do not miss one of the described steps when reusing an existing file! Otherwise  
you have to delete the rack and start the instance of MC_Rack again. 

Repeat step 1 to 4 to open the third and fourth instance of MC_Rack with an existing file  
to control the amplifiers three and four. 
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Operating two MEA2100-32-Systems with multiple instances of MC_Rack 

Using a MEA2100-32-System with two MEAs or two headstages with two MEAs, it is possible  
to operate up to four devices with up to four instances of MC_Rack, running on a single data 
acquisition computer. 

Click “Advanced Configuration” to select the number of instances of MC_Rack that you want  
to run simultaneously. Please see screen shot above.  

Important: It is not possible to connect one device with more than one instance of MC_Rack.  

1. Start the first instance of MC_Rack.  

2. Click Data Source Setup on the Edit menu. Select USB on the left drop down menu of the "Data 
Source", and MEA2100-32 on the right drop down menu. Please see chapter "Defining the Data 
Source". Select the block you want to control with the first instance of MC_Rack "Block" number. 

 

3. Select Configuration in Source Layout. The total number of channels is 32 with an additional 
digital input channel or not.  

4. Add MEA2100-32 (S/N 00018-A, headstage A), for example, as the data source to your virtual  
rack for the first instance of MC_Rack. The data source and its serial number are displayed  
in the blue header of the dialog of the "Rack" tab as well as on the left side of the display. 
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5. Start the second instance of MC_Rack.  

6. Click "Data Source Setup" in Edit menu. Select the headstage you want to control with the second 
instance of MC_Rack via serial number, for example MEA2100-32 (S/N:00018-B). Add the desired 
data source. The data source and its serial number are displayed in the blue header of the dialog 
of the "Rack" tab (second instance) as well as after the data source icon. 

 

Opening an existing Rack File with MEA2100-32-System and multiple instances  
of MC_Rack 

If you build up (and saved) a complicated rack in the first instance of MC_Rack which you want  
to reuse in the second instance of MC_Rack, please do the following: Start the second instance  
of MC_Rack.  

1. Click "Open" in File menu. The dialog "Open Rack Files" appears. Select the desired rack file.  

2. Before the selected file will open in the second instance of MC_Rack, you have to change the  
data source device specification from the copied file. That is why the dialog "Channel Layout"  
in "Data Source Setup" will automatically appear again.  

3. Please choose the appropriate MEA2100-32 headstage via block number, assigned the second 
instance of MC_Rack. 

4. Now the reused rack file will be opened in the second instance of MC_Rack. The data source  
used for the rack is shown in the header and after the data source icon. 

Note: Please do not miss one of the described steps when reusing an existing file!  
Otherwise you have to delete the rack and start the instance of MC_Rack again. 

 

Maximal Sampling Frequency 

Usually, the maximal sampling frequency for MCS data acquisition systems is 50 kHz. However, 
when using some advanced features of the USB-ME256 and USB-ME128, some limitations apply.  

The maximal sampling frequency that can be achieved with 256 channels is 40 kHz. This is possible 
when using the USB-ME256 with the "Virtual Device Configuration" 1 x 256 (Please see above). 
With the USB-ME128 and USB-ME256 it is also possible to split the data stream into 2 x 64 or  
2 x 128 and 4 x 64 channels, respectively, again by using the "Virtual Device Configuration".  
These virtual machines can then be controlled independently by up to four instances of MC_Rack. 
However, splitting the data stream into several virtual devices consumes system performance. 
Therefore, the maximal sampling frequency is limited to 25 kHz when using the virtual device 
configuration 2 x 64 (USB-ME128) or 2 x 128 and 4 x 64 channels (USB-ME256). 

 

The Additional Analog Channels A1 to A4 

The devices USB-ME256, USB-ME128, USB-ME64 and USB-MEA256 are equipped with four 
additional analog channels A1 to A4. Please refer to the respective manuals.  

The additional analog channels A1, A2, A3 and A4 are available in MC_Rack data display  
and in MC_Rack long term display.  

Note: Because of the different scaling of electrode data channels and the additional analog 
channels, it is recommended to visualize the analog channels in a separate display. 
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Availability of Additional Analog Channels in USB-ME256 (and USB-ME128 respectively)  

Depending on the selected "Source Layout", it is possible that no or not all additional analog 
channels are available. To have full access to the analog channels, please use the "Configuration" 
option of the data source setup. If other data source layouts are selected, limitations apply: 

 

Source Layout 1 dimensional: No additional analog channels are available. 

Source Layout 2 dim. (MEA):  Three additional analog channels are available A1, A2, A3. 

Source Layout Configuration: All four additional analog channels are available A1, A2, A3 and A4. 

 

Visualizing the Additional Analog Channels 

Click  to add a data display. On the left window pane of the dialog the data display appears, 
labeled ”Display 1”. Double click on "Display 1" to rename the display for discrimination of the 
analog and electrode displays.  

In the "Data" tab, select "Analog Raw Data" only.  
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In the "Layout" tab, select the "Default Map". The additional analog channels A1 to A4  
are displayed. It is also possible to use a custom layout (for example 2x2 electrodes). Please  
see chapter “Monitoring Activity” for more information about designing channel maps. 

 

Additional Analog Channels with Different Instances of MC_Rack 

If you use the Advanced Configuration to run more than one instance of MC_Rack at once,  
the same four additional analog channels A1 to A4 can be displayed in any of these instances.  

 

3.2.4 Adding a Data Source 

In MC_Rack, the input data streams for the virtual rack can come from different data sources: 
From the data acquisition board of the MEA2100-System or from the Replayer, that is, from 
previously recorded data (*.mcd) files, or from USB based data acquisition systems like USB-
ME256, USB-MEA256, USB-ME16-FAI-Systems or from the MC Card. 

Here, we want to acquire new data and choose, for example the MC_Card as data source. 



Step by Step Tutorial 

33 

1. Click the electrode array symbol  on the toolbar or click Add MC_Card on the Edit menu. 
The program detects the MC_Card automatically. If you have no MC_Card installed on the 
computer, the simulation mode is started automatically, and you will be informed by a message. 
(If you have a MC_Card, but you still get an error message, the driver installation may be invalid. 
Please contact your local retailer for support.) 
You see the MC_Card virtual instrument in your virtual rack. When you select the MC_Card so 
that the name appears highlighted in blue, you see three tab pages on the right: The general 
Rack tabbed page, and the MC_Card specific Hardware and Info tabbed page. In the Hardware 
page, you can define the hardware related settings. The Info page shows the channel layout. 
 

 

2. In the tree view pane of the virtual rack, select the MC_Card, click the Info tab, and check the 
channel layout settings that you have defined in the last step. You cannot modify the settings 
anymore once you have added the MC_Card. If the settings are not appropriate, remove the 
MC_Card from the rack (by selecting the MC_Card In the tree view pane of the virtual rack  
and pressing DELETE), and go back to the last step "Defining the Data Source". 
The following screen shot shows the information on the standard layout for the MEA60-System. 
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3. Click the Hardware tab. Here, you can define hardware related parameters. Please note that the 
amplifier gain is an intrinsic property of the amplifier and cannot be altered, whereas the input 
voltage range and the sampling rate of the data acquisition card can be adjusted to your 
needs. On this page, you will also find hardware related information like the MC_Card driver 
version and the serial number. Please keep this information at hand when contacting the support. 
 

 

4. Click Enter to enter the Amplifier Gain settings according to your hardware. The gain settings 
are used for scaling and displaying the signals properly. So if you specified a wrong gain, you 
would perceive wrong signal amplitudes leading to false documentation and results. The default 
settings are 1200 for the standard MEA1060 amplifier, and 1100 for the standard MEA1060-BC 
amplifier. The amplifier gain of the MEA2100-System is automatically set, depending on the 
version of the hardware. If you have a ME-System, you should enter the total gain of the 
amplifiers. For example, if you have a MPA8I (with a gain of 10) and a filter amplifier with  
a gain of 100, you have a total gain of 1000. Please check the technical specifications of the 
connected amplifier(s) and make sure that you enter an appropriate value. 

5. Select an Input Voltage Range of Data Acquisition Board for the MC_Card from the drop-
down list. For standard signals and a standard gain amplifier, the default input range of -819  
to +819 will be fine. You need a higher input voltage range if your biological sample generates 
higher voltages, for example, cardiac signals from whole-heart preparations, and/or the amplifier 
gain is considerably higher. The lower the input voltage range, the higher is the voltage 
resolution. Please see also Defining MC_Card Settings in the MC_Rack Features section. 

6. The Signal Voltage Range is calculated from the Input Voltage Range of the Data Acquisition 
Board divided through the Amplifier Gain Factor. 

7. Select a Sampling Rate from the drop down list. For most applications, 25 kHz will be fine.  
Please see also Defining MC_Card Settings in the MC_Rack Features section. 

8. An Offset Correction is generally not necessary. You may use it when you observe a disturbing 
voltage offset on the input channels. Or you may use it during testing the system with a test 
model probe. Make sure that there are no signals on the channels when using the offset 
correction. Click Offset Correction to activate the Offset Correction. Click Learn Offsets to 
perform an individual offset correction for each input channel. MC_Rack takes 100 ms of the 
recorded data in the moment when the button is pressed to calculate the DC offset. The mean of 
this 100 ms sweep is subtracted from the recorded data as long as the Offset Correction button 
is pressed. The individual offset values for each channel are saved in the local settings of the data 
acquisition computer and are only overwritten when you click Learn Offsets again. Make sure 
you press the Learn Offsets button only when you have no real input signals or irregular noise 
signals on the electrodes. To be on the safe side, connect a test model probe to the amplifier. 
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3.2.5 Channel Tool 

The Channel Tool feature in MC_Rack allows the selection of one MEA electrode as reference 
electrode. The tool works similar to the offset correction and influences the signal to noise ratio.  
If there are problems with homogenous noise on all electrodes, the user is able to select one 
electrode without signal as reference. The voltage value of this reference electrode will be 
mathematically subtracted sample point per sample point from all electrode signals in the  
stream. For example, a low frequency noise on all electrodes will be eliminated this way.  

 

Note: Be careful to choose an electrode with noise only as reference electrode. If the reference 
electrode contains signals too, the value of the signals will be subtracted together with the noise 
value, and falsify the data.  

Click the "Channel Tool" icon  in the main window toolbar, or select "Channel Tool"  
from the Edit menu. The following dialog appears. Click the "Channels" tab. 

 

Select the data stream you want to apply the channel tool: Electrode Raw Data in this example. 
Select a "Reference electrode" from the "Reference electrode" drop down menu. 

Important: Data streams recorded with the channel tool feature can not further be processed  
in MC_Rack. As a workaround please use filters before applying the channel tool. Always record 
also the data stream "Electrode Raw Data" to be flexible with analysis options offline. 
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3.2.6 Monitoring Activity Continuously 

Next, you need a Data Display for monitoring the ongoing activity continuously. 

Click  on the toolbar or click Add Data Display on the Edit menu to add a Data Display  
to your virtual rack. The Data Display displays the channels in the layout of the Channel Map 
you have created or loaded. Channel maps are saved as *.cmp files. The default channel map at 
first program startup is the 8x8 grid of standard MEAs (saved as 8x8mea.cmp). When you have 
changed the channel map, the last used channel map is loaded automatically as the default. 
 

 

For monitoring the ongoing activity continuously over a longer period, add the Longterm 
Display. 

Click  on the toolbar or click Add Longterm Display on the Edit menu to add a Longterm 
Display to your virtual rack. 

The Longterm Display shows analog raw data and electrode raw data. You can display data  
in a user defined time span from 1 second up to 60 minutes. The longterm display tool allows  
to observe the development of the signals over a longer period. The Longterm Display displays  
the channels in the layout of the Channel Map you have created or loaded. In the Longterm 
Display the adjustment of the x-axis is disabled, and you cannot zoom in. The peak detection  
is permanent selected (for more information please see chapter Peak Detection). 
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Defining the display layout 

Note: You can set up any channel layout that meets your requirements and save it for later use. 
You can pick preconfigured channel maps for all MEAs available from Multi Channel Systems  
from the MCS Channel Maps drop down list.  

1. In the tree view pane of the virtual rack, select the Display 1 and click the Layout tab. 
You see the currently used display layout of the Default Map: The standard 8x8 grid. The 
electrodes are labeled in relationship to their position in the electrode grid, respectively to their 
coordinates. The first number refers to the x-axis (column), the second number refers to the y-axis 
(row). The character refers to the MEA, MEA A in this case, that is important when using more 
than one MEA amplifier. 
 

 

2. To load a different Channel Map, click MCS Channel Maps or if the channel map is user 
defined, click User Channel Maps. You can use the Channel Map drop down menu or you 
browse your folders and open the MC_Rack program folder. In the Channel Maps folder,  
you will find a selection of standard layouts, for example, for different MEA types, layouts for  
the MEA two or four fold-systems (8x8meaA.cmp and 8x8meaB.cmp for two or four separate 
MEAs), and various other layouts for single electrode columns on a MEA, for example. Select  
an appropriate channel map and click Open. The MEA layout appears on he right side of the  
dialog box and the display shows the channels in the selected layout accordingly. 
. 

 

3. For setting up a custom layout, enter the desired number of rows and columns. 
The layout grid displayed on the right is updated accordingly. 
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4. Click any electrode number that you want to change and select the desired channel number 
from the Channel list, or type the channel number with the keyboard. 
 

 

5. If you want to keep the custom layout for later use, click Save and enter a file name. 

Option: Advanced 

Hint: For advanced users only! Adjusting a custom MEA layout to a custom data display layout. 

Click button Advanced. 
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Additional windows appear: Channel Offset, X- and Y- Offset and X- and Y-Extend.  
These commands concern the data display layout only.  

 

 

Example: Setting up a MEA layout 5x5 with electrodes in different sizes. 
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Customized Display 

 

1. Click User Defined Map.  

2. Set up a MEA layout with a 5x5 grid using Rows and Columns. The MEA layout appears  
on the right side of the dialog box and in the data display.  

3. Click into the empty squares of the electrode grid and select the desired channel numbers  
from the Channel drop down menu. The data display shows the channels in the selected  
layout accordingly.  

4. The electrode referring to channel No.13 (in the middle of the first row) is bigger than the other 
electrodes. Click 13 in the electrode grid. Enlarge the electrode in the data display with X-Extend 
= 300 and Y-Extend = 200 by overwriting the 0 in the numeric updown box or clicking the arrow 
buttons.  

5. To change the position of the electrode in the data display use X-Offset for moving it to the  
left (negative integer) and to the right (positive integer), and Y-Offset for moving it downward 
(positive integer) and upward (negative integer). The X- and Y-Offset has a range from -100 to 
+100. Overwrite the 0 in the numeric updown box or click the arrow buttons. The layout displayed 
on the data display is updated immediately. 

6. The electrode referring to channel No. 23 is bigger as well. Do the same procedure to enlarge  
and move it as described in point 4 and 5. Repeat this procedure as often as necessary, and you 
are able to build your custom display layout. 

If you have two or four amplifiers in your setup use Channel Offset to assign the custom layout 
to the correct data stream. Please read also next chapter “Selecting data streams”. Until today,  
it only makes sense to give 0 in Channel Offset for connecting the custom layout to Electrode Raw 
Data 1 or 64 for connecting the custom layout to Electrode Raw Data 2. 

 

 If you want to keep the custom layout for later use, click Save and enter a file name. 
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Selecting data streams 
 

1. Click the Data tabbed page. 
In this page, you select the data streams that you want to monitor in the display. The Electrode 
Raw Data stream is already preselected. You can select the Analog Raw Data stream if you have 
connected a data source to an analog data input (A1 A2 and A3 for the MEA-System). It may make 
more sense to display the additional analog channels in a separate display, though, because in 
most cases, the scale of the axes will not be appropriate for both the electrode data stream and 
the additional analog data stream. For monitoring the digital data stream, please use the Digital 
Display. The Data Display has an oscilloscope-like function. Therefore, only the Trace option  
is available. The Parameter Display for graphing extracted parameters provides more options. 
 

 

 

Starting MC_Rack 

 Click Start  (either on the Measurement menu, the toolbar, or the Rack tabbed page) to 
start the data acquisition. Each virtual instrument in the rack starts to process the channels and 
data streams that were assigned to it, that is, the Trigger Detector detects events on the digital 
input channel and generates a trigger data stream that, in turn, triggers the display. The display  
is refreshed at each trigger event. 

Refresh rate and ranges 

1. Switch to the Display 1 window. 

2. You can zoom in the signals by choosing the appropriate range of the y-axis from the Y-Axis 
drop-down list, or by clicking the arrow buttons. 

3. You can select the display refresh rate and maximum x-axis range from the X-Axis drop-down 
list. 

4. You can fine-tune the ranges of the y- and x-axis with the sliders. 
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3.2.7 Recording Data 

MC_Rack's philosophy is to strictly separate the actions of all virtual instruments in a rack. That 
means, that you could record to hard disk completely different data streams and channels than 
you monitor on the screen. This has the advantage that you can store exactly the channels you  
are interested in, but it also has the slight disadvantage that all virtual instruments have to be  
set up separately. Please be especially careful when configuring the Recorder to avoid data loss. 

Selecting data streams and channels for recording 

The fate of each single channel is independent from other channels. You can pick exactly the 
channels you like to save from all generated data streams. For example, you can decide to save 
only one channel of raw data, but the peak-to-peak amplitude results of all, or of a specific 
selection of channels. 

Select the Recorder in the virtual rack tree view pane and then click the Channels tabbed page. 
On the white pane on the left of the Channels page, you see the data streams that are available 
with your data source settings, for example, the Analog Raw Data, Digital Data, and Electrode 
Raw Data streams for the MEA-System. (It does not matter whether you have really connected  
a device to the inputs, though.) If you have selected a channel layout without the digital input, 
the Digital Data stream will not be available, for example. 
 

 

1. Click the data stream that you are interested in, that is generally the Electrode Raw Data 
stream. The available electrode channels appear in a button array on the right side. 
 

 

2. You can now either select all channels by clicking the check box next to the Electrode Raw Data 
stream name, or you can pick single channels by clicking the corresponding buttons. For more 
information, please see "Channel Selection" in the MC_Rack Features section. Only data from  
the selected channels will be saved to the hard disk. 
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Choosing the file name and path 

 

1. Click the Recorder tab. 

2. Browse your folders and select a path. 

3. Type a file name into the text box. 

4. Confirm by clicking Save. 
 
The file extension for the data files is *.mcd. 

File size limit 

 

The file size is not limited by default, but the user can limit it. When the maximum file size 
specified by the user has been reached, a new file is generated automatically. The file name  
is extended by four digits, counting up, for example, LTP-Parameters0001.mcd,  
LTP-Parameters0002.mcd, and so on. 

If you rather prefer that the recording is completely stopped when a file has reached the 
maximum size, please select the option Auto Stop. For information on more options,  
please see "Generating Data Files" in the MC_Rack Features section. 
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Continuous recording versus triggered recording 

For recording evoked activity, like LTP experiments or retina recordings, it does generally not 
make much sense to record continuously. It is recommended to record only the signals of interest 
following a trigger event, for example, a TTL signal from the stimulator, to save disk space.  
You can then define the Start Time (before the trigger event) and the Window Extent (total 
cutout length). Please do not prolong the "Window Extent" time interval to more than 3800 ms. 
Please read chapter "Triggering MC_Rack on the Stimulus" for more information about "Window 
Extent" settings. For more information on continuous and triggered data, please see the chapter 
Continuous and Triggered Data in the "Step by Step Tutorial" section. 

This option is only available if there is a trigger stream available, that is, a Trigger Detector  
in the rack. 

 

3.2.8 Starting Data Acquisition and Recording 

Now that you have completed the virtual rack, you are ready to start the rack. 

 Click Start  (either on the Measurement menu, the toolbar, or the Rack tabbed page)  
to start the data acquisition. Each virtual instrument in your rack starts to process the channels 
and data streams that were assigned to it. 

 Click first Record  and then Start  to write data to the hard disk. The data from the 
electrodes selected in the Recorder is saved to the file and location specified in the Recorder. 

 

 Click Stop  to stop the data acquisition. 

 

Warning: Only data of the channels and data streams that were selected in the Recorder  
are saved in your data file when you start a recording. Data is only saved to the hard disk when 
the red Record button is pressed in. Make always sure that you have selected all channels of 
interest, and that the Record button is active before starting an experiment to avoid data loss. 
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3.3 Monitoring and Recording Triggered Activity 

3.3.1 Triggering MC_Rack on the Stimulus 

When recording evoked responses, such as in a LTP or PPF experiment, you usually want to 
synchronize the data displays and the recording to the electrical stimulation. For this purpose,  
you can feed in TTL pulses to the digital input bits of the digital input channel. In the standard 
configuration, three BNC sockets are available for applying up to three separate trigger pulses. 
You can upgrade the system with a digital IN / OUT expansion that support all 16 digital input 
(and output) bits that are provided by the data acquisition device. For more information, see  
the ME- or MEA-System manual. 

Note: It is recommended to use the digital input port for feeding in TTL signals.  
The analog inputs are intended for analog signals, like patch clamp data, for example. 

For triggering MC_Rack, we need to set up a Trigger Detector in the virtual rack. The trigger 
stream generated by the Trigger Detector can then be used for triggering Data Displays, 
Analyzers, and the Recorder. 

See also the sample rack Display_Triggered.rck. 

 

1. Configure your stimulator to output a TTL pulse that is synchronized to the stimulus pattern.  
If you are using a Stimulus Generator (STG) from MCS, you can program a Sync Out channel. 

2. Connect the TTL output to digital input bit 0 (the first BNC socket). If you are using a MEA-System, 
make sure not to confuse the digital inputs with the analog inputs. 

3. Click  on the MC_Rack toolbar to add a Trigger Detector to the virtual rack. 

4. In the tree view pane of the virtual rack, select the Trigger Detector, and click the Trigger page. 
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From the Channel list, select the Digital Data D1 channel. 
 

 
 
A button array appears, one button for each digital input bit. With the Bit button, the logical 
state (generally HIGH) that generates a trigger event is selected. With the Mask buttons, you  
can select the bits that you want to use; all unused bits are masked. 

The digital input bit 0 is already preselected. The logical state that generates a trigger event is 
set to HIGH. This is fine and you do not need to change it. (If you had, for example, connected the 
TTL output to digital input bit 1, you would need to select 1 instead of 0, and mask all other bits.) 
You may want to change the dead time (the time after a trigger event where no following trigger 
event is accepted), for example, if you run a paired pulse protocol, and want to trigger MC_Rack 
only on the first stimulus pulse. 

Click Recorder and select "Window" tab. 

 

Important: The "Window Extent" is the total time of the cutout sweep. If you prolong the 
trigger in “Window Extent” to more than 3800 m, a Warning will pop up. MC_Rack will record 
data, but you cannot display these data when replaying them, because the MC_Rack display 
setting for displaying sweeps is maximal 3800 ms. Please record the sweeps in MC_Rack, but 
export the data with MC_DataTool to custom ASCII import programs, for example to Matlab,  
for further analysis. 

 

After recording long sweeps with "Window Extent" settings near to 3800 ms, and replaying  
the respective *.mcd file with the MC_Rack Replayer, please slow down the "Replay Speed"  
in the "Replayer" tab. Otherwise MC_Rack might have problems with displaying the data.  
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3.3.2 Monitoring Triggered Activity 

Next, you need a Data Display for monitoring the ongoing activity. 

Click  on the toolbar or click Add Data Display on the Edit menu to add a Data Display  
in series with the Trigger Detector to the virtual rack. (If you would put both instruments in 
parallel, you would not be able to use the trigger stream generated by the Trigger Detector  
for triggering the Data Display, because virtual instruments can only use the output streams  
of other virtual instruments that are upstream in the virtual rack tree.) 
 

The Data Display displays the channels in the layout of the Channel Map you have created  
or loaded. Channel maps are saved as “*.cmp” files. The default channel map at first program 
startup is the 8x8 grid of standard MEAs (saved as 8x8mea.cmp). When you have changed the 
channel map, the last used channel map is loaded automatically as the default. 
 

 

1. Define the display layout and select the data stream as explained before. 

Triggering the display 

To graph the sweeps synchronized to the stimulation, you need to start the display on the trigger 
event generated by the Trigger Detector that we set up earlier. 

1. In the tree view pane of the virtual rack, select the Display 1, and click the Window tab. 

2. Select the option Start on Trigger. 
In the Trigger selection box, Trigger 1 appears automatically. It is the only trigger data stream 
available in this rack. (You could set up multiple Trigger Detectors and trigger multiple displays 
on separate trigger events.) 

Starting MC_Rack 

 Click Start  (either on the Measurement menu, the toolbar, or the Rack tabbed page) to 
start the data acquisition. Each virtual instrument in the rack starts to process the channels and 
data streams that were assigned to it, that is, the Trigger Detector detects events on the digital 
input channel and generates a trigger data stream that, in turn, triggers the display. The display  
is refreshed at each trigger event. 
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Adjusting the ranges 

1. Switch to the Display 1 window. 

2. You can zoom in the signals by choosing the appropriate range of the y-axis from the Y-Axis 
drop-down list, or by clicking the arrow buttons. 

3. You can select the maximum display refresh rate and maximum x-axis range from the X-Axis 
drop-down list. 

4. You can fine-tune the ranges of the y- and x-axis with the sliders. 

 

3.3.3 Recording Triggered Data 

MC_Rack's philosophy is to strictly separate the actions of all virtual instruments in a rack. That 
means, that you could record to hard disk completely different data streams and channels than 
you monitor on the screen. This has the advantage that you can store exactly the channels you  
are interested in, but it also has the slight disadvantage that all virtual instruments have to be  
set up separately. Please be especially careful when configuring the Recorder to avoid data loss. 

In principle, you could record the evoked responses continuously, and trigger the displays and 
analyzers when you replay the data. However, you would produce a huge amount of useless data, 
as generally only the response following the stimulus is of interest. Therefore, it is recommended 
to produce triggered data, that is, to cut out sweeps around the trigger event. This saves a lot  
of disk space. 

Selecting data streams and channels for recording 

The fate of each single channel is independent from other channels. You can pick exactly the 
channels you like to save from all generated data streams. For example, you can decide to save 
only one channel of raw data, but the peak-to-peak amplitude results of all, or of a specific 
selection of channels. 

Select the Recorder in the virtual rack tree view pane and then click the Channels tabbed page. 
On the white pane on the left of the Channels page, you see the data streams that are available 
with your data source settings, for example, the Analog Raw Data, Digital Data, Electrode 
Raw Data, and Trigger streams. (It does not matter whether you have really connected a device 
to the inputs, though.) 

Click the data stream that you are interested in, that is generally the Electrode Raw Data 
stream, and the Trigger stream. The available electrode channels appear in a button array  
on the right side. 
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1. You can now either select all channels by clicking the check box next to the Electrode Raw Data 
stream name, or you can pick single channels by clicking the corresponding buttons. For more 
information, please see "Channel Selection" in the MC_Rack Features section. Only data from  
the selected channels will be saved to the hard disk. 
 

 

Choosing the file name and path 

1. Click the Recorder tab. 

2. Browse your folders and select a path. 

3. Type a file name into the text box. 

4. Confirm by clicking Save. 
 

 

The file extension for the data files is *.mcd. 

File size limit 

When the maximum file size specified by the user has been reached, a new file is generated 
automatically. The file name is extended by four digits, counting up, for example  
LTP-Parameters0001.mcd, LTP-Parameters0002.mcd, and so on. 

If you rather prefer that the recording is completely stopped when a file has reached the 
maximum size, please select the option Auto Stop. 

For information on more options, please see "Generating Data Files" in the MC_Rack Features 
section. 
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Triggering the recording 

Again, the displayed data is independent from the recorded data. Thus we need to start  
the recording on the trigger event generated by the Trigger Detector in the same manner  
as we triggered the display. 

This option is only available if there is a trigger stream available, that is, a Trigger Detector  
in the rack. 

1. In the tree view pane of the virtual rack, select the Recorder, and click the Window tab. 

2. Select the option Start on Trigger. In the Trigger selection box, Trigger 1 appears 
automatically. Two text boxes appear, too. These two parameters define the cutout: The Start 
Time is generally a negative value, that is, the pretrigger time. The Window Extent is the total 
time of the cutout sweep. Please read chapter "Triggering MC_Rack on a stimulus" for more 
information about "Window Extent" settings. 
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3.4 MEA2100-System 

3.4.1 MEA2100-System 

Specific Functions of the MEA2100-System 

The following chapter summarizes all functions and settings of MC_Rack which are specific  
for the MEA2100-System. You will find the identical information in several subchapters of  
the MC_Rack manual and in the manual of the MEA2100-System. 

 

MEA2100-System Configuration 

The MEA2100-System is a flexible system, which can be used in different configurations.  
Please read the MEA2100-System manual for detailed information. At the moment five types  
of headstages are available for the MEA2100-System, which can be connected to the interface 
board once or twice: A headstage for one MEA with 32 (MEA2100-HS32), 60 (MEA2100-HS60)  
or 120 electrodes (MEA2100-HS120), and headstage for two MEAs with 32 (MEA2100-HS2x32)  
or 60 electrodes each (MEA2100-HS2x60). One or two headstages can be connected to the 
interface board (IFB) of the MEA2100-System. 

MEA2100-32-System 

The MEA2100-32-System is a system providing all functions of a MEA2100-System, with the 
exception of the real-time feedback via DSP. In “Data Source Setup” it is present as an own  
device “MEA2100-32”. Please read the MEA2100-System manual for detailed information. 

 

Using MC_Rack Software 

Data Source Setup 

Every MEA of the system can be operated completely independently by one instance of MC_Rack. 
To be able to open more than one instance of MC_Rack, please first open the "Advanced 
Configuration" dialog in the "Edit" menu. 

 

Please increase the maximum number of instances according to the number of MEAs  
you are going to use in parallel:  

 one MC_Rack instance for one HS32, HS60 or one HS120,  

 two MC_Rack instances for one HS2x32, HS2x60, or for two HS32, HS60 or two HS120, 

 four MC_Rack instances for two HS2x32 or HS2x60.  

Afterwards you can open several instances of MC_Rack and assign every instance  
to one MEA of the system. 
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After opening MC_Rack as many times as necessary, please open the “Data Source Setup” dialog 
from the “Edit” menu. This dialog can only be opened in one instance at a time, please do the 
adjustments in one instance after the other. The example below shows the settings for one 
MEA2100-HS2x60. 

    

Select “USB” and MEA2100 (S/N: XXXXX-A) as Data Source. Select “Configuration” in the “Source 
Layout”. Please select the type of the connected headstage in the "Amp" drop down menu.  

If a MEA2100-HS2x60 is connected you have additionally to select the "Block" in the right drop 
down menu of “Virtual Device Configuration”. For the first instance of MC_Rack, select Block 1 
(Channel 1…64) and for the second instance Block 2 (Channel 65…128). Select the appropriate 
MEA type from the drop down menu for each instance. If a second headstage is connected  
to the same interface board, it will become available in the "Data Source Setup" as MEA2100  
(S/N: XXXXX-B). The settings for the second headstage are analog to the first. 

Hardware Settings for the MEA2100-System in the Data Source 

When using the MEA2100-System, the “Hardware” tab of the MC_Rack software is modified. 
Please see also chapter “Defining a Data Source”. 

In the "Hardware" tab of the Data Source, the gain setting must be adjusted to ensure a correct 
scaling of the data in MC_Rack. The gain is a fixed hardware property, while sampling frequency 
and input voltage range of the data acquisition board can be selected according to the demands 
of the experiment. 
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The appropriate “Amplifier Gain” factor of the MEA2100-System will automatically be entered.  
Depending on the hardware revision the MEA2100-System the gain factor is 5, in older revisions 
factor 2.   

The “Input Voltage Range of Data Acquisition Board” divided by the gain is the “Signal Voltage 
Range”, the maximum size of signals you can record before they get clipped. Please adjust the 
"Input Voltage Range of Data Acquisition Board" according to the expected size of your signals.  
It is advisable to select the input voltage range as small as possible, to ensure an optimal A/D 
resolution of the analog input signals. 

The ADCs (Analog Digital Converter) of the MEA2100 system have a resolution of 24 bit, the 
MC_Rack software can record and display data with a resolution of 16 bit. To handle the complete 
24 bit range, the input voltage range selection in the MC_Rack software can select a window of  
16 bit out of these 24 bits, resulting in the following signal ranges: 

+/- 812 μV; +/- 1727 μV, +/- 3545 μV; +/- 7090 μV;  

+/- 14 mV; +/- 28 mV, +/- 57 mV; +/- 114 mV; +/- 227 mV 

A smaller input range results in a better resolution in bits/μV, signals larger than the selected 
range will be clipped. In summary, the procedure has exactly the same functionality as a software 
selectable gain, even though, strictly speaking, it is not. 

The “Sampling Frequency” should also be selected as low as possible, depending on the signals 
you like to measure, to minimize data file size.  

If several instances of MC_Rack are used to operate the MEA2100-System, for example with  
a MEA2100-HS2x60 headstage or two MEA2100-HS120 headstages, each instance of MC_Rack 
operates independently; you can define the “Input Voltage Range of Data Acquisition Board”  
and the “Sampling Frequency” for each instance of MC_Rack individually. 

 

Hardware Filter Settings 

While the MEA2100-System in principle can measure DC signals, this is for most purposes  
very impractical, as the baseline would constantly drift. Therefore the system is equipped with 
software configured hardware filters. By default, a second order high pass filter with a cut  
off frequency of 1 Hz is used to prevent a baseline drift. The upper cut off frequency is 3.3 kHz.  
Additionally you can use the software filters of MC_Rack, if necessary. 

Note: To change the filter settings you can use the add on software ”MEA2100 Configuration”. 

 

Setting up the Internal Stimulus Generator of the MEA2100-System 

The headstage of the MEA2100-System is equipped with an integrated 3-channel stimulus 
generator.  

Even when using multiple instances of MC_Rack, each instance is completely independent and 
each instance has three stimulus channels available for the electrodes which are controlled by 
that instance. 

It is possible to choose between current or voltage controlled stimulation, and any electrode can 
be selected for stimulation. The control functions for electrode selection and definition of the 
stimulation parameters are integrated into MC_Rack, you do not need any additional software. 
However, it is possible to import stimulation patterns generated in MC_Stimulus II as ASCII data. 

Important: In current stimulation mode, if you select two or more stimulation electrodes for  
the same stimulation pulse, please be aware that in some configurations (when more than one 
electrode is used within a block of 30 electrodes which are powered by the same current source) 
the current level of the stimulation pulse will be divided among these electrodes. That means  
the current level is lower than expected. Please read also chapter “Stimulation” in the Appendix. 



MC_Rack Manual 

54 

Add the internal stimulus generator to your rack: Click menu “Edit” and choose "Add MEA2100 
Stimulator". 

 

The following dialog appears. 

 

Select the tab of any of the three stimulation channels (Stimulus 1, 2 or 3). In the "Stimulus" tab 
page, you can define the stimulation pulse and select how the stimulation is started and stopped. 

 Click “Stimulus 1” tab page, for example. 
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Defining the stimulation pulse 

In "Output Mode" you can choose whether you want to stimulate in voltage or current mode.  
To set up the stimulus pulse or pulse train, please use the eight provided up down boxes.  

  

The individual stimulation pulse is defined in the "Pulse" window. Set up a monophasic pulse by 
selecting the voltage / current in mV/μA and the duration time T1 in μs. For setting up a biphasic 
pulse you have to select the stimulation strength and time also for the second phase. The shape of 
the pulse is displayed immediately in the window below. Once started, a programmed paradigm 
will run to its’ end, or till it is manually terminated. 

 

Warning: Anodic (positive) pulses can lead to a formation of titanium oxide on the MEA 
electrodes. When using MEA electrodes of TiN material, use only negative voltages pulses  
or biphasic current pulses applying the negative phase first. Always regard the safe-charge 
injection limits. Otherwise, electrodes can be irreversibly damaged by electrolysis. 

When using the "Train" window for setting up a pulse train, please select the "Inter Pulse Interval 
IPI" in μs and the number of pulses in the train in "Repeat". If no pulse train is needed, set the IPI 
to zero and the Repeat to one. 

The "Inter Train Interval ITI" function can be used to repeat a single pulse or a pulse train.  

The interval time can be set in ms, and also the number of repeats. The complete programmed 
paradigm is shown in the graphical display below the stimulus window. 

Once started, a programmed paradigm will run to its’ end, or till it is manually terminated. 

If the “Continuous Mode” is activated, the paradigm will be repeated indefinitely, till manually 
stopped. Please note that stimulation does not stop when MC_Rack is stopped. 

 

Importing a stimulation file created with MC_Stimulus II  

To generate more complex stimulation patterns it is possible to import a stimulation file setup 
with the MC_Stimulus II software as ASCII data. Please read the respective stimulus generator  
STG manual for detailed information about creating a stimulus file. You can import any pulse  
type available in MC_Stimulus II. 

 Program the file in MC_Stimulus II as usual; channel 1 will become stimulus 1 in MC_Rack,  
channel 2 will become stimulus 2, and channel 3 will become stimulus 3. 

 Export the file as ASCII file (MC_Stimulus II: File - Export ASCII) 

 Import this file in MC_Rack (Stimulus Tab: Import File) 

It is not necessary to program Sync Out pulses. Information in MC_Stimulus Channel 4 and up  
all Sync Out channels will be ignored.   
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The “Stimulus” interface will be disabled and the imported pattern will be shown in the graphical 
stimulus display. To skip the imported pattern and reactivate the “Stimulus” interface, click the 
“Unload File” button. 

 

Starting and stopping the stimulation 

In the "Trigger" drop down menu it is possible to choose different types of triggers to start the 
stimulation. The LED next to the Start / Stop button indicates the status of stimulation; the LED 
turns orange when the stimulation is running, the LED turns grey when the stimulation is stopped. 

Important: MC_Rack must not be running in "Play or Record" mode to be able to start a 
stimulation paradigm, but a running paradigm will continue even after MC_Rack is stopped.  
Once started, a programmed paradigm will run to its’ end, or till it is manually terminated. 

 

If "Manual" is selected in the "Trigger" drop down menu, the "Start" and "Stop" buttons  
can be used to control the stimulation manually.  

If "Start" is selected, the stimulation starts as soon as MC_Rack is started (in "Play" or "Record" 
mode). A delay between start of MC_Rack and start of stimulation in ms can be selected in the 
"Pre" time window. You can stop the stimulation paradigm by pressing the "Stop" button. 

If a "DigIn" is selected, the stimulation starts if a TTL pulse is delivered to the respective 
connectors Digital In 1 to 4 on the front of the MEA2100-System interface board.  

If the internal STG is connected to one or more "Trigger Detectors" in the MC_Rack virtual tree,  
it is also possible to start the stimulation on any of these Triggers (Trigger 1, 2 …). 
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If the “Real-time Feedback” tool is activated, any of the internal STG can be started on one  
of the conditions defined in the Real-time Feedback tool (RF1, RF2, …). Please see chapter  
“Real-time Feedback with MEA2100-System” for more information. The tool must be present  
and active, for the Real-time Feedback conditions to become available. 

If a new trigger arrives before the programmed stimulation paradigm is finished, the paradigm 
starts again from the beginning. All three stimulus channels can be started and stopped 
independently. 

To repeat a stimulation pulse in a loop, activate the “Continuous Mode”. The pulse will be applied 
continuously until it is stopped by manually with the “Stop” button. 

Selection of stimulation electrodes 

Click the “Channels” tab to assign the programmed stimulation patterns to individual electrodes, 
and to activate the blanking circuit BC, and to operate the “List Mode”. 

 

To apply the stimulation pattern of a specific stimulation channel (Stim. 1, 2 or 3) to one or more 
electrodes, select the desired stimulation channel (Stim. 1 to 3) and click the electrodes you want 
to apply this paradigm to. To apply the stimulation pattern to all electrodes, click the button “All” 
below the grid. Electrodes can be grounded or selected as regular recording electrodes (Not Stim.) 
in the same way. 

Electrodes selected for stimulation pattern 1 “Stim.1” are colored in blue, for stimulation pattern 
2 “Stim. 2” are colored in red, or stimulation pattern 3 “Stim. 3" are colored in yellow. To cancel a 
stimulation electrode, please use the radio button “Not Stim.” and click on the selected electrode. 

Blanking 

The blanking feature to avoid stimulation artifacts can be activated or deactivated via the check 
box “Blanking”. 

A blanking signal transiently switches off the input stage of the amplifier during the stimulus, 
thus avoiding stimulus artifacts on non-stimulating electrodes. 

Amplifier saturation is effectively prevented and the recovery time is greatly reduced. During the 
blanking period, a flat line is displayed. This blanking period extends a few hundred microseconds 
before and after the actual stimulus, currently 600 μs, but might be subject to change. The pre- 
and post-time are experimentally optimized and can not be changed by the user. 
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Dedicated Stimulation Electrodes  

The function “Dedicated Stimulation Electrodes” can be used to further avoid stimulation artifacts 
on the electrodes surrounding the stimulation electrode which are sometimes not completely 
removed by the blanking alone. Usually, the stimulation electrode will be connected to the 
stimulator output only during the stimulation pulse, and afterwards be switched back to the 
amplifier to be used as recording electrode. This sometimes causes switching artifacts 
independently from the actual stimulation.  

However, if the function “Dedicated Stimulation Electrodes” is active, the selected stimulation 
electrodes will be constantly connected to the stimulator outputs. This causes permanent higher 
noise on the selected stimulation electrodes, and makes of course recording on the stimulation 
electrodes impossible, but almost completely removes residual artifacts. The images below show 
stimulation on electrode F3 with and without “Dedicated Stimulation Electrodes” activated. 

Note: The artifact suppression additional to blanking via “Dedicated Stimulation Electrodes”  
is not available when using the “List Mode”. 

 “Dedicated Stimulation Electrodes” selected (X-Axis: 1000 ms, Y-Axis: +/- 500 μV) 

 

“Dedicated Stimulation Electrodes” deselected (X-Axis: 1000 ms, Y-Axis: +/- 500 μV) 

 

 

List Mode 

 

Clicking the button List Mode opens an additional window: List of Stimulation Patterns.  
In List Mode it is possible to generate and download a list of up to 256 user defined stimulation 
patterns, which will then be applied automatically one after the other. 
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When the List Mode is activated, the three stimulator units are coupled to a single starting 
trigger. The starting trigger is set in the tab of the first stimulator unit, Stimulus 1. In Stimulus 2 
and 3, the respective functions are disabled. To uncouple the stimulator units again, close the List 
Mode dialog. The step from one stimulation pattern to the next in the list happens when the start 
condition defined for Stimulus 1 occurs (for example, manual start, incoming trigger, real-time 
feedback trigger) and all three stimulator units are idle. Please see the red bars on the picture. 
However, the next pattern can only be started by the respective starting condition when the 
previous stimulation paradigm, including all breaks, is completely finished. 

 

That means, if one stimulation pattern of any of the three stimulator units is still running  
when the condition occurs, nothing will happen. This also holds true when a stimulator unit  
is not actually used in the currently active stimulation pattern.  

Hence, the longest programmed stimulation pattern determines the minimum possible time 
between two starting triggers, even if the respective stimulator unit is not actually used. It is 
therefore advisable to set a stimulation pattern with a length of 0 on all unused stimulator units, 
and keep all patterns as short as possible.  

A stimulation pattern can contain single or multiple stimulation electrodes and may get an  
user defined name. To create a list of different stimulation patterns, please do the following.  

Click the button “List Mode”. There are two windows in the “List of Stimulus Pattern”. The small 
window on the right side is for typing in a name for a pattern. In the window on the left side the 
list of stimulation pattern will be displayed and arranged. 

      

When opening the “List Mode” for the first time, the term “New” appears and the current 
stimulation pattern is the first stimulation pattern in the list. To change the name, please 
overwrite the name with the specific name of this pattern in the small window.  

To insert a stimulation pattern, select with the mouse the position in the list where you want  
to place the pattern. The line will be highlighted in blue. Type the specific name of this pattern  
in the small window. Click the button "New" and the new list entry appears. 

To append a pattern, select the line under the last list entry. The line will be highlighted in blue. 
Type the specific name of this pattern in the small window. Click the button "New" and the new 
list entry appears. 

To rename a pattern of the list, select the pattern which will be highlighted in blue.  
Then you can change the name of the pattern in the list. Please click the “Rename” button. 
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The command “Remove” eliminates the pattern in the list, which is highlighted in blue.  
With “Up” or “Down” you can move the patterns to arrange them in that sequence you  
like to apply them.  

Click “Download” to download the list of stimulation patterns to the internal stimulus  
generator of the MEA2100 headstage.  

To start the stimulation patterns in the list mode, please use the “Trigger Start” in “Stimulus 1” 
tab of this dialog. The trigger start in Stimulus 2 and Stimulus 3 tab will not be available,  
but all three triggers run simultaneously. 

The stimulation patterns from the list will be applied one after the other and change every  
time the start condition defined for Stimulus 1 occurs and all three stimulator units are idle,  
as described above. When the end of the list is reached, the software jumps back to the first 
pattern and continues. When the “Restart” button is pressed, the software jumps to the first 
entry in the list, respectively. 

 

Use of the Digital Channel in the MEA2100 

In contrast to the other MEA- and ME-Systems from Multi Channel Systems, the 16 input bits  
of the digital channel are not all accessible for external trigger signals, but are mostly used for 
internal communication between the different components of the MEA2100 system. Only the  
first four bits are connected to the physical DigIn connectors on the front side of the MEA2100 
interface board. Most bits are permanently assigned to certain functions. However, these settings 
can be customized if necessary. Please see the channels assignments from the following table. 

Bit  0 DigIn 1 Digital In channel 1 

Bit  1 DigIn 2 Digital In channel 1 

Bit  2 DigIn 3 Digital In channel 1 

Bit  3 DigIn 4 Digital In channel 1 

Bit  4 Stimulus 1 Stimulation pattern on channel 1 

Bit  5 Stimulus 2 Stimulation pattern on channel 2 

Bit  6 Stimulus 3 Stimulation pattern on channel 3 

Bit  7 Zero not connected 

Bit  8 RF 1 Real-time feedback specification 1 

Bit  9 RF 2 Real-time feedback specification 2 

Bit 10 RF 3 Real-time feedback specification 3 

Bit 11 RF 4 Real-time feedback specification 4 

Bit 12 RF 5 Real-time feedback specification 5 

Bit 13 RF 6 Real-time feedback specification 6 

Bit 14 RF 7 Real-time feedback specification 7 

Bit 15 RF 8 Real-time feedback specification 8 
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To monitor the digital data stream you can use the “Digital Display” tool. If a MEA2100 device 
is connected, the input bits will be labeled according to their function in the digital display.  

 

If a MEA2100-32 device is connected, the “Real-time feedback” is not available, respectively  
the real-time feedback specification 1 to 8 are not available. Therefore the input bits are used  
for the digital inputs, bit 0 to bit 12 to digIn 1 to 13. The stimulation channels are connected  
to the last three bits, bit 13 to stimulus 1, bit 14 to stimulus 2 and bit 15 to stimulus 3.  
The channels are labeled according to their function in the digital display. 

To record the digital data stream in the data file, please enable the respective check box  
in the “Channels" tab of the Recorder tool. 

.   
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Triggering on Stimulation Pulses from Internal STGs 

It is possible to trigger on stimulation pulses from any of the three internal stimulus generators. 
The three internal STG units send a trigger signals with each stimulation pulse on bits 4, 5 and 6  
of the digital channel, Stimulus 1 on bit 4, Stimulus 2 on bit 5 and Stimulus 3 on bit 6. Please see 
chapter “Use of the Digital Channel in the MEA2100” for more details. So to trigger, for example 
on each pulse of Stimulus 1, a Trigger detector in MC_Rack must be set to the Digital Channel,  
bit 4. Please see screenshot below. 

 

It is also possible to set the trigger detector to react on a signal from any of the three STG units. 
This might for example be useful to start a triggered recording if a stimulus is applied from any  
of the STG units. All three bits must be unmasked, and the bit value must be defined as > 0.  
See chapter “Triggering on TTL Pulses” for more information. 

 

Triggered recording and any instrument which is below the Trigger Detector in the virtual tree  
of MC_Rack can now work in relation to the selected STG unit(s). 

 

Real-time Feedback with MEA2100-System 

Important: The Real-time Feedback function is not available for the MEA2100-32-System! 

The interface board of the MEA2100-System is equipped with a high-capacity digital signal 
processor DSP. By moving the detection and analysis of signals from the data acquisition computer 
to the digital signal processor inside the interface, it is possible to run online filtering, analysis and 
feedback stimulation in real-time. Please read also chapter “Real-time Feedback”. 

At the moment, the real-time feedback is available for one instance of MC_Rack that means  
for one MEA2100-HS60, one MEA2100-HS120, or one MEA of a MEA2100-HS2x60. 

By default, eight of the 16 bits of the digital channels are permanently assigned to the Real-time 
Feedback function. For each of these eight bits, a different condition can be defined to release  
a trigger signal. These eight bits can be monitored with the Digital Display. See also “Use of the 
Digital Channel in the MEA2100”. The Real-time Feedback trigger signals are available in the 
“Trigger Detector”, and can also be directly selected to start the internal stimulus generators.  
See also chapter “Starting and Stopping the Stimulation”.  
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Setting up the Real-time Feedback Software 

The "Real-time Feedback" works the same way as with the other data acquisition systems of  
Multi Channel Systems. The "Real-time Feedback" tool must be the first instrument under the 
data source. Click "Edit" menu and add “Real-time Feedback” or click the real-time feedback  

icon  in the toolbar. Please also read the chapter “Real-time Feedback” for details. 

However, the dialog of the “Feedback Logic” tab is different for MEA2100-Systems. While the 
user can freely assign up o 16 different detection conditions to the 16 bits of the Digital Out 
channel in the other MEA- and ME-Systems, the MEA2100 offers by default up to eight conditions 
permanently assigned to eight bits of the Digital Channel. See also “Use of the Digital Channel  
in the MEA2100”. 
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3.5 Wireless-System 

3.5.1 Wireless System 

When using a wireless in vivo recording system, the “Hardware” tab is modified.  
Please see also chapter “Defining a Data Source” and read the Wireless-System manual. 

 

The additional option “Wireless” is for hardware and software control of the wireless in vivo 
recording system. One recording system can operate with up to four headstages simultaneously, 
but it is only possible to record from one headstage at a time. The headstages come preconfigured 
with different frequency bands by Multi Channel Systems MCS GmbH, and are labeled with A, B, C 
and D. The “Scan” function searches the complete frequency band and will detect all active 
headstages in range, and the radio buttons of the available headstages will become enabled  
in the “Select headstage” window. Now you can select one of the headstages for experimental 
processing only, the headstages do not work in parallel. In this example W8 headstages are 
connected and “A” is selected. Individual recording channels can be activated (pressed in)  
or deactivated. Inactivating channels can increase battery lifetime of the headstage. 

Note: With all electrode channels, the maximum sampling rate for the 8-channel Wireless 
Recording System W8-System is 20 kHz. It is possible to increase the maximum sampling rate  
up to 40 kHz by deactivating at least four electrode channels. Please pay attention to the 
sampling rate respectively, when using the W4-, W16- or W32-System. 

Note: Deactivated channels will vanish from displays and will be automatically deselected  
in analysis instruments (Analyzer, Spike Analyzer or the like). When reactivated, channels 
automatically reappear in displays, but must be manually reselected in the “Channels” tab  
of analysis instruments. 
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The button “Switch Off” can be used to send the currently selected headstage from “Stand By” 
mode to “Switched Off” mode, for saving battery energy. From this mode it is not possible to 
switch the headstage on again via software control.  

The blue LED mounted on the headstage of the Wireless-System indicates the recording phases.  
It can be switched into three modes via radio button. Select “Off” if the laboratory animal  
is disturbed by the light. Switching off the LED will save a little bit of energy. Select “Blink”  
and the LED flashes during recording. Select “On” and the LED will be on permanently. This 
feature can be used, for example for camera tracking. The W32-headstage is equipped with two 
LEDs, a blue one and an additional red one which can be switched independently of each other. 
The user has the same options to set the red LED. Both LEDs together improve the camera 
tracking, because with two LEDs it is possible to track the orientation of the headstage. 

Choose a “RF Output Power” value from the drop down menu. The smaller the value, for example 
–18 DB, the longer the storage battery will support the recording, but the smaller the distance 
between animal and receiver. 

When operating a wireless in vivo system, there is an additional “WPA” status display for 
visualizing the current status of the connected headstage in the status bar at the bottom  
of the MC_Rack window. 

 

 The WPA status display appears in green color when the W8-System is running. The color turns 

into yellow   three seconds after the data acquisition is stopped. The yellow color 
indicates a stand by mode: The headstage is in energy saving mode, but can be started again  
by pressing the MC_Rack “Start” button.  

The WPA status turns red if the recording system does not have contact with the selected 
headstage. This can be the case if the “Switch off” button has been used to send the headstage 
into “Switched Off” mode, if the battery of the headstage is removed, or if the headstage is out 
of transmitting range.  

 

The status will automatically become green or yellow again if a headstage comes back into range. 
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4 MC_Rack Features 

4.1 About MC_Rack Features 

This section provides more detailed information on all features of MC_Rack. The topics  
are in a systematic order. 

4.2 Data Acquisition Settings 

4.2.1 Data Source Setup 

From the Edit menu, select Data Source Setup to configure the software according to your 
MEA2100-System, USB based data acquisition or MC_Card hardware. Data Source Setup  
is only available as long as your current virtual rack is empty (that is, only a Recorder, but no  
data acquisition or Replayer in the virtual rack). Configure the channel layout first and then set 
up the rack configuration, because it is not possible to change the data source setup or channel 
layout later. 

The data source and channel layout configuration is saved together with the rack (*.rck) file, that 
is you can set up different racks for different hardware configurations. For example, the number 
of electrode channels may vary in different ME-System setups. As a MEA-System use, you only 
have to decide whether you have a MEA2100-System, a USB based data acquisition, or a MEA60-
System (with a 64 channel MC_Card) or a MEA120-System (with a 128 channel MC_Card). The 
number of electrode channels is fixed and cannot be changed for a MEA-System, but it can be 
altered in USB based data acquisition systems. 

You can also select Simulation as the data source. In Simulation mode, no data is acquired  
from the data acquisition, but simulated waveforms are played and can be used for trying out 
MC_Rack features. You can choose between sine waveforms on all channels, or the default 
simulation (different waveforms on a number of channels). If no data acquisition is installed  
(or if it is not properly installed), only Simulation is available as the data source. 
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If you use MC_Rack together with devices which do not require a MC_Card, but use an internal 
data acquisition and USB data transfer, the name of the connected device and its serial number 
will appear in the right Data Source drop down menu, for example, USB-ME16 or USB-ME256.  
On the left Data Source drop down menu is "USB MEA" displayed instead of MC_Card. Select  
the desired device as data source. 

 

Note: If you open a rack with a different channel layout, the channel layout of the opened rack 
will be used. You can check the data source setup of the loaded rack by selecting the data source 
in the tree view pane of the virtual rack, and clicking the Info tab, as shown in the following 
screen shot. 

 

Important: Please note that the data source layout you choose (1-dimensional or 2-dimensional) 
does not only affect the numbering of the electrodes, but may also affect the compatibility with 
third party programs, for example, the MEA Tools. Make sure you always select the appropriate 
layout before setting up a virtual rack, and make always sure that the data source layout of the 
loaded rack file is appropriate before starting the data acquisition. 

 
 



MC_Rack Features 

69 

MEA60-System 

Select 2 dimensional (MEA) if you are using a microelectrode array (MEA) and a MEA60-System 
with 60 electrode channels, three analog channels, and a digital channel. The number and layout 
of channels is pre-configured and cannot be altered. 
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MEA120-System 

Select 2 dimensional (MEA) if you are using two MEA1060 amplifiers and a MEA120-System 
with 120 electrode channels, 7 analog channels, and a digital channel. The number and layout of 
channels is pre-configured and cannot be altered. Only three of the analog channels (A1, A2, A3) 
are supported by the BNC connectors installed on the data acquisition computer. 
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Linear (custom) Layouts / ME-Systems 

Select 1 dimensional if you are using any other type of data source, for example, a ME-System  
or a custom setup. Define the number of channels provided by your hardware, and specify how 
many electrodes (data amplified by the main amplifiers, for example, a MPA and a following  
filter amplifier) and how many analog inputs (for example, from a temperature controller  
or a microphone) are present. For the electrode channels, the original signal is calculated 
automatically according to the gain settings in MC_Rack. Signals on the analog channels  
are recorded "as is", with no respect to the gain. 

Deselect the option Digital Input Channel, if you do not want to use the digital input channel. 
One of the digital input bits can be used for triggering the recording on a TTL output of the 
stimulator, for example. A typical configuration of an ME64-System would be 63 electrodes  
and a digital channel. 
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Data Source Configuration 

Click "Configuration".  

Configuration is an option that can also be used with MC_Card data acquisition (64 or 128 
channels), but is recommended for the USB based data acquisition systems USB-ME64 / USB-
ME/128 / USB-ME256. When selecting the configuration option, it is first necessary to adjust the 
number of channels available. After that you can select the amplifier(s) and MEA(s) in use from  
a drop down menu. To configure the MEA layout, please use the right drop down menu "MEA".  
To configure the amplifier, please use the left drop down menu "Amp" (MEA1060 without 
blanking circuit, gain factor 1200, and MEA1060BC with blanking circuit, gain factor 1100 for 
MEA-Systems, and FA64I/S, FA32I/S for ME-Systems). 
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In MEA120-System it is possible to configure both amplifiers independent of each other. 
Additionally it is possible to configure the MEA layouts of both MEAs A and B individually. 

Note: Setting up the configuration of the data source is important for having the correct layouts 
for MEA A and MEA B during the complete experiment. 
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USB-ME16-FAI-System 

The USB-ME16-FAI-System does not require a MC_Card, but uses an internal data acquisition.  
Data can be transferred via USB 2.0 port to any data acquisition computer. Please see USB-ME16-
FAI manual for detailed information. Select USB MEA from the left Data Source drop down list.  
The USB MEA device will be specified on the right Data Source drop down menu: USB-ME16  
(S/N: 00001). The number in brackets is the serial number of the device. The data source layout  
is 1 dimensional, with 16 electrode channels, and an additional digital channel. 

 



MC_Rack Features 

75 

USB-ME32-FAI-System 

The USB-ME32-FAI-System does not require a MC_Card, but uses an internal data acquisition. Data 
can be transferred via USB 2.0 port to any computer. Please see USB-ME32-FAI manual for detailed 
information. Select USB MEA from the left Data Source drop down list. The USB MEA device will 
be specified on the right Data Source drop down menu: USB-ME32 (S/N: 00001). The number in 
brackets is the serial number of the device. The data source layout is 1 dimensional, with 32 
electrode channels, and an additional digital channel. 
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USB-ME64 / USB-ME128 / USB-ME256 Data Acquisition 

The USB-ME64 / 128 / 256 data acquisition systems are in principle the same devices, except  
for the total number of channels. 

USB-ME256 Data Acquisition 

The USB-ME256 is an external data acquisition device that uses USB 2.0 connection to transfer 
digitized data to any connected computer. Please see USB-ME64 / 128 / 256 manual for detailed 
information. Select USB MEA from the left Data Source drop down list. The USB MEA device will 
be specified on the right Data Source drop down menu: USB-ME256 (S/N: 0004). The number in 
brackets is the serial number of the device. Adjust the number of channels available. 
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Click Configuration in Source Layout. Choose 256 as total number of channels from the drop down 
list under "No. of Channels". 

 

In USB-ME256-System it is possible to configure four MEA1060 / MEA1060BC amplifiers 
independent of each other. Click the amplifier drop down menus on the left side. Additionally  
it is possible to configure the MEA layouts for up to four MEAs A and B, C and D independent  
of each other. Click the MEA drop down menus on the right side. 
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On the Edit menu, click Advanced Configuration to configure the software according to the  
USB-ME256 hardware. Please see Advanced Configuration for detailed information. The dialog 
Advanced Configuration is for optionally defining as many instances of MC_Rack software  
as necessary. That means, you are able to work with several MC_Rack versions in parallel, for 
example, when using the USB-ME256 with up to four MEA1060 amplifiers. With setting "Max. 
Number of MC_Rack Instances = 4" in Advanced Configuration you can control each of the four 
amplifiers independent from the others with its own MC_Rack software. 

Note: Setting up the configuration of the data source is important for having the correct layouts 
for MEA A, B, C and D during the complete experiment. 

USB-ME128 Data Acquisition 

The USB-ME128 device is in principle the same device as the USB-ME256, except for the total 
number of channels that is 128.  

The USB-ME128-System does not require a MC_Card, but uses an USB 2.0 port for the data transfer 
to the data acquisition computer. Please see USB-ME128 manual for detailed information. Select 
USB MEA from the Data Source drop down list. The USB MEA device will be specified on the right 
Data Source drop down menu: USB-ME128 (S/N: 0002), for example. The number in brackets is the 
serial number of the device. 

In USB-ME128-System it is possible to configure two MEA1060 / MEA1060BC amplifiers 
independent of each other. Additionally it is possible to configure the MEA layouts for MEA A  
and MEA B independent of each other.  

On the Edit menu, click Advanced Configuration to configure the software according to the  
USB-ME128 hardware. The dialog  Advanced Configuration is for optionally defining as many 
instances of MC_Rack software as necessary. That means, you are able to work with several 
MC_Rack versions in parallel, for example, when using the USB-ME128 with two MEA1060 
amplifiers. With setting "Max. Number of MC_Rack Instances = 2" in Advanced Configuration  
you can control each of the two amplifiers independent from the other with its own MC_Rack 
software. 

Note: Setting up the configuration of the data source is important for having the correct layouts 
for MEA A and B during the complete experiment. 

USB-ME64 Data Acquisition 

The USB-ME64 device is in principle the same device as the USB-ME256, except for the total 
number of channels that is 64.  

The USB-ME64-System does not require a MC_Card, but uses an USB 2.0 port for the data transfer 
to the data acquisition computer. Please see USB-ME64 manual for detailed information. Select 
USB MEA from the Data Source drop down list. The USB MEA device will be specified on the right 
Data Source drop down menu: USB-ME64 (S/N: 0002), for example. The number in brackets is the 
serial number of the device. 

In USB-ME64-System it is possible to configure the MEA1060 / MEA1060BC amplifier. Additionally 
it is possible to configure the layout of MEA A. 

Note: Setting up the configuration of the data source is important for having the correct layout 
for MEA A during the complete experiment. 
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USB-MEA256 Data Acquisition and Filter Amplification 

The USB-MEA256 is an external data acquisition device with integrated filter amplifier that uses 
an USB 2.0 connection to transfer digitized data to any connected computer. Please see USB-
MEA256 manual for detailed information. Select USB MEA from the left Data Source drop down 
list. The USB MEA device will be specified on the right Data Source drop down menu: USB-MEA256 
(S/N: 00007). The number in brackets is the serial number of the device.  
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Wireless Recording System 

The wireless in vivo recording system is the all-in one solution for amplifying, recording, and 
analyzing in vivo data from eight channels that uses a wireless connection between headstage 
and receiver and an USB 2.0 connection to transfer digitized data to any connected computer. 
Please read the Wireless-System manual for detailed information. Select USB MEA from the left 
Data Source drop down list. The W8-System device for example, will be specified on the right  
Data Source drop down menu: MCS WPA8 (S/N: 00001). The number in brackets is the serial 
number of the system. The data source layout is 1 dimensional, with 8 electrode channels and  
an additional digital channel. 

Note: With all electrode channels, the maximum sampling rate for the Wireless Recording System 
is 20 kHz. It is possible to increase the maximum sampling rate up to 40 kHz by deactivating at 
least four electrode channels. Please pay attention to the sampling rate respectively, when using 
the W4-, W16- or W32-System. 
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MEA2100-System 

The MEA2100 recording system is an all-in one solution consisting of headstage and interface 
board. The MEA2100-System with integrated amplification, data acquisition, online signal 
processing, and integrated stimulus generator. You can connect one or two headstages to the 
interface board. The MEA2100-System uses an USB 2.0 connector per headstage to transfer 
digitized data to any computer. Please read the MEA2100-System manual for detailed 
information.  

Select USB MEA from the left Data Source drop down list. The MEA2100 device will be specified 
on the right Data Source drop down menu: MEA2100 (S/N: 0000-A).The number in brackets is  
the serial number of the system, the character A labels the connected headstage, A is the first 
headstage, B is the second headstage. It is possible to run up to two instances of MC_Rack per 
headstage . Please read chapter "Advanced Configuration". Specify the “Number of Channels” 
first: 32 electrode channels, when connecting one headstage with 32 recording and 12 stimulation 
electrodes (MEA2100-HS32), 64 when connecting one headstage with 60 channels (MEA2100-
HS60) or 128 electrode channels when connecting two headstages with 60 channels (MEA2100-
HS60) or one headstage with 120 channels (MEA2100-HS2x60 or MEA2100-HS120) to the interface 
board. Choose “Configuration” in the data source layout. Enable the check box for the digital 
input channels. Select the correct headstage in the “Amplifier” drop down menu and specify  
the type of MEA. 
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In MEA2100-System it is possible to configure two headstages independent of each other. 
MC_Rack identifies two connected headstages as completely different devices. They are defined 
via the character A or B in the serial number in the right "Data Source" drop down menu.  

It is also possible to run two MC_Rack instances per headstage, for example for recording  
from the 2x60 channels of the MEA2100-HS2x60 headstage separately. Please read chapter 
"Advanced Configuration". Click the Amplifier drop down menus on the left side to configure  
the "Amplifier". Additionally it is possible to configure the MEA layouts for up to two MEAs  
A and B independent of each other. Click the MEA drop down menus on the right side. 

 

MEA2100-32-System 

The MEA2100-32-System is a descendant of the MEA2100-System with the same functions except 
of the real-time feedback. Please read the MEA2100 Manual for detailed information. Select USB 
from the left Data Source drop down list. The MEA2100-32 or MEA2100-2x32 device will be 
specified on the right Data Source drop down menu: MEA2100-32 (S/N: 00018-A). The number  
in brackets is the serial number of the device. The data source layout is Configuration, with 32 
electrode channels, and an additional digital channel. 
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4.2.2 Defining Hardware Settings 

Before you start building a rack, configure first the software according to your hardware and 
amplifier. The following example is for MC_Card and MEA1060 amplifier. 

 Select the MC_Card from your rack and click the Info tab to see the channel layout information 
of your current rack. You cannot modify the settings anymore once you have added the MC_Card 
or the Replayer to your rack. If the settings are not appropriate, remove the MC_Card from your 
rack and change the channel configuration. 

 

 Click the Hardware tab to define the other settings, like the amplifier gain and sampling 
frequency. 

 

Signal voltage range 

Please define first the "Amplifier Gain" and then the "Input Voltage Range of the Data 
Acquisition Board". The "Signal Voltage Range" is calculated by dividing the "Input Voltage 
Range of the Data Acquisition Board" and the amplifier gain factor. 
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Amplifier gain 

Specify the gain of the amplifier used. The gain is an intrinsic option of the device and can not be 
altered. Make sure to use the gain the device actually has. Otherwise the recorded data will have 
wrong voltage values. The default amplifier gain of a MEA1060 amplifier is 1200. For MEA2100-
Systems the amplifier gain is automatically set depending on the hardware. Any value between  
1 and 1,000,000,000 is valid. The original signal is calculated automatically from the input and the 
amplifier gain. 

Important: The gain is a hardware property. You cannot change the gain of the amplifier with 
MC_Rack. Make sure you use the gain that the amplifier actually has. This is especially important  
if you use a PGA amplifier with programmable gain. Use the PGA-Control program to change the 
PGA's gain and make sure you specify the same gain in the MC_Rack program as well. Otherwise, 
the recorded data will have wrong voltage values. 

 Click Enter... to change the amplifier gain settings. 

 

Input voltage range of data acquisition board 

You can adjust the input voltage range of the MC_Card from +/- 400 mV to +/- 4 V with the 
software control in the MC_Rack program. The lower the input voltage range, the higher is the 
voltage resolution. You need a higher input voltage range if your biological sample generates 
higher voltages, for example, cardiac signals from whole-heart preparations, and / or if the 
amplifier gain is higher, so that the amplified output signal amplitude is higher, too. For spike 
data, an input range of  -819 to +819 mV will in most cases be fine, whereas for sum field 
potentials like LTP that can be in the range of mV, you will probably need a higher input range. 

For example, if you have a standard MEA amplifier with a gain of 1200, and choose a MC_Card 
input voltage range of 819 to +819 mV, this results in a signal input range of -682 to +682 μV. 

With a MC_Card with 14-bit resolution and an input voltage range of -819 to +819 mV, the 
voltage resolution of the MC_Card will be 0.1 mV or 100 μV: A 14 bit resolution means 214 = 16384 
available voltage values.  819 mV * 2 = 1638 mV total input voltage range / 16384 = 0.1 mV. For  
a standard MEA amplifier with a gain of 1200, this means a resolution of 83 nV for the recorded 
original signal. 

 Select the desired input voltage range from the Input Voltage Range of Data Acquisition 
Board list. 
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Sampling frequency 

As a rule of thumb, the sampling rate should equal five times the highest signal frequency for  
a good digitized representation of the continuous analog signals. You would, for example, use  
a 5 kHz sampling rate when using a MEA1060 amplifier with a cutoff frequency of 1 kHz. It should 
be set according to the steepest slope of the expected signal. If the shape or amplitude of the 
signal is very important for your analysis, an even higher sampling rate might be appropriate.  
The maximum sampling rate is 50 kHz. 

Please note that the sampling rate influences the amount of disk space needed and the computer 
performance. Do not use a higher sampling rate than necessary. If you have a low signal 
frequency (for example, from heart cells), you can use a much lower sampling rate than if you 
have high frequency signals (for example, from neurons). (For more information on recording  
and file size see "Recording Data"). 

If the sampling rate is too low, you will miss signals and / or see artifacts. The sampling rate  
should also be at least twice the bandwidth of the MEA1060 amplifier. Otherwise, aliasing occurs. 
See also the chapter "Filtering and Sampling Rate" for more information about aliasing. 

Note: The sampling frequency should be at least five times the highest signal frequency  
and at least twice the bandwidth of the MEA1060 amplifier. 

 Select the desired sampling frequency from the Sampling Frequency list. 

Maximal Sampling Frequency using the data acquisition devices USB-ME256  
and USB-ME128 

Usually, the maximal sampling frequency for MCS data acquisition systems is 50 kHz. However, 
when using some advanced features of the USB-ME256 and USB-ME128, some limitations apply.  

The maximal sampling frequency that can be achieved with 256 channels is 40 kHz. This is possible 
when using the USB-ME256 with the "virtual device configuration" 1 x 256 (Please see Advanced 
Configuration). With the USB-ME256 and USB-ME128 it is also possible to split the data stream 
into 2 x 64 or 2 x 128 and into 4 x 64 channels, respectively, again by using the "virtual device 
configuration". These virtual machines can then be controlled independently by up to four 
instances of MC_Rack. However, splitting the data stream into several virtual devices consumes 
system performance. Therefore, the maximal sampling frequency is limited to 25 kHz when using 
the virtual device configuration 2 x 64 (USB-ME128) or 2 x 128 and 4 x 64 channels (USB-ME256). 

Offset Correction 

An offset correction is generally not necessary, because the intrinsic DC offsets of the MCS 
amplifier outputs and the MC_Card are very low in comparison to the signals of interest. You can 
use the offset correction feature to remove even this low offset and reset all channels to zero. 

Note: If you observe a large offset on any channel(s), you should contact your local retailer for 
troubleshooting. The offset correction is not intended for removing large offsets, because the 
offset correction will decrease the input voltage range.  

1. Click Offset Correction to activate the offset correction..  

2. Click Learn Offsets to perform an individual offset correction for each input channel. MC_Rack 
takes 100 ms of the recorded data in the moment when the button is pressed to calculate the DC 
offset. The mean of this 100 ms sweep is subtracted from the recorded data as long as the Offset 
Correction button is pressed. The individual offset values for each channel are saved in the local 
settings of the data acquisition computer and are only overwritten when you click Learn Offsets 
again. Make sure you press the Learn Offsets button only when you have no real input signals 
or irregular noise signals on the electrodes. To be on the safe side, you can connect a test model 
probe to the amplifier. 
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4.2.3 Channel Tool 

The Channel Tool feature in MC_Rack allows the selection of one MEA electrode as reference 
electrode. The tool works similar to the offset correction and influences the signal to noise ratio.  
If there are problems with homogenous noise on all electrodes, the user is able to select one 
electrode without signal as reference. The voltage value of this reference electrode will be 
mathematically subtracted sample point per sample point from all electrode signals in the stream. 
For example, a low frequency noise on all electrodes will be eliminated this way.  

 

Note: Be careful to choose an electrode with noise only as reference electrode. If the reference 
electrode contains signals too, the value of the signals will be subtracted together with the noise 
value, and falsify the data.  

Click the "Channel Tool" icon  in the main window toolbar, or select "Channel Tool"  
from the Edit menu. The following dialog appears. Click the "Channels" tab. 

 

Select the data stream you want to apply the channel tool: Electrode Raw Data in this example. 
Select a "Reference electrode" from the "Reference electrode" drop down menu. 
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4.2.4 Grouping Multitrode Channels 

Channels from electrodes with multiple channels (tetrodes or stereotrodes, for example) can be 
grouped. This feature will help to analyze signals from multitrodes with MC_Rack or with other 
analysis tools that can import MC_Rack files in the future. Right now, this feature is new and not 
supported yet. But we recommend to use the grouping anyway to take advantage of improved 
analysis features that will be made available in the future. 

1. Add the data acquisition to your rack, and click the Group tabbed page to define the groups. 
This page is only available if you use a 1 dimensional channel layout (see Setting Up the Channel 
Layout). 

2. Define the number of electrodes with multiple channels. On the right, the layout is updated 
accordingly. Each column represents a multitrode. 

3. Define the number of channels per electrode. The number of rows is updated accordingly. 

4. Assign the appropriate channel numbers to each channel. 

You can load or set up predefined channel maps. See “Setting Up a Channel Map” for more 
details on the subject. 

 

4.2.5 Simulation Mode 

The simulation mode is available for users who are interested in learning more about the 
MC_Rack features, but do not have a data acquisition hardware available. Without properly 
installed hardware, MC_Rack starts in Simulation mode automatically. However, you can also 
switch from the default mode to the Simulation mode if you have installed a data acquisition 
device, for example, if you want to prove MC_Rack without connecting an amplifier.  

In Simulation mode, no data is acquired from the data acquisition, but simulated waveforms  
are played and can be used for trying out MC_Rack features. You can choose between sine 
waveforms on all channels, or the default simulation (different waveforms on a number of 
channels). The third option is "File Source". Selecting this option an additional window pane 
appears and you are able to browse through your folders.  

If no data acquisition is installed (or if it is not properly installed), only Simulation is available  
as the data source. 

 

Warning: Make sure that you select the data acquisition as the data source (not the 
simulation) before starting an experiment. You cannot use a virtual rack that uses Simulation 
as the data source for experiments. With Simulation as the data source, no data will be 
acquired from the data acquisition. 

1. From the Edit menu, select Data Source Setup. Data Source Setup is only available as long  
as your current virtual rack is empty (that is, only a Recorder, but no data acquisition or 
Replayer in the virtual rack). 
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2. Select Simulation from the Data Source list. Select either Sine Waves, Default or File Source. 

3. Choose a data source layout and the number of channels. For more information, see "Data 
Source Setup". 
 

 

With the option "File Source" in simulation mode you can open binary files with the extension 
".raw" for simulating data. It is recommended to create these binary files with the software 
MC_DataTool, but you can use different software just as well, however the format of the file  
has to be binary. 

Note: When creating a binary file with MC_DataTool, make sure to export as many channels  
to the binary file as should be simulated later. 
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Open a binary file in MC_Rack in simulation mode. Data of this file is repeated in a infinite loop. 
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4.3 Data Streams and Channels 

4.3.1 Data Stream Types 

A data stream can include several channels of the same data type. The term channel means  
the data from a single data acquisition input pin, that is, one electrode. 

Several different data streams can be generated, handled, processed, and recorded by MC_Rack. 
Data streams are either acquired by a MEA2100-System, an USB based data acquisition device or 
the MC_Card, for example, Electrode Raw Data, Analog Raw Data, and Digital Data, or they are 
generated by MC_Rack when processing input streams, for example, Trigger, Parameter, Spikes 
and Filtered Data. 

You can adjust the number of analog and electrode channels according to your hardware  
in the Channel Layout dialog box, up to a total of 256 channels. One digital input stream  
with 16 channels (input bits) is available. 

If you assign data to MC_Rack instruments, for example, the Recorder, you can select complete 
data stream(s), or you can pick individual channels of interest from a data stream. 

In the following list, all data streams available in MC_Rack are briefly described. Some more 
complex data stream types are explained in more detail in the following chapters. 

Definition of Data Stream Types 

Electrode 
Raw Data: 

Unprocessed analog data acquired from an amplifier, for example, from a 
MEA2100 headstage, a MEA1060 amplifier for MEA electrodes or from a ME 
preamplifier like MPA8I or a wireless headstage. The amplifier gain can be 
specified in MC_Rack, so that the original signal is calculated automatically. 

Analog 
Raw Data: 

Analog non-amplified data that is directly delivered to the data acquisition via 
BNC connectors, for example, channels A1, A2, A3 in the typical MEA layout.  
In MEA2100-Systems are eight, in USB-MEA- or USB-ME-Systems are four 
additional analog channels available. The data are delivered to the internal data 
acquisition, and send to the data acquisition computer via USB High Speed. You 
can use it to record additional information from external devices, for example, 
the heart rate, and so on. You can connect the Sync Out of a STG (stimulus 
generator) to an analog input to synchronize stimulus application and recording. 

Digital 
Data: 

The 16 digital input channels of the data acquisition device can be used to record 
additional information from external devices as a 16-bit encoded number, or you 
can connect the Sync Out of a STG (stimulus generator) to a single input bit for 
synchronizing stimulation and recording. A digital IN/OUT connector is also 
available in MEA2100-, USB-MEA- and USB-ME-Systems. The 16 digital input 
channels are represented as the Digital Data stream that is, a stream of 16-bit 
values, each bit (0 to 15) representing one digital input. Standard TTL signals  
are accepted as input signals on the digital inputs. There are two possible logical 
states for each bit: 0 (low = 0 V) and 1 (high = 5 V). The digital input channels  
are sampled with the overall sampling rate selected in MC_Rack. 
In the standard configuration, TTL signal sources can be connected to 3 BNC 
inputs (input bits 0, 1, 2). Alternatively, a 68-pin socket supporting all 16 input 
and output bits and a digital in / out extension with 16 BNC inputs and outputs 
can be ordered as accessories. Unused input bits, which have an undefined state, 
should be masked in the Trigger Detector. 

For example, if the digital input bit 0 is set to high, the binary 16-bit value will  
be 0000000000000001, or 1 as a decimal number. If channel 2 is set to high, the 
value is (binary) 0000000000000010, or (decimal) 2, and so on. Any combination 
of logical states of input bits is represented by the 16-bit value. 
For more details on the use of the Digital Data stream for triggering MC_Rack, 
please see the chapter Trigger Detector under MC_Rack Features. For more 
background information on digital data and binary code, please see the chapter 
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About Digital Data and Binary Code under MC_Rack Features, General Aspects. 

Trigger: Generated by a virtual Trigger Detector. A trigger is used to control virtual 
instruments or to record triggered data. For example, you can use signals from  
an external device (for example, from the Sync Out of a STG) for triggering.  
For electrode raw data, parameters, or filtered data, you can define a threshold 
for triggering. You can define a bit pattern for using digital signals as a trigger.  
You can also program an automatic time-based trigger. The manual trigger 
allows the user to generate a trigger event manually during data acquisition. 

Filtered 
Data: 

Generated by a virtual Filter. You can use several filters with different cutoff 
frequencies in your rack, for example, to remove background noise from your 
signals or to separate spike activity from local field potentials. 

Spikes: Generated by a virtual Spike Sorter. Spikes can be detected by a threshold  
or by their shape. Spike data streams can be overlaid or displayed as a Raster 
Plot, sorted into up to three categories, or analyzed (the spike rate, for example). 

Parameter: Generated by a virtual Analyzer. Several independent parameters can be 
extracted from the same or separate input streams, for example, the peak- 
to-peak amplitude, the spike rate, and so on. 

Averager: Generated by a virtual Averager. You can average sweeps to enhance the  
signal to noise ratio. The averaged data can be saved and displayed. In addition 
to the averaged data stream, a trigger data stream is created (Avg Trigger).  
This trigger event is the time point of the last sweep. You need this trigger 
information to access the averaged data later. See also Averaged Data for  
more information. 

4.3.2 Channel Selection 

In the dialog box of the Recorder, Filter, Spike Detector and Analyzer tool, click the  
Channels tab to assign individual channels to the according virtual instrument. 

You can conveniently select and deselect channels with the button array on the right side.  
You can choose single channels for recording, analyzing or displaying simply by clicking the 
appropriate buttons. 

The button array is arranged either in the layout of the MEA or in a linear fashion depending  
on the currently selected stream and channel layout. 

Selecting a data stream 

The button array of the selected data stream is shown. The currently selected stream is 
highlighted in blue. If you want to switch to the button array of another stream, select that 
stream in the tree view to update the button array. 

 Click the desired data stream listed on the left. A button for each channel of the selected data 
stream is shown. 

Selecting a channel 

The buttons represent single channels and have a toggle function. Click a button to select  
or deselect a channel. 

 Click a button to select a channel. A selected channel button appears pressed in. 

 Click a selected channel again to deselect it. 
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If you want to select or deselect all channels of a stream, check the box next to the stream name 
in the tree view. 

 

Note: Click a data stream first to display the corresponding button array. Make sure you have 
selected the appropriate stream when selecting a channel. 

4.3.3 Continuous and Triggered Data 

You can create either continuous or triggered data files. Continuous data means that the data  
is recorded / processed by the virtual instruments as a continuous data stream without regard  
to a trigger event. Continuous data may still be synchronized to another system by starting the 
recording of the file on a trigger event. Triggered data means that only data sweeps around a 
specific trigger event are displayed, saved, analyzed, and so on. This has nothing to do with the 
data stream types included in the data file: All data streams can in principle be recorded either 
continuously or triggered, though it generally does not make much sense for all data stream 
types. For example, the recording of spike cutouts would be a typical application for a continuous 
recording (even though the spike data stream itself is not really continuous, it is treated as a 
continuous stream in MC_Rack), and the recording of evoked field potentials like LTP would be 
typical for a triggered recording (synchronized with the stimulation). Extracted parameters like 
the spike rate are a special kind of data stream, because these data streams include only single 
data points. Trigger settings in the Recorder do not apply to parameter streams. 

A trigger event can be a biological signal crossing a threshold, or an external trigger event,  
like a TTL pulse. The trigger event is specified with the Trigger Detector. 

The Recorder, the Data Display, the Analyzer, and the Averager can be triggered by a trigger 
event. You can define several triggers and assign them to separate virtual instruments. Use the 
Window tabbed page of a virtual instrument to assign a trigger to it (Settings to assign a trigger 
to the Averager, ROI for the Analyzer). 

Note: MC_Rack stores the last two seconds of recorded data streams in a temporary virtual 
memory. Therefore, it is not possible to display streams with sweeps that are longer than 2 s in 
MC_Rack. You can record longer sweeps and export the data to other analysis programs, though. 
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When using the Replayer for replaying triggered data, make sure all other virtual instruments  
in your rack are set up according to the data type. It is not possible to display triggered data 
streams continuously (as there are "gaps" between the sweeps where no data was recorded).  
The maximum x-axis range is limited by the sweep length. See the File Info of the Replayer to 
obtain all necessary information on the data file, such as the sweep length. 

Assigning a trigger event to a virtual instrument 

You can trigger a virtual instrument by any Trigger data stream. The trigger event is referred  
to as a time point of 0. 

 

In the following example, the virtual instrument starts to process the data 30 ms before the 
trigger and stops after a total time of 200 ms (170 ms post-trigger time). This results in 200 ms 
sweeps. Please read chapter "Triggering MC_Rack on a stimulus" for more information about 
"Window Extent" settings. 
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4.3.4 Averaged Data 

Averaged Data, that is, a data stream generated by an Averager, is a special kind of triggered 
data. Only the last sweep of each averager cycle is added to this data stream. Therefore, a so-
called Avg Trigger is saved together with the Averaged Data stream (not to be confused with the 
Averager Trigger that triggers the Averager). This Avg Trigger marks these last sweeps of a cycle. 
If you assign averaged data to another instrument, the Analyzer or a display, for example, you 
should use the Avg Trigger to trigger this instrument. 

Recording averaged data 

Together with the averaged data stream, the Avg Trigger is saved in the data file. You need  
this trigger when you assign the Averaged Data stream to another instrument, for example  
for triggering a Data Display. 

Note: If you want to record averaged data and triggered data in the same data file, please  
make sure that the Start Time and Window Extent of the Averager and the Recorder match. 
Otherwise, you will not be able to review the Averaged Data stream later. 

Replaying (or graphing) averaged data 

In the following, it is described how to review an already save averaged data stream with the 
Replayer. For more information on how to generate an averaged data stream (either online 
during data acquisition or offline with the Replayer), please see chapter "Averager", "Averaging 
Data Sweeps". 

For replaying recorded Averaged Data streams, click  to add a Data Display to the virtual 
rack. Do not use the Averager, which is only used for generating Averaged Data streams! 

In the tree view pane of the virtual rack, select the Data Display (here: Display 1), and click the 
Data tabbed page. Select the Averaged Data stream (here: Averager 1). You can select the raw 
data stream as well, to overlay the averaged data with the raw data, for example. 
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Click the Window tabbed page and select the option Start on Trigger. Select the Avg Trigger 
that was recorded together with the Averaged Data stream. 
 

 

1. Click the Start button to start the Replayer. The averaged data sweep will appear at the time 
point when it was generated during the recording (here: after summing up 20 sweeps). 

 

Overlay of averaged and raw data. The averaged data (in blue) was generated by summing up  
20 x 200 ms sweeps (from 10 to 190 ms relative to the trigger event) and overlaid with the raw 
data (in grey). 
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4.3.5 Digital Data and Binary Code 

Only two voltage levels are allowed as an input of the 16 digital channels: 0 Volts or 5 Volts.  
This means, that each channel can have either the state high (5 Volts), also called 1 or On,  
or low (0 Volts), also called 0 or Off. For example, if you use the Sync Out of a stimulus generator 
(STG) or another external device to trigger the recording, you can connect the device to one  
of the 16 digital channels. When the device is active, it sends a 5 V signal and the bit of the 
corresponding channel is high. This event can be used as a trigger (see Trigger Detector) for 
recording, or for triggering displays or analyzers. 

For special advanced applications, it is also possible to encode more complex information from 
external devices in binary code. Because a single bit can only store two values, bits are combined 
together into large units in order to hold a greater range of values. Each bit combination encodes 
a decimal number. (Decimal numbers are the numbers we usually use in daily life.) The more bits 
you have, the more information you can encode. The number of possible values is 2 to the powers 
of N, where N is the number of bits. 

If a bit is Low, its decimal weight value is 0. If it is High, the bit has a decimal weight value 
according to its position (see following table). The first bit has the number 0, and its decimal  
value is 1 if it is high. Each following bit doubles the decimal weight value of the preceding bit. 
This means, the decimal weight value of a bit is 2 to the powers of N, where N is the bit number. 
Mathematical convention sets out binary numbers with the lowest significant bit (the bit with the 
least value) on the right and with the highest significant bit (the bit with the greatest value) on 
the left (in analogy to the arabic decimal number system, which is also written from right to left). 
The total decimal value of all 16 bits results from adding up the single values. 

Bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 

Decimal 
value 

215 214 213 212 211 210 29 28 27 26 25 24 23 22 21 20 

32768 16384 8192 4096 2048 1024 512 256 128 64 32 16 8 4 2 1 

For example, if you had a 2-bit encoded number, the first bit would have a decimal weight value 
of 2, and the second bit of 1. This gives the possible decimal numbers shown in the following 
table. 

Binary number Decimal number 

00 0 (0+0) 

01 1 (0+1) 

10 2 (2+0) 

11 3 (2+1) 

Accordingly, for 16 bits, there are 65,536 possible values, that is, 65,536 different states that can 
be defined. (Number 65,535 results if all 16 bits are High, 0 results if all bits are Low). For example, 
if the digital input bit 0 is set to high, the binary 16-bit value of the Digital Data stream in 
MC_Rack will be 0000000000000001, or 1 as a decimal number. If channel 2 is set to high,  
the value is (binary) 0000000000000010, or (decimal) 2, and so on. Any combination of logical 
states of input bits is represented by the 16-bit value. 

Thus, you can use the digital data stream to retrieve and store encoded information from external 
devices for your experiment. This information can be displayed with the Digital Display either  
as a bit trace or as a decimal number. It can also be used to trigger events (see Trigger Detector). 
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4.4 Recorder 

4.4.1 Recording Data 

In MC_Rack, the rack you use to record and analyze data online and offline, and the data files  
are principally independent from each other. You can reuse a rack for several experiments and 
generate separate data files. You can then load the generated data file with another rack later 
for further offline analysis. The Recorder is used to record data acquired by a data acquisition 
device or data generated by an offline analysis to your hard disk. Every empty rack contains 
already a Recorder; you cannot add or remove a Recorder to or from your rack. 

Data is saved as binary data, which is a very compact data type. A further compression (by 
zipping for example) can reduce the file size to half of its original size. The more redundant  
the data is, the higher is the compression that can be achieved. Arbitrary signals cannot be 
compressed further. 

All channels that you assign to the Recorder are recorded to the same file. When you have an 
empty rack, the Channels tabbed page will be empty as well, because there are no channels 
available yet. As soon as you add a Data Source or a Replayer to your rack, the Channels page 
will be updated accordingly. You can assign all available channels you like from any data stream 
to the Recorder, but it is strongly recommended to choose the channels you like to record 
carefully, because the more channels you record, the bigger the file size will be. This is especially 
important if you use a high sampling frequency. For example, if you record 60 channels at  
a sampling frequency of 25 kHz, the data rate is 3 MB/s, that is 10.8 GB/h. Regard also the 
performance limit of your computer. 

Selecting data streams and channels for recording 

The fate of each single channel is independent from other channels. You can pick exactly the 
channels you like to save from all generated data streams. For example, you can decide to save 
only one channel of raw data, but the peak-to-peak amplitude results of all, or of a specific 
selection of channels. 

Select the Recorder in the virtual rack tree view pane and then click the Channels tabbed page. 
On the white pane on the left of the Channels page, you see the data streams that are available 
with your data source settings, for example, the Analog Raw Data, Digital Data, and Electrode 
Raw Data streams for the MEA-System. It does not matter whether you have really connected  
a device to the inputs, though. If you have selected a channel layout without the digital input,  
the Digital Data stream will not be available, for example. 
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1. Click the data stream that you are interested in, that is generally the Electrode Raw Data 
stream. The available electrode channels appear in a button array on the right side. 
 

 

2. You can now either select all channels by clicking the check box next to the Electrode Raw Data 
stream name, or you can pick single channels by clicking the corresponding buttons. For more 
information, please see "Channel Selection" in the MC_Rack Features section. Only data from  
the selected channels will be saved to the hard disk. 

Synchronizing the recording 

For synchronizing MC_Rack to imaging or other recording systems, such as a patch clamp setup, 
there are basically two options. See also the chapter Continuous and Triggered Data for more 
information on the difference between continuous and triggered data files. 

 A triggered recording of sweeps with a maximum duration  of 2 s (based on a periodical 
trigger pulse). This way, the generated data file stores only data cutouts around the trigger 
event (called triggered data). This is especially useful for analyzing evoked responses, for example, 
LTP experiments. For example, you can use the Sync Out pulse of a Stimulus Generator for 
triggering the sweeps. It is possible to record sweeps that are longer than 2 s, but please note  
that you will not be able to review or analyze the generated data file with MC_Rack, as MC_Rack 
supports only sweeps with a maximum duration of 2 s. You can still export the data from the file 
with MC_DataTool, though. See also "Recording triggered data". 

Triggering the start and stop of the recording (based on a single trigger pulse): With the 
Recorder option Create New File On Trigger, a new file is created when a trigger event occurs. 
To start the recording, you still need to start MC_Rack with the Start button before the trigger 
event occurs. That means, the first data file will be unrelated to the trigger event, but you can 
delete this file if you do not need it. The second and all following files will be synchronized to the 
trigger. With this option, you can generate both continuous and triggered data files. You will 
need two different triggers (for example, one TTL pulse applied to digital input bit 0 and the 
other TTL pulse applied to the digital input bit 1) for triggering both the recording of sweeps 
with one trigger, and trigger the start of the recording (that is, the generation of the data file) 
with the other trigger. With the option Stop on Trigger, you can end the recording again  
(based on a second trigger). 
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Recording triggered data 

When you record data that is triggered by an event, for example the response to a stimulation, 
please make sure that the Recorder is operated on this trigger, too (not continuously, to save disk 
space. Triggered data needs much less disk space than continuous data. Add a Trigger Detector 
to your rack and start the Recorder on the trigger event. 

 

The window extent of the Recorder is the minimum dead time for the trigger, that is,  
no following trigger event will be accepted during the sweep. Please read chapter  
"Triggering MC_Rack on a stimulus" for more information about "Window Extent" settings. 

Note: The Recorder does not allow overlapping sweeps, that is, trigger events that would lead 
to overlapping sweeps will be ignored. In other words, the Analyzer will only accept following 
trigger events after time point T2 minus T1. 

Linking the background picture to the recorded data file 

If you load a background picture into MC_Rack before starting the recording, the file name and 
path of the image file are automatically linked to the data file. That means, if you later load the 
data file, you will not have to load the picture again. If you save a Replayer rack with the loaded 
data file, the picture will be recalled automatically next time this rack is opened. 

Please note that all file paths are absolute in MC_Rack, that is, do not move the picture file to 
another folder or directory in order to preserve the link. 

If you load a picture file into a Replayer rack after recording the file without loading a picture 
first, the picture will not be linked to the data file.  

4.4.2 Generating Data Files 
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It is important to know that MC_Rack never modifies or overwrites any existing data file. That 
means, in an offline analysis (using the Replayer), the extracted parameter streams are stored in 
a new data file. Therefore, you need to specify a file name and path in the Recorder for both 
online and offline analysis. 

Hint: If you want to store raw data and extracted parameters in the same data file, you can select 
the already existing raw data traces in a replayed file for rerecording them together with the 
extracted parameter streams. 

File name and path 

You can specify the file name and path of a MC_Rack data file with the extension "*.mcd".  
A file is never overwritten. If a file with the specified file name already exist, a new file with  
an extended file name is created. For example, if a file named example.mcd exists, files 
example0001.mcd, example0002.mcd, and so on, are generated automatically.  

File size limit 

 The file size is not limited by default, it may be as big as the maximum capacity of the NTFS files  
of the windows system is. 

 You can limit the file size based on space used on the hard disk in MB or on time. If the option 
Auto Stop is not selected, new files are created if the file size limit is reached. 

Select Auto Stop if you like to stop the recording after a certain period of time or when the 
specified file size has been reached. Only one file is created then. 

 In any case, make sure you have enough disk space left for recording the data to avoid data loss. 

Start and stop the recording on a trigger 

Apart from the option of generating a triggered data file, that is, one or multiple data files 
containing sweeps based on a trigger event (which is generally useful for recording evoked 
responses), you can also start and stop the recording of continuous or triggered data files  
based on a trigger, for example, if you want to synchronize MC_Rack to an imaging or another 
recording system. 

 The option Create New File On Trigger can be used to generate a new file on a trigger event.  
If the option Create New File On Trigger is selected, a new file is generated when the file size 
limit is met or when a trigger event occurs (whichever comes first). To start the recording, you  
still need to manually start MC_Rack with the Start button or menu command before the trigger 
pulse is applied. That means, you will generate a file before applying the first trigger pulse, but 
you can delete this file if you do not need it. The second file will then be synchronized by the 
trigger. 

The option Stop on Trigger stops the data acquisition and recording as if the Stop button was 
pressed. 

Note: Do not use the same trigger for recording and generating new files. Each sweep would then 
be saved in a new file, which does not make much sense and may lead to performance problems. 
Do not use the same trigger for recording or generating new files and for stopping the recording. 
A dead time of at least 500 ms is recommended for the trigger. If the dead time is lower and 
trigger events follow each other too fast, it may be possible that the software is not able to save 
the files fast enough. The data streams are internally handled in units of 100 ms. If two or more 
trigger events occur during one internal data unit, only the first is used for generating a new file, 
the following are ignored. 
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4.5 Replayer 

4.5.1 Loading a Data File 

Data files can be stored separate from the rack files. Use the Replayer to load a data file into 
your current rack. You can browse your folders and select an appropriate data file or select  
a file from the Recent Files list. 

For replaying a data file, you need a virtual rack with a Replayer as the data source instead  
of the data acquisition device. 

Setting up a rack for offline analysis 

1. Create a new rack file by clicking New on the File menu. 

2. Click  on the toolbar, or click Add Replayer on the Edit menu to add a Replayer to the 
virtual rack. 

3. Load a data file into the Replayer. 

4. Set up other virtual instruments like displays or analyzers for the offline analysis. 

5. You can save the rack configuration for analyzing other data files with identical data streams  
and channels. 

6. Click  on the toolbar or click Start on the Measurement menu to start the Replayer  
and the other instruments in the rack. 

See also Replaying Data for more information on the Replayer. 

Loading a Data File 

Note: You can only load a data file that has the exactly the same data streams and channels  
as the data file that the rack was based on. For example, if you load a data file with exactly 60 
Electrode Raw Data streams in the MEA layout and the Trigger 1 data stream into the Replayer, 
and then set up the rack for offline analysis, you can then later load only data files into this rack 
that also have (only) exactly 60 Electrode Raw Data streams in the MEA layout and the Trigger 1 
data stream. If only one channel is different or missing, you will have to set up a separate rack  
file. Also, continuously recorded data will not be compatible with data recorded on a trigger,  
and vice versa. 

1. In the tree view pane of the virtual rack, select the Replayer, and click the Replay File tab. 

2. Click Browse to browse your folders and select a data file, or select a file from the recently used 
file list and click Open. 
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4.5.2 File Specifications 

Some information about the experiment is saved together with the data. This information is 
displayed on the File Info page. It is very important to adjust other tools in the rack according  
to this information, especially if you have triggered data. See also "Triggered Data" for more 
information on this subject. 

The following additional information is stored. 

 Start and stop time (and date) of the recording 

 Number of data streams 

 Number of sweeps 

 Pre-trigger event and window extent 

 Sampling rate 

 MC_Rack version that has been used to record the data file 

The Buffer Info page shows all channels of the present data streams. 

4.5.3 Replaying Data 

The Replayer acts as a data source in MC_Rack, similar to the MC_Card or other data acquisition 
devices: Instead of recording data from the data acquisition board, it "generates" a data stream 
output by replaying a previously recorded data file. The data stream output of the Replayer can 
be assigned to the tools in your rack for reviewing data and / or offline analysis. The Replayer 
works similar to a tape deck or media player. You start to replay the loaded data file by clicking 
the Start button on the toolbar. 

You can define the speed as well as pause and continue the replay. You can also define the start 
time, when the replay will begin. This is especially useful for long recordings that stretch across 
several hours. In addition to the automatic mode, you can also move through the file in single 
steps. 

 

 

 

 

 



MC_Rack Features 

103 

Hint: If you want to graph (already extracted) parameters, such as the spike rate, without  
a further offline analysis, replay only the parameter streams in the Parameter displays,  
with no further Data Display or other instrument. The replay speed will be much higher,  
and you will get the graphs much faster. Each virtual instrument in the rack will decrease  
the maximum Replayer speed. 

 

Browsing the data file and adjusting the speed 

 Click  on the toolbar or click Start on the Measurement menu to start the Replayer. 

 You can adjust the speed of the Replayer by moving the Replay Speed slider. If you move  
the slider to the outmost left (fast), the data file will be replayed as fast as possible (100 %  
CPU usage). The actual time point relative to the start of the recording, and the actual speed 
relative to the original signal input rate is displayed under Automatic Mode. For example, 
 in the preceding screen shot, the current time point of the replayed data is 5.8 s after starting  
the recording, and the speed is 10 percent higher (1.1 x) than the original recording speed.  
The speed will change according to the CPU usage that the Replayer needs for the data,  
and according to background tasks. The faster the CPU, the faster will be the maximum speed. 

Browsing the data file in single steps 

This feature is useful if you look for a specific situation and want to go through your data 
thoroughly. 

 Enter the # Steps, that is, the step size and click Step to replay the data stepwise. Make sure to 
set the step size equal to the refresh rate (continuous data) or to the window extent (triggered 
data) settings of your displays. Otherwise, you will not see a change each time you click Step,  
but only every second or third step, for example. 

 You can click Reset to restart from the Start Time. 

Changing the start time 

If you did not change the start time, the Replayer will start to replay the data file from the 
beginning. If you are interested only in data that was recorded later, you can change the start 
time to begin the replaying of data at the specified start time. 

 Enter the desired start time in seconds into the Start Time box. 

 You can also use the slider to define the start time. 
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4.6 Displaying Data 

4.6.1 Display Types 

You can flexibly define the electrode grid for all displays. You can define not only the channels 
to be displayed, but also the position of the channels in the display. For example, you can arrange 
the electrode channels in the typical MEA layout, but you can also customize the layout freely 
according to your experimental setup. 

All data streams that you have assigned to a display are shown on this display. There are different 
display types for different data stream types. 

 The Data Display can show Analog Raw Data, Electrode Raw Data, Trigger, and Spikes. 

 The Longterm Data Display can show Analog Raw Data and Electrode Raw Data,  

 Only extracted Parameter streams can be assigned to the Parameter Display. 

 The Digital Display displays Digital Data streams, that is, the TTL input signals on the digital  
16-bit channel. 

 There are also special displays for some virtual instruments: The Spike Sorter display, the 
Analyzer display (only in triggered mode), the Averager display. For these displays, the same 
general features are available as for the Data Display: The display settings, peak detection, 
background picture, and ASCII export. 

Also, for each display, you can choose between different plot types, depending on the data 
stream type. The plot type defines how the data is shown on the display. 

 When displaying Raw Data, only the Trace plot is available. 

 Spikes can be shown in a Trace, Overlay, or Raster plot. 

 Parameters can be displayed as a Trace, False Color or False Color vs. Time plot,  
or as a Number. 

 The logical state of the 16 bits of the Digital Data stream can be displayed as a trace.  
The decimal value of the 16 bit encoded binary number can be displayed as a number. 

The ranges of the x- and y-axis can be set only for the overall display. That means, if you have 
two data streams or channels that are based on a different scale (for example, not amplified 
Analog Raw Data and amplified Electrode Raw Data), it is recommended to use two separate 
displays and set the scaling accordingly. 

 

4.6.2 Setting up a Display Layout 

Similar to other virtual instruments, displays do not recognize active channels by themselves, but 
you have to set up a channel map for each display separately. A channel map defines the layout in 
which the channels of a display appear, that is, information about the channel numbers and their 
positions. There are several standard maps provided in the MC_Rack program folder, for example 
the standard rectangular 8x8 MEA grid. But you can set up and save your own custom maps as 
well. The advantage of this system is that you control which channels are displayed, thus saving 
computer performance. If you get a performance limit message, try to remove displays or to 
display fewer channels in the displays. Displays have a quite big impact on computer performance. 
Also, you can arrange the electrode channels in the display exactly as you like, thus trying to make 
the display look as similar as possible to the real electrode layout. 
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The channels of MEA A are tagged with an "A". Likewise, the channels of MEA B are tagged  
with a "B". If you have a MEA60-System (or an USB-ME64-System) in use, only channels of MEA A 
are available. If you have a MEA120-System (or an USB-ME128-System) in use, you can choose 
between MEA A and B. Channel maps for MEA A and B have been preconfigured, but of course 
you can set up any custom or "mixed" channel layouts as well. The USB-ME256-System provides  
up to four MEAs, the channels are tagged with A, B, C and D, and you can choose between  
MEA A to D. 

Once you have loaded a channel map, this channel map is considered the default channel map  
for all following displays that you add later to your rack. 

Note: You can set up any channel layout that meets your requirements and save it for later use. 
You can pick preconfigured channel maps for all MEAs available from Multi Channel Systems from 
the MCS Channel Maps drop down list. You can download channel maps for all MEAs available 
from Ayanda Biosystems from the Ayanda web site (http://www.ayanda-
biosys.com/download.html). 

Loading a preconfigured channel map 

1. Choose the display that you like to modify and click the Data tab to select the appropriate data 
stream. The display is loaded in the default layout (that is, the last loaded channel map). 

2. Click the Layout tab to modify the layout of the display. 

3. Select MCS Channel Maps to select a default channel map available for various MEA types  
or linear layouts or select User Channel Maps to select one of your customized channel maps. 

4. Select any channel map from the Channel Map drop-down list (available in the MCS default  
or in the user folder). 
- OR -  
Click Open and browse your folders to look for a specific channel map. Select a channel map 
(*.cmp file) of your choice and click Open. The display is updated accordingly. 

Setting up a custom channel map 

1. Choose the display that you like to modify and click the Data tab. 
The display is loaded in the default layout (that is, the last loaded channel map). 

2. Click the Layout tab to modify the layout. 
In the Rows and Columns boxes, you can now modify the layout. 

3. Type or select the total number of Rows and the total number of Columns. 
In the preview on the right, the layout is updated accordingly. 

4. Assign the appropriate channel number to each slot. Click a slot in the preview to make it active. 
The active slot is highlighted by a tiny dotted line. Click the desired channel on the Channel list  
or type the appropriate channel number. The display is updated accordingly. 

5. If you like to keep this layout for future use, click Save. The Save Channel Map File dialog box 
opens. 

6. Browse your folders and enter a file name. 

7. Confirm by clicking Save. The channel map is saved as a *.cmp file. You can now load this map 
into other displays. 
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4.6.3 Display Settings 

 

You can select the range and refresh rate of the display from the drop-down lists. In addition,  
you can zoom the display by moving the sliders. 

MC_Rack stores the last two seconds of recorded data streams in a temporary virtual memory. 
Therefore, it is not possible to set the time scale wider than 2 s. 

If you run the display in triggered mode, the sweeps start with the trigger event = time point 0. 
You can set the time scale to negative values to display pre-trigger times (if you display 
continuously recorded data or if the triggered data was recorded with a negative = pretrigger 
start time). 

Zooming a channel 

All available channels are shown in the display to provide an overall view of the ongoing activity. 

 Simply double-click a channel to have a closer look at it. The magnifying-glass icon in the top left 
corner indicates that you are in zoom mode. The channel number is displayed in the top left 
corner next to the axes intersection point. 

 Double-click the zoomed channel again to restore the overall view. 

Changing the ranges and refresh rate 

Select the appropriate range from a set of fixed values in the X-Axis or Y-Axis drop-down lists.  
If you change the x-axis range, you will also change the refresh rate and the sweep size.  
You cannot change the x-axis range for replaying data that was recorded on a trigger,  
as the recorded cutouts have a fixed length. 

 You can also move through the set of fixed values in the Y-Axis list by clicking the up and down 
arrow buttons. 

Zooming a part of the sweep 

Note that if you zoom continuous data with the sliders, you will not see the complete recorded 
data traces anymore, but only the zoomed section. (In contrast, if you display continuously 
recorded data and change the x-axis range in the drop-down list, you will still see the complete 
data traces, but in smaller or larger sweeps. If you display triggered data or display continuous 
data in a triggered display, the displayed sweeps are cut out around the trigger event.) 
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 Zoom into a part of the displayed sweep by clicking and dragging the sliders with the mouse. 

 Or select a slider with the mouse (a selected slider is highlighted in white) and move it by pressing 
the LEFT or RIGHT arrow key. For larger steps, press the PAGE UP / DOWN key. 

Reverse Display 

 Changes the display background color from white to black. 

Automatic Zoom 

Please click on the data display with the left mouse button. The following menu appears. 

 

In raw data displays you can use an automatic zoom: Enable the "display tooltip" option. Now you 
can draw a rectangle by pressing the right mouse button. All data in this rectangle are zoomed. 
The reset the zoom, please click "reset zoom". 

Additionally you have the options to display labels or a crosshair for measuring, or to set cursors 
and to remove them. 

When pointing with the mouse on a data display, the accurate position will be displayed. 

 

 

 

4.6.4 Peak Detection 

In the Data Display and the Spike Sorter display, you can select the option Peak Detection. 
This option does only effect the display, not the data that is stored to the hard disk. 

Peak Detection is a very important option. The massive amount of data points retrieved in  
the range of the time axis, 200 ms in this case, that means 500 data points at a sampling rate  
of 25 kHz, are reduced to a few pixels on the display, let us say to 100 pixels. That means,  
five data points are reduced to one. 

Without Peak Detection, only every fifth data point is actually plotted. The other four are 
dropped. As you can imagine, it is likely that fast signals are overlooked or that you see peaks  
that are not actual present, but display artefacts. 
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With Peak Detection, the highest (max) and the lowest (min) value of the five data points are 
taken and connected by straight vertical line. Peaks are preserved in this way. On the other hand, 
this feature needs a higher computer performance for the internal data handling. You may want 
to deselect this option when you have a limited computer performance. The following error 
message appears when the system is at its limits. 

 

Without Peak Detection 

 

 
With Peak Detection 
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4.6.5 Customizing a Display 

Showing and hiding the axes bar * 

You can hide the axes bar on top of the display to save space and obtain a larger view  
of your data. 

Right-click anywhere in the window and deselect Display Header. 

Showing and hiding the data stream names * 

You can show the data stream type of each channel. 

Right-click anywhere in the window and select Display Labels. 

Using the crosshairs * 

Right-click anywhere in the window and select Display Crosshairs to show crosshairs.  
You can use the crosshairs to manually estimate peak heights and time points. 

Customizing the display colors 

Right-click either an axis or a trace to assign a new color to it. You can either choose one of the 
basic colors or define a custom color. You can assign a different color to each data stream. This is 
especially useful if you use a background picture or if you like to assign specific colors to specific 
kind of data. 

(* = Available only for Data Display) 

4.6.6 Displaying a Background Picture 

You can load a photo of your preparation as a background picture to see which signals belong  
to which region of the preparation. This feature is only intended for MEAs with the standard  
8x8 electrode grid. The file path is saved together with the data file when you record data after 
loading the picture. You can unload a picture again with the command Unload Image. 

If you are using a MEA two-fold-System, you can load two images, one for each MEA (A and B). 

If you are using a MEA four-fold-System, for example a MEA2100- or an USB-ME256-System,  
you can load four images, one for each MEA (A, B, C and D). 

Note: File paths are absolute, that means MC_Rack cannot find picture files if they have been 
moved to another folder or directory. An error message will inform you in this case. 

On the File menu, click Load Image (MEA A) for MEA A or Load Image (MEA B) for MEA B, 
and if available Load Image (MEA C) for MEA C, and Load Image (MEA D) for MEA D. 

1. Select an appropriate image file and click Open. 

2. Add a Data Display (or an Analyzer with display) to your rack. Select a MEA layout  
(A, B, C or D). 

3. On the display, click Show Image. You can now see the picture. 

4. Now, you map the channels to the electrodes in the picture. Hold down the SHIFT key,  
point to any electrode, for example, the top left, and double-click. A text box opens. 

5. Type in the number of the electrode according to the MEA layout, for example 21. 

6. Hold down the CTRL key, point to any electrode in another row, for example the bottom right, 
and double-click. 
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7. Type in the number of the electrode according to the MEA layout, for example 78. 
The data traces appear on top of the picture. 

 

Hint: If you have made a mistake, simply repeat the assignment from step 5 to 7. 

4.6.7 ASCII Export of Waveforms 

Click   in the display header (not in main menu tool bar) to save the displayed data as a tab-
delimited ASCII file (text without formatting). The format is tab-delimited ASCII, so that the file 
can easily be loaded into other applications. ASCII export is possible for all plot types. 

You can open these files with an editor or with your custom analyzing software, for example  
Excel or Origin. 

Exporting data is only possible when you have stopped the data acquisition or the Replayer.  
The Save button will then reappear on the toolbar. 

You export all displayed data. A file is created for each channel separately. If you have zoomed 
to a single channel, only the visible channel is exported. The header of the ASCII table shows the 
channel numbers, the data type and the measuring units. The file name is automatically extended 
by the data stream name and the channel number. For example, if you export displayed data of 
channel 12 of the Filtered Data 1 stream and enter MyData as a file name, the file name would 
be MyData_filt0001_12. 

Data stream identifiers: 

elec Electrode Raw Data 

angl Analog Raw Data 

digi Digital Data 

filt Filtered Data 

spks Spikes 

trig Triggered Data 

Please see the description of the plot types for more details. 
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4.7 Data Display (for Monitoring Raw Data) 

4.7.1 Plot Types 

Click  to add a Data Display to your rack. You can choose between different plot types, 
depending on the data stream type. When displaying Raw Data, only the Trace plot is available. 

 Trace plot: The voltage traces are plotted. 

 Overlay: Spike cutouts are overlaid. 

 Raster plot: The detection events of spikes are plotted. Use this plot type to make spike patterns 
visible, for example in relation to a stimulus. 

4.7.2 Trace Plot 

 The voltage traces are plotted. This plot type is generally used to view Electrode Raw Data, 
Analog Raw Data, or mixed data streams. 

ASCII Export 

The created file has the following structure. 

 The first column is the x-axis (time). 

 The following column is the y-axis (voltage). 

 The first row contains the column headers. 

 The second row are the measuring units. 

 The following rows contain the data. 

 The following screen shot shows such a file opened with a standard spreadsheet. 

 

4.7.3 Overlay Plot 

 For plotting spikes. Spike cutouts are plotted over each other, aligned to the detection event.  
You can set the number of spike cutouts to be overlaid (up to 1000). The overlay plot is useful to 
compare waveforms. It can be used to estimate the variability of signals or to detect multi-unit 
activity. 
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ASCII Export 

The created file has the following structure. 

 The first column is the x-axis (time). 

 Each following column represents a sweep, in the order of plotting, that is the first column 
contains the first sweep, and so on. 

 The first row specifies the Spike Sorter tags. Untagged sweeps are specified by Unit = 0.  
Sweeps can be tagged by units 1 to 3. 

 The second row are the measuring units. 

 The following rows contain the data. 

 The following screen shot shows such a file opened with a standard spreadsheet. 

 

4.7.4 Raster Plot 

 For plotting time points of spike detection events. Detection events are plotted as vertical lines 
arranged in rows, that means, only information about the time course, but no information about 
the amplitude is provided. The length of a single row is defined by the range of the x-axis.  
The latest sweep is plotted on top of the plot; and all previous sweeps are shifted downward.  
You can use the Raster Plot to visualize spike patterns, especially for triggered data. 

 You can set the number of plotted sweeps, up to 1000. 

In the following screen shot, you see a regular spike pattern (continuous data). 
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Using a raster plot 

The Raster plot is only available for spike data streams. Make sure you have a Spike Sorter  
in the rack, or replay a data file containing spike data streams. 

 

1. Add a Data Display to your virtual rack configuration (in serial with the Spike Sorter). 

2. Click on the Display in the virtual rack tree pane to select it. 

3. Click the Data tabbed page of the Display. Select only the Spikes data stream. 

4. Select the Raster Plot option. 

ASCII Export 

The created file has the following structure. 

 The first column is the x-axis (time). 

 The second column is the sweep number. The first sweep (on the bottom of the plot) is sweep 
number 0, all other sweeps are counted up. 

 The third column specifies the Spike Sorter tags. Untagged sweeps are specified by Unit = 0. 
Sweeps can be tagged by units 1 to 3. 

 The first row contains the column headers. 

 The second row are the measuring units. 

 The following screen shot shows such a file opened with a standard spreadsheet. 
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4.8 Digital Display (for Monitoring TTL Inputs) 

4.8.1 Displaying Digital Data 

The Digital Display is used to view either the logical state of the 16 digital channels, or to display 
the 16-bit encoded decimal number of the binary data (see "Numeric Display"). It is only available 
if the data source you are currently using produces a Digital Data stream. The Digital Display has 
features similar to the Parameter Display type. For more information on the toolbar, or how to 
zoom channels, please refer to the topic "Parameter/Digital Display Tools". 

 On the Edit menu, click Add Digital Display OR click the according button  on the toolbar - 
OR - press CTRL+G on your keyboard to add a Digital Display to your rack. 

Selecting bits 

You can choose the bits you like to display. 

1. Select the Digital Display in your rack. 

2. Click the Settings tab. 

3. Select all bits you like to view in the Digital Display. 
 

 
 
The display now shows the logical state (0 or 1) of the selected bits. 
 

 

4.8.2 Numeric Display 

Instead of plotting the logical state of the binary data (bits), you can choose to display the  
16-bit encoded decimal value. The numeric display is used for special applications, for example,  
to display slow digitized data from an analog data source. It is not recommended for pulses that 
are faster than the refresh rate of the display. Instead, use the Binary view to see the traces of 
fast triggers. 
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See "About Digital Data and Binary Code" for MC_Rack Features. 

1. On your rack, click the Digital Display. 

2. Click the Settings tab, and then click Decimal Number. The Digital Display is empty now.  
If you click Start, the actual decimal value based on the 16-bit binary value of the digital data 
stream is displayed. 

 

4.9 Trigger Detector 

4.9.1 Using the Manual Trigger 

The  function "Manual Trigger" allows the user to generate a trigger event manually from 
within MC_Rack. This can be used to create timestamps in a data file. Manual triggers can only  
be generated during online data acquisition, and only in continuous mode. Manual triggers are 
intended to mark external events like changing perfusion solution, turning on or off a pump, 
changing temperature or similar events.  

These triggers can NOT be used to mark specific signals, as the manual trigger will be generated 
in real time when the button is pressed, but the signal displayed in MC_Rack is approximately  
one second behind real time.   

To use the manual trigger, insert a “Trigger Detector” in your rack and select "Manual Trigger" 
from the bottom of the list in the “Channel” drop down menu. To generate a manual trigger, 
press the “Trigger” button below the Channel drop down menu or the manual trigger icon in the 
main menu toolbar. Each timestamp generated with the manual trigger will be counted up, and 
stored in the “*.mcd” file. You just have to note which event is correlated with manual trigger 1, 
2, 3 etc.. When replaying the marked data file in replayer mode, the manual trigger events will 
always be shown on one channel of the display only: Using the MCS default two dimensional 
channel map, the marker will appear on channel 47, in one dimensional channel layout on 
channel 1. 

Click trigger detector icon  or select in main menu Edit "Add Trigger". 
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Click Trigger tab. Select “Manual Trigger” from the Channel drop down menu. 

 

When MC_Rack is displaying or recording data, the button “Trigger” is active. The number of user 
defined trigger events will be counted up in the small display “Trigger Count”. Alternatively to 
the Trigger button in the Trigger dialog, you can also use the manual trigger icon in the main 
menu toolbar   to generate a manual trigger timestamp. Immediately after clicking the button 
“Trigger” or after clicking the icon, a symbol for the timestamp and its number    will appear in 
one channel of the display. Using the MCS default two dimensional channel map, the marker will 
appear on channel 47, using the one dimensional MCS default channel map, the marker appears 
on channel 1. 

For displaying and recording the trigger events, please select the continuous mode in “Window” 
tab of recorder. 

 

To record the time stamps created with the manual trigger, make sure to select the Trigger  
data stream in the “Channels” tab of recorder. 
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To display data and manual trigger, please select the desired data streams in the “Data” tab  
of the display. The display has to be placed in dependency of the Trigger Detector 1 in the  
virtual tree.  

 

When replaying a Rack file with manual trigger events, the timestamp and its number will appear 
in one channel of the display. Using the MCS default two dimensional channel map, the marker 
will appear on channel 47, using the one dimensional MCS default channel map, the marker 
appears on channel 1. 

 

Important: The manual trigger is enabled, when MC_Rack data acquisition is running only! 

Important: The manual trigger is enabled in continuous mode of recording! 

4.9.2 Triggering MC_Rack 

The Trigger Detector detects trigger events on a single input channel and generates a Trigger 
data stream that can be used to trigger other virtual instruments, for example, to control the 
Recorder or an Analyzer. Several Trigger streams can be generated by separate Trigger 
Detectors. You can use Electrode or Analog Raw Data, Filtered data, Parameter, or Digital Data 
streams as input streams for trigger detection. 

 You can define a bit pattern for using digital signals (TTL pulses) as a trigger. 

 You can define a threshold for triggering on biological signals. 

 You can define a threshold for triggering on extracted parameters. 

 You can also program an automatic time-based trigger. 

4.9.3 Triggering on TTL Pulses 

The digital input channel is generally used for synchronizing the (USB) MEA- or ME-System to  
a stimulus generator, or to another data acquisition system, for example, an imaging or a patch 
clamp system. In MEA2100-Systems the STG is integrated. Only TTL signals are accepted as input 
signals on the digital input bits. You can apply TTL pulses to single digital input bits, or you can 
encode a bit pattern by combining multiple digital input bits. 

Important: The applied TTL signal should not be too short, depending on the sampling rate,  
for example, it should be at least 40 μs at a sampling rate of 50 kHz. Otherwise, it can happen  
that the MEA2100-System, the MC_Card or the USB based data acquisition miss signals. 
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You can select the digital input channels that will be used by the Trigger Detector. All other 
channels are masked, that is, are not considered at all. Click a Mask button to select an input 
channel. For example, in the preceding screen shot, TTL signals are accepted only on the digital 
channel 0. All other channels are masked. 

This is very important if you do not have all 16 channels in use that is, connected. Open (not 
connected) channels do not automatically have a logical state of 0, even though there is no input 
signal. They are in an undefined state, that is, it is not known whether they have the logical state 
0 or 1, and they can also switch to the other state without an input signal (depending on electrical 
noise, air moisture, and so on). Therefore, it is recommended that you select only those channels 
that you have actually connected. Unused input bits should be masked. 

You have to preset the state of each selected bit by using the Bit buttons. Each channel can  
have either the state High (1) or Low (0). If a Bit button is pressed in, the input signal on the 
according digital channel has to be high (5 Volts). Otherwise, if a bit button is not pressed, the 
signal has to be low (0 Volts). The bits of all channels are combined by the logical operator AND, 
that is, all states have to be true to trigger an event. For example, if bit 0 is set to Low and bit 1  
to High, a trigger event is detected when bit 0 is low and bit 1 is high at the same time. 

A simple way of triggering would be to apply a signal to one or more channels (for example, from 
the Sync Out of a stimulus generator (STG). But it is also possible to encode more information 
from external devices in binary code. For those applications, you can set the Type to Less than 
(<), Equal to (=), or Greater than (>). This specifies whether the decimal value has to be less 
than, equal to, or greater than the specified bit combination to trigger an event. 

Remember that TTL input signals are only accepted on those input bits that are selected with the 
Mask buttons. The state of the other (masked) bits can be arbitrary. For example, if you select 
only bit 0 and set it to High, all situations where bit 0 is High will trigger an event. In the example, 
all odd numbered decimal values will trigger an event, because, if a decimal number is odd, bit 0 
always has the state High (=1). See "About Digital Data and Binary Code" for more information 
on the subject. 

Multiple trigger inputs 

You can set up several trigger detectors that respond to separate trigger inputs. For example,  
for a paired pulse experiment, you can trigger one Analyzer on bit 0 (for example, connected  
to Sync Out 1 of an STG 2000 series), and the other on bit 1 (connected to Sync Out 2). 
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4.9.4 Triggering on Biological Signals 

You can define a threshold for triggering on biological (analog) signals from Analog Raw Data, 
Electrode Raw Data, or Filtered data streams. 

 

 Select the appropriate data stream and channel from the Channels list. 

 If you select the option Negative Slope, the fall of the curve is regarded. If you select  
Positive Slope, the rise is considered. 

 

The following picture illustrates how the trigger detection works. 

 

If you use the Trigger data stream that is generated by the Trigger Detector to control other 
virtual instruments, the trigger event is considered at the time point = 0. You can then define how 
long before the trigger event (pre-trigger time) the instrument (an Analyzer, for example) will 
start and how long after the trigger event (post-trigger time) the instrument shall stop. The total 
time gives you the window extent. You define these settings on the Window page of an 
instrument. See also "Triggered Data". 
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4.9.5 Triggering on Extracted Parameters 

Similar to the triggering on raw data streams, you can also define a threshold for an extracted 
parameter stream to generate trigger events. For example, you can trigger the recording only  
if the spike rate reaches a threshold level. 

 

 Select the appropriate parameter data stream and channel from the Channels list. 

 If you select the option Negative Slope, the fall of the parameter curve is regarded.  
If you select Positive Slope, the rise is considered. 

 If you use a Parameter stream with multiple extracted parameters you have to specify  
the parameter type as well. 

 

4.9.6 Time Based Trigger 

You also can define a time-based trigger. The trigger event can either occur periodically  
or at specified points of time. For example, you can use this feature if you want to apply  
a drug at specific time intervals and want to record data only at the drug application times. 
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Single or periodic trigger event 

 

If you use a periodic trigger, you define the start time (Wait), when the trigger occurs the first 
time, and the time interval, when the trigger will reoccur after an event. You can choose 
whether the trigger shall occur a fix number of times, or whether it shall occur continuously 
(option Cont.). 

Predefined list of trigger events 

 

1. If you want to use predefined trigger times, select the option List. 

2. Click Edit List to set up a list of trigger events. The Trigger List dialog box appears. 
 

 

3. Select the time unit. 

4. Click the New Trigger Value button  to enter a value. 

5. Select an entry in the list and click the Delete Value button  to remove the selected trigger 
event from the list, if necessary.  

6. Click OK to complete the list and close the dialog box. 
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4.10 Automatic Feedback 

4.10.1 Digital Output 

To use this feature, you need a MEA2100-System, an USB based data acquisition device and  
when using the MC_Card a Dig Out connector for your computer and the MC_Card driver  
version 2.5 or higher. 

You can use the Digital Output instrument to apply a feedback triggered by a signal or  
a parameter stream. Set up a Trigger Detector first. You can then use the generated trigger  
to apply a digital pulse via the digital output channels of the MEA2100-System or an USB based 
data acquisition device or the MC_Card. You can use this output signal to trigger an external 
device, for example, a stimulus generator that applies a feedback stimulus to the test model. 

The pulse is a 20 ms TTL signal. See also "About Digital Data and Binary Code". The timing is not 
real-time based, that means the feedback event may vary. The typical internal delay between the 
trigger event and the TTL pulse is about 300 ms. You can add a custom delay to this internal error. 

The digital output signal cannot be processed further by other virtual instruments or displayed 
directly in MC_Rack. But you can connect the digital output of the data acquisition to the digital 
input of the data acquisition. You can then add a Digital Display to see the digital input signals, 
which should be identical to the output signals. 

 

1. Add a Trigger Detector to your virtual rack, select a data stream, and set a trigger detection 
level. 

2. On the Edit menu, click Add Digital Output to add a Digital Output  to your rack. 

3. Click the Digital Output tab and select the Trigger data stream, if you have more than one 
Trigger Detector in use. 

4. Select any bits of your choice. A TTL signal (logical state 1) will be applied to all digital output 
channels that are selected. Selected bits appear pressed in. 

5. Type a number in the Delay box. The digital signal will be applied after the trigger event with  
the specified delay plus the internal time delay of about 300 ms. 

6. Start the application by clicking Start on the measurement menu. 
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4.11 Real-time Feedback 

4.11.1 Real-time Feedback 

Introduction 

The real-time feedback feature represents a significant improvement in signal detection and 
processing. Previously, the digitized signals were processed by the computers main processor, 
which involved the operating system and resulted in unpredictable and rather long delays 
between the actual event and its’ detection. With the new generation of USB based data 
acquisition systems from MCS, online filtering, signal detection and generation of feedback  
signals are realized by a Digital Signal Processor (DSP) in the data acquisition hardware.  
It is now possible to reliably generate a feedback signal within a time frame of one millisecond 
after the actual event.  

The main purpose of this feature is to allow the user to generate TTL signals in response to 
defined signal patterns detected by one or several electrodes. These TTL signals in turn can control 
a stimulus generator (STG) to deliver feedback stimulation to the biological sample. It is also 
possible to use the TTL for example, to activate an imaging system, or control a drug application 
device. 

The real-time feedback function consists of four components: Online filtering, signal 
detection, feedback logic, and generation of a digital TTL feedback signal. The filtering  
is optional; you can use a high pass, a low pass, or a band pass filter on your data. The signal 
detection works either on the raw data or on the filtered data stream. Signal detection works  
by an individual threshold that can be adjusted for each electrode. After the signal detection,  
the user can define the conditions that will trigger a TTL signal by a feedback logic. Either single 
events or event rates on one or several electrodes combined can be set as condition to trigger  
a TTL signal. 16 digital output channels are available, each of which can be activated by a 
different signal condition. Events from the same electrode can be used in more than one  
logical block. The following scheme illustrates the principle of real-time feedback processing. 

 

 

Limitations 

Real-time feedback is available only for advanced data acquisition systems like MEA2100-
Systems, USB-MEA- or USB-ME-Systems. It is not available with MC_Card data acquisition or in 
simulation mode. Furthermore, a firmware update and MC_Rack version 4.0 or higher is 
required. Due to the performance limitations of the Digital Signal Processor (DSP), online  
filtering and signal detection are limited to 64 channels at the moment. If you have more than  
64 channels, it is necessary to select a maximum number of 64 channels at a time for real-time 
processing. 

MEA2100-Systems with the exception of the MEA2100-32-System are equipped with  
an additional DSP which allows programming from extern. You can feed in individual  
adapted signals for your individual designed experiments. 
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Setting up the Hardware 

To generate real-time feedback stimulation to a biological sample, you need an advanced data 
acquisition system (MEA2100-System, USB-MEA- / ME-System), and a stimulus generator STG.  
The digital output channel of the data acquisition has 16 bits. Bit 0 is accessible directly via Lemo 
connector. In MEA2100-Systems bit 0 to bit 3 are separately available via Lemo connectors, but 
you do not need a cable connection, because of the internal 3-channel STG. If you work with more 
that one bit in USB-MEA- / ME-Systems, you need the Digital In / Out Extension (Di/o). This device 
gets connected to the Digital IN / OUT of the data acquisition and provides access to all 16 input 
and 16 output bits via standard BNC connectors.  

Each output bit of the digital channel can be connected to one or more Trigger IN connectors  
of a STG. Please see the STG manual on how to start stimulation on the Trigger IN. 

Important: It is a requirement to select the check box “Digital Input” in “Channel Layout”  
of the “Data Source Setup”. Otherwise the real-time feedback feature is not available! 

 

Important: The feedback signal from the processor module will be sent to digital outputs and 
digital inputs as well. The DIG OUT is used for the connection to the STG. The respective DIG IN 
channels can be used to monitor the generated feedback signals with a digital display in MC_Rack. 
Therefore you can not apply external digital input signals to the DIG IN bits in use. 

Setting up the Software 

Click Edit menu and add “Real-time Feedback” or click the real-time feedback icon  in the 
toolbar.  

The real-time feedback tool automatically opens a display window, which will show the raw 
data or data filtered by the digital hardware filter of the real-time feedback tool, the spike 
detection level and the TTL feedback signal. The starting point of the trigger is marked by the 
small red triangle above. The duration of the trigger is indicated. You can change the color of the 
signal traces with a right click onto the trace as usual. Spike detection thresholds of individual 
electrodes can be adjusted by moving them with the mouse in the display window. In the example 
shown below, a 5 ms TTL is generated in response to every detected spike.  
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The data trace (blue), the detection level (black), and the generated TTL pulses (red) are 
displayed in one window. It is possible to toggle the display window in the "Digital Hardware 
Filter" tab.  

 

The real-time feedback has to be the topmost tool in the hierarchical order of MC_Rack program 
below the data source, because the raw data stream is influenced by the digital hardware filter  
of the DSP. MC_Rack processes this data stream only, and so do all instruments and the recorder. 
However, it is possible to generate feedback on a filtered data stream, but still record the raw, 
unfiltered data (Please see "Digital Hardware Filter" tab.) 

MEA2100-System 

The “Feedback Logic” tab of the dialog is different for MEA2100-Systems with internal stimulator. 
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When recording with a MEA2100-System, the digital display is labeled: The first four rows display 
the “DigIn” channels for bit 0 to bit 3. The next three rows show the “Blanking” signal 1 to 3 on 
bit 4, bit 5, and bit 6. “Zero” is associated with bit 7. The following rows display the “RF” real-time 
feedback associated to bit 8 to bit 16 on channel 1 to 8. 

  

To record the digital stream, created via real-time feedback, please enable the respective check 
box in the “Channels" tab. 
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Digital Hardware Filter 

In the "Digital Hardware Filter" tab, it is possible to switch the real-time feedback feature on  
and off, and to define the characteristics of the digital hardware filter that gets applied to the 
data before it goes through the signal detection algorithm. Using a filter is not obligatory  
for real-time feedback. It needs Digital Signal Processor (DSP) resources and time for calculation.  
The digital filter shifts the signal by some samples, so the real-time feedback is delayed about 
eight times the sampling rate, for example 200 μs for 40 kHz sampling rate, compared to the time 
without filter.  

The filter is applied to all channels, whereas further processing is restricted to the channels 
selected in the “Feedback Logic” tab. 

 

Important: After selecting the filter parameters, you have to download the settings to the  
DSP with the “Download” command. The “Download” button is available only if a download  
is necessary. Pressing “Download” in any tab will send the settings from all tabs to the DSP.  
The settings will also be automatically downloaded when the “Play” button in the main window  
is activated. 

With the "Feedback” button you can switch the tool on or off. With the command button  
“Hide Display” it is possible to toggle the real-time feedback display. 

Select the data stream you want to record. It is possible to generate feedback on a filtered data 
stream, but still record the original, unfiltered data. The selected stream “Record Filtered Data” 
or “Record Raw Data” will be sent to MC_Rack, and can be used for all other instruments.  
If you select “Record Raw Data” the data is still filtered by the Digital Signal Processor (DSP)  
for performing real-time feedback, but unfiltered data is sent to MC_Rack. With this option,  
it is necessary to use a digital filter in MC_Rack to observe the data filtered in the same way  
as it is used for real-time feedback processing. 

Enable or disable the check box “High Pass Filter”. Select the high pass “Cutoff Frequency” 
from the drop down menu in a range from 10 Hz to 2 kHz. Other frequencies may be directly 
edited. 1 Hz is the smallest possible frequency, fractions of the unit are not allowed.  

Enable or disable the check box “Low Pass Filter”. Select the low pass “Cutoff Frequency” 
from the drop down menu in a range from 10 Hz to 2 kHz. Other frequencies may be directly 
edited. 1 Hz is the smallest possible frequency, fractions of the unit are not allowed. If you apply  
a high pass and a low pass filter the bandwidth of the resulting band pass filter is defined by the 
cutoff frequencies of the high- and low pass filter. Select the first, second or third order of the 
respective filter from the drop down menu. The setting of the filter order applies to all selected 
filters. 
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Note: Please use first order filters whenever possible. Higher order filters tend to be unstable  
and oscillate, especially when using very low or very high cutoff frequencies. 

Warning: Please keep an eye on the “Performance” window. The window shows the 
percentage of time available between two samples that is needed for real-time feedback 
calculations (filtering and feedback logic). It should never exceed 90 %. Real-time feedback is 
automatically switched off if more than 90 % of the resources of the Digital Signal Processor 
(DSP) are expended. In case of performance problems, decrease sampling rate, if possible. 

The “Status” window displays the status of the real-time feedback feature: “Off” immediately 
after disabling the “Real-time Feedback” button, “On” after starting the tool and after the first 
download. 

Signal Detection 

In the “Detection” tab, you can define a threshold as detection level for each channel 
separately. All events that cross the threshold are detected. Please read chapter “Spike Detection 
Methods” under “Spike Sorter” in this manual for more details. As usual, the settings have to be 
downloaded to the DSP with the “Download” command. 

 

Individual channels can be selected from the drop down menu. For each channel, a threshold  
in μV can be selected from the numeric updown box. All signals crossing the threshold will be 
detected as events. The same function can be achieved by dragging the threshold line in the  
real-time feedback display. 

Important: Changes in the detection settings also have to be downloaded to the DSP with the 
“Download” command. 

Enable the check box “neg. Slope”. If you select the option “Negative Slope”, the fall of the  
signal curve is regarded, otherwise the rise is considered. This setting applies only to the selected 
channel. In the “Apply to All” window, click “Slope” button to apply the slope setting to all 
channels. Click “Level” button to apply the detection level of the currently selected channel  
to all channels. 

To modify the threshold level of all channels, please click the buttons of the “Tune all Levels” 
numeric updown box. Tuning all channels means, that the different levels of all channels are 
modified stepwise up or down by the same factor (+1 μV or -1 μV).The current level is displayed  
in the microvolt box “μV” above.  

The “Automatic” feature is convenient to automatically assign an individual detection level to 
each channel. The standard deviation of the noise of each data trace is used to estimate its signal 
threshold.  
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A time interval of 500 ms is used to calculate the standard deviation. You can set the factor by 
which the standard deviation is multiplied to set the detection threshold numeric updown box. 
Click “Refresh” button to calculate the standard deviation from the currently recorded data,  
and to apply the result. It depends on the distribution of noise and spikes, which factor should be 
used. The higher the spike rate, the lower the factor can be set. The sign of the factor determines 
whether the spike detection level is positive or negative. A value between -3 and -5 is appropriate 
for most applications. 

The “Slope” window for detecting spikes by their waveform is not available at the moment and 
will be implemented in future versions of MC_Rack. 

Feedback Logic 

The "Feedback Logic" of the DSP monitors whether the conditions for generating a feedback 
defined by the user are met, and triggers a TTL signal in response. The logic operates with logical 
states. The logical state of an electrode, or a combination of electrodes, can be TRUE or FALSE 
regarding the condition defined by the user. If necessary, the logical states of more than one 
electrode are combined (see AND and OR function below). A TTL is generated if the logical states, 
or the combination of logical states, fulfill the user defined condition.  

The conditions that trigger a TTL signal on each of the 16 bits of the Digital Output are defined  
in the “Feedback Logic” tab. A different condition can be assigned to each bit. Some settings  
are for all outputs bits, while others can be adjusted for each bit individually. 

General Settings: Please choose the number of digital output bits you want to use from the 
numeric updown box first. For each bit, a separate control unit in the dialog will become available 
(see below). The display is immediately adapted when the number of digital bits is changed. 

 

Select a “Time Window” in milliseconds from the numeric updown box. The time window defines 
the time in which the rates of signals should be counted. For performance reasons, the window  
is limited to 1000 ms. 

Important: The time window is not a fixed time bin, but a moving window. For example if  
the window is set to 1 s, and a rate of 10 Hz is set as condition, the condition is fulfilled as soon  
as ten events within a second are detected. Therefore, it may not happen that these ten events 
fall by chance in two separate time bins and are not counted as 10 Hz. 

Important: For the purpose of this feature, a "Rate" is defined as the number of events in the 
selected time window. 
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Select the “Event Duration” in milliseconds from the numeric updown box. The event duration  
is the time after a crossing of the detection threshold that the detection condition is considered  
as fulfilled. This duration influences the length of the resulting feedback TTL, and is especially 
important when the input from several electrodes is combined with the “AND” and “OR” function 
(see below). That means, for the Feedback Logic, the logical state of a channel becomes TRUE 
from the detection point of an event till the end of the event duration.  

Please see image below: 

 

If only one channel is used as input, the duration of the resulting digital TTL pulse is as long as the 
logical state is TRUE. As usual you have to download all settings to the DSP with the “Download” 
command.  

Individual settings: The following control functions are available for each output bit of the 
digital channel: 

 

Select the channels you want to detect signals from by clicking onto the channel block.  
The layout on the channel block depends on the settings in the Data Source Setup.  
Selected channels will be highlighted in grey. Deselect a channel by clicking it again.  
Events from the same electrode can be used in more than one logical block. 

Select the bit of the Digital OUT you want the condition to be assigned to. The Digital OUT  
has 16 bits, D0 to D15. 
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Select from the “Spike Count” drop down menu either “Single Spike” or values from 2 to 100. 
This corresponds with the number of spikes that have to be detected in the defined time window 
to fulfill the criteria to generate a feedback. The frequency resulting from the selected 
combination of time window and spike count is also shown in the drop down menu in brackets. 

If more than one electrode and a spike count larger than one is selected, the selection Single 
Rate / Overall Rate becomes available. “Single Rate” means that the spike rate of each selected 
electrode is counted separately, and that the given spike count has to be reached on any of these 
electrodes to set the logical state of this channel on TRUE. “Overall Rate” means that the spikes  
of all selected channels are counted together, and that the combined spike count in the selected 
time window must reach the threshold to generate the logical state TRUE. If more than one 
electrode and “Single Spike”, or “Single Rates” is selected, it is necessary to combine the logical 
states of the different electrodes with the functions “AND” or “OR”.  

If “AND” is selected, a feedback is generated only if all electrodes have the logical state TRUE  
at the same time. If “OR” is selected, a TTL is generated if any of the electrodes has the logical 
state TRUE. 

The length of the TTL is determined by the overlap (AND) or addition (OR) of the TRUE states  
of the individual electrodes. 

Please see the following example: 

 

When selecting “Overall Rate” or one channel only, the logic option “And” or “Or” is not 
applicable. 

Rate Detection 

Important: For the purpose of this feature, a Rate is defined as the number of events in  
the selected time window. The time window is not a fixed time bin, but a moving window.  
For example if the window is set to 1 s, and a rate of 10 Hz is set as condition, the condition  
is fulfilled as soon as ten events within a second are detected. It may not happen that these  
ten events fall by chance in two separate time bins and are therefore not counted as 10 Hz. 
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In case of rate detection, the logical state becomes TRUE from the detection point of the last 
event that is needed to fulfill the rate condition till the end of the event duration. If the rate of 
detected events stays above the rate threshold, the logical state will remain TRUE as long as the 
rate condition is fulfilled. In the example below, a window of 200 ms and a rate of five events  
per window is set as condition. The logical state becomes TRUE upon detection of the fifth spike 
within 200 ms, and stays TRUE because the event rate remains above threshold. 

 

 

As shown above the status of the TTL output bit will remain HIGH as long as the logical state,  
or the combination of logical states of all selected electrode channels, fulfils the condition defined 
by the user, including the AND / OR function. 

Note: More complicated operations are possible when using custom software to control the DSP. 

Real-time Feedback Display Window 

The Real-time Feedback tool automatically opens a display window, which will show the raw data 
or data filtered by the digital hardware filter of the real-time feedback tool, the spike detection 
level and the TTL feedback signal. The starting point of the trigger is marked by the small triangle 
above. The duration of the trigger is indicated. You can change the color of all traces with a right 
click onto the trace, as usual. 

If one electrode is used for more than one logical block, the detected events and resulting  
TTL pulses for all applicable logical blocks will be indicated in the data window of that electrode.  
Turn on the “display labels” function with a right mouse click to see which trace belongs to which 
digital output bit. See red trace for D0 and green trace for D1 in image below. 

If two or more electrodes are combined with the condition OR, detected events on any of the 
combined electrodes will be indicated in each electrode data display. See dashed line in image 
below: An event is detected on the lower electrode only, but is indicated with a red triangle in 
both electrodes’ displays, as these electrodes are combined with the condition OR. 
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Examples: 

The following examples further illustrate the possible combinations of the Feedback Logic.  
In example one, single spikes are detected on two channels combined with the condition OR. 
Hence, the logical state of each channel is TRUE from the detection of an event till the end of  
the event duration (shown in red). As the two channels are combined with OR, a TTL is generated 
as long as any of the two channels, or both, have the logical state TRUE. 

In example two, the same channels are combined with the condition AND. This means, a TTL is 
generated only if both channels have the logical state TRUE. This setting can be used to detect 
simultaneous events. By adjusting the event duration, it is possible to define how close together 
two events have to be to trigger a feedback stimulation. 

Important: In extreme cases, if the overlap between the TRUE states of all selected channels is  
very short (below 20 μs), the generated TTL might be too short to trigger the stimulus generator. 

 

In example three, spike rates are detected with the condition eight spikes per time window.  
The two channels are combined with the condition OR. The logical state of channel one becomes 
TRUE upon detection of the eighth event in the time window until the last event that fulfils the 
condition, plus the event duration. In channels two, the event rate is too low. As both channels 
are combined with OR, the TRUE state of channel one is sufficient to trigger a TTL output. 

In example four, the overall event rate of channel one and two is combined and the condition  
is again eight events per time window. The addition of both channels results in longer and more 
TTL outputs. As the activity of both channels is counted together anyway, the combination 
parameter AND / OR is not applicable. 
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4.12 Filtering Data 

4.12.1 Filtering Data 

The Digital Filter tool can be used online or offline. Displays in dependence of filters can show 
the unfiltered and filtered data stream at the same time, so it is possible to directly monitor  
the effect of the filtering on the data. This is especially important because all filters are known  
to distort signals. Keep in mind that you may need a higher sampling rate to avoid aliasing.  
Please see also chapter "Filtering and Sampling Rate" for more information about aliasing. 

The filter tool creates a separate data stream that will show up in dependent displays and 
instruments, as well as in the recorder. More than one filter can be used in combination on  
the same data stream (one filter type after the other). However, this option consumes a lot  
of system resources and can in some cases lead to performance problems. A range of filter  
types are available, please see chapter “Filter Characteristics” below for a short description. 

Click Edit drop down menu “Add Filter”. Select “Filter” tab. 

 

Filter types:   Bessel 2nd order 

Bessel 4th order 

Butterworth 2nd order 

Chebyshev 2nd order, 0.5, 1.0, 2.0 and 3.0 dB 

Bandstop Resonator 

Savitzky Golay 

Filters can be used to remove background noise from signals or to separate signal components 
with different frequencies. The filter creates a separate data stream that can be recorded or 
further processed. For example, you can use a high pass filter to separate spikes from slow field 
potentials, and afterwards detect and analyze spikes on the filtered data. 

The low pass filter preserves frequencies below passband; frequencies above stop band are 
removed, with a smooth transition in-between. The high pass filter preserves high frequencies.  

Note: All filters distort signals, so use the filter carefully! 
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Adding a filter to your rack  

1. To add a virtual filter to your rack, click "Add Filter" from Edit menu, or click the Filter button 

 on the toolbar. 

2. Click the Channels tab and select the channels you like to be filtered. 

Click the Filter tab to select the filter type. If you choose the Butterworth filter you have to 
define high or low pass and the cutoff frequency. If you select the Savitzky-Golay filter you 
have to define the order and the "Number of Points" used for averaging. The number of points 
gives the quantity of points, which are included from the right and the left side of a data point  
for averaging the calculated data point (2, 4, 8, 16, 32, 48).  

Note: If you choose a high number of data points for averaging, for example 32 or 48,  
the computer needs a high performance for calculating each filtered data point! 

The cutoff frequency for spikes (High Pass) is typically in the range of 0.3 to 3.5 kHz; for LFPs 
(Low Pass) 10 to 500 Hz is suitable. The cutoff frequency of the filter must be compatible with 
the frequencies present in the signal of interest. 

Changing the lowest and highest bandpass frequency 

Use two filters for changing the lowest and highest frequency of the pass band. For example,  
if you use a broadband amplifier and you need a bandwidth of 300 Hz to 3 kHz for recording 
spikes, combine a high pass filter with a cutoff frequency of 300 Hz and a low pass filter with  
a cutoff frequency of 3000 Hz. Select the "Filtered Data" output stream of the first filter as the 
input stream for the second filter. 
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Signal distortion 

Though filters present an easy and convenient way to remove unwanted signals from your data, 
filters should be used with care. All filters (analog and digital) distort signals, especially if the 
signal frequencies lie near the cutoff frequency. You should be aware of the fact that the signal 
amplitude may be modified by a filter, and that the signal may be shifted as well. 

 

In this screen shot, you see regular signals (from a signal generator) with a frequency of about  
70 Hz (green traces). The cutoff frequency of the low pass filter has been set to 200 Hz. A low  
pass filter removes high frequency components of signals. You can clearly see that the amplitude 
of the filtered data (magenta) is decreased and the phase of the signal has been shifted slightly. 

The distortion increases with increasing signal frequency. If the frequency is set near the cutoff 
frequency, the shape of the signal has changed to a sinus waveform. 

 

If the frequency is increased far beyond the cutoff frequency, for example 1 kHz, the signals  
are almost completely removed (which is, of course, the purpose of a filter). 

 



MC_Rack Features 

137 

4.12.2 Filter Characteristics 

Bessel 

A Bessel filter is a type of linear filter with a maximally flat group delay (maximally linear phase 
response). Analog Bessel filters are characterized by almost constant group delay across the entire 
passband, thus preserving the wave shape of filtered signals in the passband. 

 

Butterworth 

The Butterworth filter is designed to have a frequency response which is as flat as mathematically 
possible in the passband.  

 

Chebyshev 

Chebyshev filters are analog or digital filters having a steeper roll-off than Butterworth filters. 
Chebyshev filters have the property that they minimize the error between the idealized filter 
characteristic and the actual over the range of the filter, but with ripples in the passband. Because 
of the passband ripple inherent in Chebyshev filters, filters which have a smoother response in the 
passband but a more irregular response in the stopband are preferred for some applications. 
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Bandstop Resonator 

In signal processing, a bandstop filter is a filter that passes most frequencies unaltered,  
but attenuates those in a specific range to very low levels. A bandstop filter with a high  
Q factor has a narrow stopband. Please see the following pictures.  

 

Savitzky Golay 

The parameters of the Savitzky-Golay filter are the order (2 or 4) and the number of points which 
are included from the right and the left side of a data point for averaging the calculated data 
point (2, 4, 8, 16, 32, 48). This filter can be used to smooth a noisy signal. However, it is possible  
to accidental filter out fast signals, like spikes. 

The y-axis is the normalized amplitude, that is, the output amplitude divided by the input 
amplitude. The x-axis represents the frequency of a sinus-wave function. The red line indicates  
the input signal amplitude, the purple line indicates the theoretical value at the cutoff frequency, 
and the green vertical line indicates the cutoff frequency. The data was obtained using a sine 
wave generator and MC_Rack for the measurement. The cutoff frequency was set to 100 Hz.  

All filters except of Savitzky Golay are calculated with the help of Fidlib 0.9.10 Copyright  
2002-2004 Jim Peters http://uazu.net. This library is released under the GNU Lesser General  
Public License (LGPL) version 2.1 as published by the Free Software Foundation. 

4.12.3 Filtering and Sampling Rate 

A sampling rate of at least five times the highest frequency of the signal of interest is generally 
enough for a reasonable representation of the signals. If you are using a broadband MEA1060 
amplifier and a digital low pass filter for removing high frequency noise, however, a higher 
sampling rate might be necessary. 

According to the Nyquist-Shannon sampling theorem, the sampling rate should equal twice the 
bandwidth of the analog (hardware) low pass filter. The 1/2 bandwidth frequency is also called 
Nyquist frequency. You may ignore this if saving hard disk space is more important for your 
application than the noise level. 

This is the case because the full amplifier bandwidth is recorded and then high frequency noise is 
removed with a digital low pass filter after recording. Frequencies (noise) that are above half the 
sampling rate (for example above 2.5 kHz at a 5 kHz sampling rate) will be transformed into lower 
frequencies. This is called aliasing. This low frequency noise passes the digital low pass filter and 
increases your noise level. 

The other possibility to prevent aliasing is to use a MEA1060 amplifier with an appropriate analog 
low pass (so-called anti-aliasing) filter instead of the digital filter instrument. 
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Example: 

This can be demonstrated by the following experiment. A regular 1000 Hz signal (from a pulse 
generator) is applied to electrode input channels of the MC_Card. In this experiment, this signal 
represents the high frequency noise that should be removed. A 100 Hz Low Pass filter is used to 
remove this high frequency "noise" signal. 

At a sampling rate of 5 kHz, signals up to 2.5 kHz are safe from aliasing, resulting in a good 
sampling and filtering result. The screen shot shows the raw data (blue trace) and filtered data 
(magenta). 

 

 

The high frequency "noise" signal has been removed by the filter. The signal frequency of the 
digitized data (measured with a Spike Detector and Analyzer) matches the frequency of the 
analog input signal. 

At a sampling rate of 1 kHz, aliasing occurs to frequencies above 1/2 sampling rate, that is, above 
500 Hz. Thus, the 1000 Hz signal is digitized to a low frequency signal of about 4 Hz (see time 
scale of display). Please note that the only difference between the two screen shots is the altered 
sampling rate. The input signal is exactly the same. 

Of course, the low frequency noise signal passes the digital low pass filter. The raw data and the 
filtered data traces match perfectly. 
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4.12.4 Downsampling 

The MC_Rack downsampling feature offers the possibility to generate raw and filtered data 
streams with different sampling frequencies. This can help to avoid huge amounts of 
resulting data when recording more than one data stream. For example, you can record spikes 
with a high sampling rate, and a second filtered data stream with slow field potentials with  
a lower sampling rate (please see the example at the end of the section).  

The maximum sampling frequency used in a file is still defined in the Data Source. To add  
an additional data stream with a lower sampling rate, you need to use a digital filter tool.  
The parameters for the downsampled data stream are set in the filter tool dialog, as using  
a low pass filter is a precondition for the downsampling feature. 

 

Click Edit menu “Add Filter” or click the filter icon in the main menu toolbar.  

Note: All filters distort signals, so handle filters with care! 

Click the “Channels” tab and select the data stream and the channels you want to apply  
the downsampling to. Open the “Filter” tab and select an appropriate filter type. Bandstop 
Resonator and Savitzky Golay filter are not compatible with downsampling, as they do not define 
a lower cutoff frequency. Select a “Low Pass” filter with an appropriate “Cutoff Frequency”. 

Select the “Downsampling” check box and choose a "downsampling frequency" in Hz from  
the drop down menu. The lowest frequency for downsampling is 100 Hz. 

For downsampling electrode raw data you need a proper combination of cutoff frequency and 
downsampling frequency to avoid aliasing. Please read also chapter "Filtering and Sampling 
Rate". According to the Nyquist-Shannon sampling theorem, the cutoff frequency of the low  
pass filter must be half of the downsampling frequency, or less (sampling frequency 2x cutoff 
frequency, respectively). If the frequencies selected by the user do not match, MC_Rack will 
suggest an appropriate cutoff frequency for the selected downsampling frequency via the 
following dialog: 
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MC_Rack sets the cutoff frequency of the filter automatically. A second dialog will appear  
and prompt the user to select a cutoff frequency in the possible range (0.1 to half of the 
downsampling frequency in Hz). Please type in a number in the denoted range. 

Note: The second dialog is generated directly by Windows, and will therefore appear in the 
language set in the operating system.  

The filtered and downsampled data will appear as an individual data stream in the “Channels” 
tab of the Recorder. To record the downsampled data, you have to select this data stream. 

Example: Recording two data streams with high frequency spikes and low frequency ERGs from  
a retina slice with different sampling rates. The following rack contains two filters, a high and  
a low pass. The data are ERGs from a retina slice with spikes on top of the slow field potentials.  

 

The raw data is shown in blue. The high pass filter (Filter 1) subtracts the slow component of  
the signal, and leaves only the spikes (red). This data stream will be sampled with the frequency 
set in the Data Source. The low pass filter (Filter 2) leaves only the slow component (ERG, green). 
In this example, the slow field potential gets downsampled to 1000 Hz. Hence, the data stream 
“Filtered Data 2” available in the "Channels" tab of the Recorder is recorded with a sampling 
rate of 1000 Hz. 

Replaying Files with downsampled Data Streams 

Files containing data streams with different sampling rates can be replayed by the Replayer  
as usual. In the tab “Buffer Info” of the Replayer, you can review the information about the 
different data streams, including which filters and downsampling options were selected when  
the file was recorded. 
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4.13 Spike Sorter 

4.13.1 Spike Detection Methods 

The virtual Spike Sorter instrument is used for extracting spikes from the raw data,  
and for sorting spikes into up to three single units per electrode (channel). 

There are two ways of detecting and extracting spikes with MC_Rack. One method uses  
a threshold, the other recognizes the shape that is, the amplitude and slope of a curve.  
Both methods regard either the rise or the fall of a curve, depending on your settings. 
Waveforms that meet the requirements defined by either of the two methods are cut out  
from the raw data. The size of the cutout, that is, the time length before and after the spike 
detection event, can be chosen by the user. It is also possible to extract only the time stamps. 

The Threshold method is especially useful if the overall signal is steady and the spikes appear 
approximately on the same height. If you have local field potentials or a high noise level,  
you will miss spikes or detect noise signals with the Threshold method. In this case, the Slope 
method is more appropriate. 

The following illustrations show how the two methods work. 
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4.13.2 Detecting Spikes by a Threshold 

You can define a threshold (spike detection level) for each channel separately. All peaks that  
cross the threshold are detected. Spike traces are cut out around the detection event. The 
resulting spike cutouts form a new data stream that can be further processed by other tools,  
that is, sorted, analyzed, displayed, and so on. See also the preceding illustrations "Spike 
detection" and "Voltage threshold not reached". 

 If you select the option Negative Slope, the fall of the curve is regarded, otherwise the rise  
is considered. This setting applies only to the selected channel. Under Apply to All, click Slope  
to apply the slope setting to all channels. 

There are several ways to set the detection levels. It is up to your choice which way you like to use. 

 Select a channel from the drop-down list and define the threshold for this particular channel. 

 You can change spike detection levels by moving them with your mouse in the display window. 
The values in the rack window will then change automatically. 

 You can then tune all channels, which means, that the different levels of all channels are 
modified by the same factor (+ 1 μV or -1 μV). 

 You can also apply the same detection level or the negative/positive slope to all channels.  
Under Apply to All, click Level or Slope, respectively. 

 The Automatic feature is very convenient to automatically assign an individual detection level 
to each channel. The standard deviation of each data trace is used to estimate its spike threshold. 
A time interval of 500 ms is used to calculate the standard deviation. You set the factor, by which 
the standard deviation is multiplied. Click Refresh to calculate the standard deviation and apply 
the result. It depends on the distribution of noise and spikes, which factor you should use. The 
higher the spike rate, the lower the factor can be set. The sign of the factor determines whether 
the spike detection level is positive or negative. You generally will use a negative factor. A value 
between -1 and -4 is appropriate for most applications. 

 

4.13.3 Detecting Spikes by Waveform 

With this method, the shape of a signal is considered instead of the absolute height of a peak. 
You define the minimum amplitude (in μV), and the minimum and maximum slope (in μV/μs) 
that a signal must have to be considered as a spike. In contrast to the spike detection level, which 
presents a fixed absolute voltage level, the Slope method searches the incoming data trace 
continuously for a waveform that satisfies the following criteria: The slope range that is 
specified by the minimum and maximum slope and the minimum amplitude (dV). The 
preceding illustration "Spike detection" shows both methods of spike detection (for a negative 
slope). 

The amplitude parameter ensures that noise waveforms that satisfy the slope criteria, but has  
a too small peak, are not detected (see illustration "Amplitude too small"). On the other hand, 
there may be voltage drops that are high enough, but too slow or too fast, that is, the slope is  
too low or too high, respectively. These are not detected, too (see illustrations "Slope too low" 
and "Slope too high"). 
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Only waveforms that satisfy both criteria (slope and amplitude) are considered spikes.  
See also the preceding illustrations "Spike detection" and "Not detected waveforms". 

 

4.13.4 Spike Cutouts 

You can define the size of the spike cutout in the ranges of 100 ms Pre-Trigger and 1500 ms 
Post-Trigger times. The detection event is the point of time when the threshold has been crossed 
(threshold method), or the point of time, for which the amplitude and slope criteria have been 
fulfilled (slope method). 

The data from pre-trigger to post-trigger event is the spike cutout. The Dead Time determines, 
for how long after a detection event no new detection event is accepted. You can define 
overlapping cutouts, that is, the Dead Time can be set lower than the Post-Trigger time.  
This makes sense for monitoring cardiac arrhythmia, for example. But please note that this affects 
the computer load. It is recommended to set the Dead Time to at least the Post-Trigger time for 
saving computer performance. 

The spike cutouts form a new data stream, the Spike stream, which can be sorted, analyzed, 
displayed, recorded, and so on. 

 

Extracting timestamps only 

If you are interested in the spike rate or spatial distribution of spikes but not in the waveform 
information, you can extract only the detection events of spikes as single data points. This saves 
computer performance and hard disk space. Please see chapter ”Extracting Timestamps only" in 
"Burst Analysis”. 
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4.13.5 Spike Sorting 

Most often, spikes do not represent a single unit activity, but are derived from multiple neurons. 
Spikes from separate neurons usually have different shapes and a different rhythm. To interpret 
an experiment, it is often very important to sort spikes into categories, thus separating single unit 
spikes. 

In MC_Rack, you can sort spikes into three groups. The sorted spikes can then be displayed by  
a Data Display. 

 

A special overlay display for spike sorting is provided. You can set the number of spike cutouts 
that will be overlaid (up to 500) and define the number of groups (up to three). Use the buttons 
on the display header to switch from the standard Spike Sorter display to the Spike Sorter 
overlay display and vice versa. The icon of the active display mode is highlighted in white. 

 

You simply tag spikes by positioning the red bar with the mouse in the Spike Sorter overlay 
window. You can adjust the height of the bar by dragging it with the mouse. The tag defines  
a voltage range and a point of time (in relation to the spike cutout). All spikes that fulfill both 
requirements, that is, lie in the specified range at the specified point of time, are tagged and 
assigned to the corresponding group. Thus, spikes that have a different shape can be separated 
from each other. The bars should be moved to the positions, where the two signals differ most 
from each other to obtain best results. 

The spike detection level is very important for spike sorting. If your detection level is too low  
and you see too many signals and too much noise, it may be difficult to detect and separate  
single unit activities. 

 

You may like to switch back to the standard Spike Sorter display to adjust the spike detection 
parameters. Click the appropriate button to switch back to the spike detection view. 

Also, the number of spikes you overlay is important. If you overlay not enough spikes, you will  
not see different units. If you overlay too much spikes, the display may be crowded and it may  
be difficult to distinguish different signals, either. Try different parameters until you get a feeling 
for the settings. 
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The following illustration shows the activity of two neurons, as spike cutouts on a small time basis. 
The first (red) signal has one peak, the second (yellow) spike waveform shows a small peak 
followed by a bigger peak. The window bars are positioned at the time point where both signals 
differ most. 100 spikes are overlaid in this plot. 

 

When zooming into a channel in Spike Sorter overlay mode (as shown above) be aware that  
the traces might be displayed in low quality, that means, you can discriminate single pixels.  
The quality of the picture increases when the display is refreshed.  

The next illustration shows the sorted spikes (Raw Data). The blue signals do not belong  
to either of the two units. 
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4.13.6 Burst Analysis 

The “Burst Detection” option allows the detection and analysis of spike bursts. The spikes have 
to be detected by the spike sorter first. The quality of the burst analysis therefore depends heavily 
on the accuracy of the spike detection. 

Add the "Spike Sorter" and the "Spike Analyzer" to the virtual rack. Click "Analyzer" tab. 
Spike burst analysis will be active as soon as the "Burst Marker" is selected. Bursts are detected 
based on the MaxInterval Method. The method is explained below. 

 

 

The MaxInterval Method for detecting bursts 

Find all bursts using the following algorithm: 

 Scan the spike train until an interspike interval is found that is less than or equal to Max. 
Interval. 

 While the interspike intervals are less than Max. End Interval, they are included in the burst. 

 If the interspike interval is more than Max. End Interval, the burst ends. 

 Merge all the bursts that are less than Min. Interval between Bursts apart. 

 Remove the bursts that have duration less than Min. Duration of Burst or have fewer spikes 
than Min. Number of Spikes. 
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The detection parameter for bursts are shown in the following picture. 

 

Parameter for burst detection: 

Max. interval to start bursts: maximum interspike interval to start the burst. 

Max. interval to end a burst: maximum interspike interval to end the burst. 

Min. interval between bursts: minimum interspike interval between two bursts. 

Min. duration of burst: minimum burst duration. 

Min. number of spikes in burst: minimum number of spikes in a burst. 

(Reference: Legendy C.R. and Salcman M. (1985): Bursts and recurrences of bursts in the spike 
trains of spontaneously active striate cortex neurons. J. Neurophysiology, 53(4) : 926-939). 

 

Monitoring of Spike Burst Detection 

To monitor the spike burst detection, it is possible to display the detected spikes as Timestamps 
in a spike parameter window. If the "Burst Marker" is selected, a line under the timestamps  
will mark the detected bursts. The image below shows a spike burst and the corresponding 
timestamps in a spike parameter window, with the green line below depicting the detected burst. 
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Different units on each electrode, separated by the spike sorter, will be shown in different colors. 
In the same window, a color coded line under the time stamps will mark the detected bursts 
individually for each unit. Unit 0 represents all unsorted spikes together, and is displayed in  
green as shown in the picture above. 

 

Online Detection of Spike Burst Parameters 

Click in "Spike Analyzer" the "Analyzer" tab. The "Burst Detection" dialog allows setting  
the parameters described above. Additionally, the user can select which spike and burst 
parameters should be analyzed. The parameters selected in the menu are analyzed online  
for each detected burst. 

Burst parameters are Mean Spike Frequency (mean spike frequency inside burst plotted  
for each burst), and Spike Number (number of spikes inside burst plotted for each burst). 

These parameters can be plotted versus time in a spike parameter display, just like the overall 
spike frequency or the ISI. One parameter display can show either the mean spike frequency or 
the spike number per burst. These results can be exported as picture or ASCII with the standard 
export function of parameter displays.  

Analysis of Spike Burst Parameters  

In addition to the two parameters mentioned above, the burst parameters listed below are 
calculated for the whole detection period that means from start to stop of data acquisition. 
Analysis is done whether the data is recorded or not. With the command "Export Results"  
you can export the numerical results of the spike burst analysis to a tab delimited (text without 
formatting) file with the extension *.dat. The file includes the listed analysis parameters of spikes 
and bursts, organized in columns: 
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1. Channel / Unit  

2. Number of Spikes  

3. Mean Spike Frequency [Hz]  

4. Number of Bursts  

5. Bursts per Second  

6. Bursts per Minute  

7. % of Spikes in Burst  

8. Mean Burst Duration [ms]  

9. Mean Spikes in Burst  

10. Mean ISI in Burst [ms]  

11. Mean Spike Frequency in Burst [Hz]  

12. Mean Interburst Interval [ms] 

 

Hint: All parameters will be calculated, independently from the selected online burst parameters. 

 

Extracting Timestamps only 

If you are interested in the spike rate or spatial distribution of spikes but not in the waveform 
information, you can extract only the detection events of spikes as single data points. This saves 
computer performance and hard disk space. 

Add the "Spike Sorter" and the "Spike Analyzer" to the virtual rack. Click "Analyzer" tab.  
Select the check box “Timestamp”. 

 



MC_Rack Features 

151 

Add a display to your virtual rack. Click “Data” tab. In “Data Streams” select “Spike parameter 1” 
and “Timestamp”. In “Plot Type” please select check box “Trace”. 

 

Start the recording or replaying. Zoom into one channel on the display by double click. 

 

You see the timestamps only. Click   icon to export the timestamp data to one single data file 
or to export them to one file per channel. 
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4.14 Analyzing Data 

4.14.1 Analyzing Data 

Two virtual instruments are provided for data analysis: 

Standard Analyzer based on discrete time intervals (bins or region of interest) for general 
analyzing purposes (all data streams supported). This Analyzer type is especially useful for 
waveform analysis, for example, for amplitude and slope analysis of evoked responses.  
Extracted parameters can be graphed in the Parameter Display. 

Event-based Spike Analyzer for extracting statistical parameters such as the interspike 
interval (ISI), timestamps or the spike rate from Spike data streams generated by the Spike 
Analyzer. Extracted parameters can be graphed in the Spike Analyzer Display. The Spike 
Sorter, the Spike Analyzer, and the Spike Parameter Display are intended for general event 
detection and analysis, and are thus useful for both neuronal and cardiac applications. 

Both analyzers extract the selected parameters of interest from any number of channels that  
you have assigned to it. You can assign only a single data stream to an analyzer. Use multiple 
analyzers for analyzing multiple data streams. 

The extracted parameter values form a new data stream, the Parameter or Spike Parameter 
stream, which can be processed further by other virtual instruments, for example, the displays 
mentioned above for online or offline graphing, the Recorder for storing the parameters in  
a data file, and so on. The extracted parameters can be exported in an ASCII or a graphic file 
format directly from the parameter displays. 



MC_Rack Features 

153 

4.14.2 Time-Interval Based Analyzer 

Extracted Parameters 

The following parameters can be extracted with the Analyzer from the described data streams. 

Parameter Analyzer input stream 

Raw Data Spikes 

t-Min Point of time when minimum occurs, 
relative to trigger event (to start of 
recording if no trigger is present) 

 

t-Max Point of time when maximum occurs, 
relative to trigger event (to start of 
recording if no trigger is present) 

 

Minimum Lowest value in time window (minimum)* 

Maximum Highest value in time window (maximum)* 

Peak-
Peak-
Ampl. 

Amplitude, maximum minus minimum Amplitude, maximum minus 
minimum of largest spike in time 
window 

Amplitude 
(Mean) 

Mean value of all data points in time 
window 

 

Slope Slope of linear fit regression line  
(Least Square Algorithm): A straight 
line is fitted through the data points 
in the region of interest. The slope of 
the straight line is then extracted. 

 

Slope  
10 % /  
90 % 

Slope of linear fit regression line (Least 
Square Algorithm) of 10 % / 90 % (or 
20 / 80 or 30 / 70) interval, see below. 

 

Number  Number of spikes in time window 

Rate**  Number of spikes in time window  
per second (in Hz) 

 

* If there are no spike events in the time window, the Analyzer will extract an invalid value 
(outside the voltage range) as minimum or maximum. The Analyzer cannot extract 0 in this case, 
as 0 can be a valid value for the minimum or maximum, and would thus be misleading. 

** Evaluating an event rate in discrete time bins is useful, for example, for analyzing the  
signal distribution. Often, a continuous analysis of an event rate is more useful, for example,  
for monitoring the beating rhythm of a cardiac application. For these purposes, use the event-
based Spike Analyzer. 
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Slope extraction 

 

The 10 % / 90 % (or 20 / 80 or 30 / 70) interval of the peak-peak amplitude (stretching from 
minimum to maximum) in the region of interest is detected. Only data points in this interval  
are used for the linear regression fit (Least Square Algorithm). The slope of the resulting straight 
line (not shown in the Analyzer) is extracted as the slope. 

Triggered Mode vs. Continuous Mode 

The Analyzer can be operated either synchronized on a trigger event, or continuously. 

The selected parameters of interest are extracted from a distinct time window that is either 
relative to the trigger event (then termed region of interest) in triggered mode, or results  
from splitting up the continuous data stream into time bins of equal size. 

For example, when analyzing an evoked response such as LTP, the region of interest follows  
the electrical stimulation. When continuously recording spikes, the spike rate would usually  
be extracted from 1 s time bins. For slower signals such as cardiac signals, a higher bin size  
would be more appropriate. 

You can use separate Analyzers in the same virtual rack configuration for extracting parameters 
from the same channels, but distinct regions of interest (for example, for a PPF experiment)  
or different bin sizes (for example, if you want to compare the overall spike rate (measured  
in 1 s bins) and the organization of spiking activity (in 100 ms bins). 

Defining the ROI (Triggered Mode) 

The Analyzer estimates the selected parameter type for the region of interest (ROI), which  
is defined in the ROI tabbed page of the Analyzer. Thus you can analyze the data relative to  
the trigger event. By defining the ROI, you can also exclude data from the analysis, for example,  
if you have stimulus artifacts that would disturb the analysis. See "Triggered Data" for more 
information. 

You can set up several Analyzers with independent region of interests on the same or other 
trigger, for example, for paired pulse analysis. If you have two trigger events shortly after each 
other, but you want to use only the first event to trigger the Analyzer, exclude the second trigger 
event by choosing a higher dead time in the Trigger Detector. 

Note: The region of interest can have virtually any time length, even several hours. Of course  
it is limited by the length of the sweeps. Please make sure that the region of interest does not  
go beyond the actual sweep. The internal data handling of MC_Rack does not allow to display 
sweeps that are longer than 2 s. If you need a region of interest that is longer than 2 s, you can 
define T2 by entering the appropriate time in the text box, but the T2 bar will not be displayed  
in the Analyzer window. 
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1. Set up a rack with a Trigger Detector and an Analyzer. 

2. Click the ROI tab of the Analyzer. 

3. Select the option Start on Trigger and choose the appropriate trigger from the drop-down list. 
 

 
 
The Analyzer display appears. You can change the layout of the Analyzer display in the same way 
as that of a standard display. 

4. You can define the region of interest either with the two bars T1 and T2 directly in the display 
(not available for ROIs of more than 2 s) or by entering the appropriate values into the text boxes 
in the ROI dialog box. 
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Maximum trigger rate 

Please note that the ROI must be defined in a way that the trigger rate does not cause ROIs  
to overlap. 

The maximum refresh rate of the Analyzer display is determined by the x axis range selected 
from the drop-down list on the display toolbar. In contrast, the Analyzer functionality, that is, 
the parameter extraction, is directly related to the trigger events, not to the display. The 
Analyzer does not allow overlapping regions of interest, that is, trigger events that would lead 
to overlapping ROIs will be ignored. In other words, the Analyzer will only accept following 
trigger events after time point T2 minus T1. (For example, for T1 = 2 ms and T2 = 21 ms, new 
trigger inputs will be accepted only at 20 ms or later after the first trigger event, because 20 ms 
plus 2 ms will result in the new T1 = 22 ms, and that is after the end of the first ROI = 21 ms.) 
To avoid misunderstandings, it is recommended that the refresh rate of the display corresponds 
to the expected maximum trigger event rate, by either adjusting the refresh rate of the 
Analyzer, or by adjusting the dead time in the Trigger Detector. (If the trigger event rate is 
lower than the display refresh rate, the display will be refreshed only at a new trigger event.) 
Example: If you have trigger events at a 10 Hz rate, that is, at a 100 ms trigger interval, but the 
display refresh rate is set to 200 ms or +/-100 ms, the Analyzer display will miss every second 
sweep, but the selected parameter, for instance the peak-peak amplitude, will be extracted from 
each sweep, that is, each 100 ms (provided the ROI and trigger settings do not lead to overlapping 
ROIs). 

 

Defining the Bin Size (Continuous Mode) 

If you have a continuous data stream, you can define the time intervals from which the analyzer 
will extract the selected parameter. For example, if you choose intervals of 1 s, the parameter,  
for example the spike rate, is measured for 1 s intervals. For example, the spike number may  
be 80 in the first second, 30 in the second second, and 40 in the third second, and so on. 

The appropriate bin size depends on the expected signal rate, and on the purpose of the 
Analyzer. 

For example, when monitoring the cardiac signal rate of a cardiomyocyte preparation, it does not 
make sense to use a 1 s bin size, because the expected signal rate is in the range of 1 Hz, that is, 
either there is a signal detected in the bin or not. This would result in an extracted rate switching 
between 0.00 and 1.00 Hz. For this purpose, you would need a higher bin size, for example, 5 s. 
Please note that a higher bin size affects your resolution on the other hand. That is, with a bin 
size of 5 s, the rate will be updated only every 5 s. 
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When monitoring faster signals like neuronal spikes, a bin size of 1 s will generally be fine.  
For special applications, it can make sense to use a smaller bin size, that is, if you are interested 
more in the organization of signals than in the overall spike rate. For example, if the Analyzer 
extracts the spike number in 100 ms bins, you will get a pattern of empty and non-empty bins 
(with a majority of empty bins) if the spike pattern is highly organized in bursts. If the activity  
is more random or distributed over time, the number of empty bins will be lower. (See example 
rack  Neurons_DrugApplications_Demo.rck.) 

Another example: You can extract the spike rate in 10 ms bins, and use the false color plot  
as an "LED display", that is, electrodes will light up each time if there is any spike activity  
on the electrode, refreshed each 10 ms. (See example rack Neuro_Spikes_LED_Display.rck.) 

For longterm experiments (over weeks or months), a higher bin size might be appropriate for 
reducing the amount of data points. For example, you can extract the spike rate each 5 min.  
(See example rack SpikeRate_5minBins.rck.) 

1. Set up a rack with an Analyzer. 

2. Click the ROI tab of the Analyzer. 

3. Select the option Continuous and enter the appropriate time window (Bin). 

 

Averaging Extracted Parameters 

You can average the parameters over several intervals. For example, if you choose intervals  
of 1 s, the parameter, for example the spike rate, is measured for 1 s intervals. 

For example, the spike number may be 80 in the first second, 30 in the second second,  
and 40 in the third second, and so on. If you have set the number of windows to 3,  
the spike rate of the first three intervals (three seconds in total) is averaged, resulting  
in a mean value of 50 Hz:(80 + 30 + 40) : 3 = 50. 

If you have triggered data, the time window refers to the region of interest. 

Set the number of windows to 1, if you do not want to average data. 

1. Click the Analyzer tab of the Analyzer. 

2. Under Window Means, enter the number of time windows that should be averaged. 
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4.14.3 Event-Based Spike Analyzer 

Extracted Parameters (Spike Analyzer) 

The following parameters can be extracted with the Spike Analyzer. Only Spike data streams 
are available as input streams. Each detection event generates a data point. 

Interspike 
Interval 

Time interval between detection events (as detected by the Spike Sorter) 

Rate Event rate in Hz (1 divided by the interspike interval) 

Timestamp Indicates a detected spike at a that time, when the spike occurs 

4.15 Parameter + Spike Analyzer Display 

4.15.1 Plot Types 

Two virtual instruments are provided for graphing extracted parameters: 

 Parameter Display for graphing Parameter streams (generated by an Analyzer),  

such as the peak-to-peak amplitude. Click  to add a Parameter Display to your rack. 

 Spike Analyzer Display for graphing Spike Parameter streams (generated by a Spike 

Analyzer), such as the interspike interval, timestamps or the spike rate. Click  to add a Spike 
Parameter Display to your rack. 

For the Parameter Display, four plot types are available: Trace, Color vs. Time, False Color and 
Number. 

For the Spike Analyzer Display, only the Trace and Color vs. Time plot are available (because 
the False Color and Number Plot need to be updated on a regular interval and not on events 
for proper operation. You can choose between the plot types on the Data tabbed page of the 
display. 

 Trace plot: Parameter values are plotted as a line with or without markers displayed at each data 
point. Default: Parameter values are plotted as markers at each data point (dots without line). 

 Color vs. Time: Displays the data as colored bars over time. Similar to the false color plot,  
but with the time information. 

 False Color: Shows the spatial distribution of signals in a two-dimensional false color map. 

 Number: Displays the actual value as a number. 

4.15.2 Trace Plot 

 Parameter values are plotted versus time in a Trace plot. You can choose between showing 
markers (scatter graph), lines, and both markers and line by pressing the appropriate graph 
option button in the display toolbar. See also Parameter Display Tools. 

 In the Spike Analyzer Display, you also have the option to choose between a straight line and 
a horizontal step line graph by pressing the appropriate graph option button in the display 
toolbar. These options are only available if either the line or marker and line option is active. 
See also Parameter Display Tools. 

 Several data streams, for example spike rate and peak-to-peak amplitude, can be shown in the 
same plot. 

 Different data streams are plotted in different colors. 
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4.15.3 False Color Maps 

In the Color vs. Time and the False Color plot, color values or gray-scale intensities are assigned 
to parameter values. 

The colors are chosen from a Color Map. The following pre-set color maps are available: Jet, Hot, 
Cool, Gray and Jet reverse. Each color map consists of 64 different colors arranged  
in a particular way. 

 

The range of the y-axis (defined in the display) is assigned to the selected Color Map, that is, the 
leftmost color corresponds to the minimum y-value (Min) , and the rightmost color corresponds  
to the maximum y-value (Max). The interval between min and max is straight-proportional to the 
colors in-between. For example, low values can be displayed in cool colors, and high values in 
warm colors (false color map Jet). Or you can display low values in dark gray scales, and high 
values in light gray scales (Gray). 

The color of the actual value is looked up from the Color Map accordingly. Parameter values 
outside the defined min/max range are plotted in Black. 

Example: If the range was set from min = 0 Hz to max = 64 Hz, each color of the map would 
correspond to 1 Hz steps. Spike rates lower than 1 Hz would then be plotted as the first (leftmost) 
color of the color map, spike rates between 1 Hz and 2 Hz would be plotted as the second color  
of the color map, and so on. A value above 64 Hz would be plotted in black. 

 

4.15.4 False Color vs. Time (Plot) 

In a Color versus Time plot, color values or gray-scale intensities are assigned to parameter 
values. This feature can be used to enhance the visibility of details in the plot. You can choose 
between four different false color maps. 

The Color vs. Time plot shows the data as colored vertical bars over time. Each y-value  
is assigned to one of 64 colors (defined by the Color Map). 

Note: Only one input data stream can be displayed here.  

4.15.5 False Color Plot 

In a False Color plot, color values or gray-scale intensities are assigned to parameter values.  
This plot type is very useful for two-dimensional applications. It gives you a good imagination  
of different areas of activity in your preparation. 
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You can choose between four different false color maps. The False Color plot shows only the 
current values as colors without information about the time. Each parameter value is assigned to 
one of 64 colors (defined by the Color Map). There is no time axis, the plot is refreshed according 
to the Window settings of the Analyzer. 

Scrolling back and forward is not available for this plot type, but will be enabled in future 
versions. The scroll arrows are present but inactive. 

Note: Only one input data stream can be displayed in a False Color plot. 

The following screen shots show a False Color plot (Color Map Jet) of a spike rate. An Analyzer 
has been used to extract the spike rate and a Parameter Display to display the False Color plot. 

The first screen shot shows the right region firing, the second shows the left slice firing. You see 
now clearly that both brain slices fire independently. 

 

 

4.15.6 Number Plot 

The Number plot shows the current parameter value (for example the spike rate of a neuron)  
as a number. 

Note: Only one input data stream can be displayed in a Number plot. 

Scrolling back and forward is not available for this plot type, but will be enabled in future 
versions. The scroll arrows are present but inactive. 
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4.15.7 Parameter/Digital Display Tools + Settings 

Each Parameter Display or Digital Display has a toolbar at the top of the window. 

 

 Zoomed 
Channel:  

This icon appears, when you have zoomed a single channel.  

 
Apply to All:  (In zoom mode) Applies the display settings to all channels. 

 
Show/Hide 
Measure Tool: 

A vertical bar in the color of the data channel is shown that displays the  
x- and y-value of the intersection point. You can position the bar with the 
mouse. Right-click the bar for several options, such as measure the peak-
peak amplitude or period. (Available only in Zoomed Channel mode.) 

 
Start Position: Moves displayed region to the start position. 

 
Back: Rewinds displayed region. 

 
Forward: Fast-forwards displayed region. 

 
End Position: Moves displayed region to the last position. 

 
Zoom In x: Scales up the x-axis. 

 
Reset x: Resets scaling of the x-axis. 

 
Zoom Out x: Scales down the x-axis. 

 
Zoom In y: Scales up the y-axis. 

 
Reset y: Resets scaling of the y-axis. 

 
Zoom Out y: Scales down the y-axis. 

 
Zoom Min / Max: Adjusts the min and span properties on the y-axis to ensure that all data  

is kept in the visible display area. "Empty" display areas are not adjusted. 

 
Zoom to Fit:  Adjusts the ranges of the y-axis to exactly fit all displayed data. "Empty" 

display areas are removed. 

 Save Plot: Saves the displayed channels in an ASCII file format. 

 
Snapshot: Takes a screenshot (*.wmf, *.bmp, *.jpg) of the display. 

 
Markers: Shows markers for data points only, without connecting line.  

(scatter graph) 

 
Trace:  Shows connecting lines between collected data points. 

 
Markers + Trace:  Shows markers and connecting line. 

 
Straight Line 
Mode: 

Data points are connected with straight lines. This option is available 
only if either the Trace or Marker + Trace option is active.  

 
Horizontal Step 
Line Mode: 

Data points are connected by a horizontal "step" connection. A step 
connection is constructed by connecting each data point at a right angle. 
The initial line for each data point is horizontal. This option is available 
only if either the Trace or Marker + Trace option is active. 

 

Note: The Save and Snapshot commands are not available during data acquisition / replaying. 
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Note: In general, all buttons apply only to the displayed channels. If, for example, 64 channels  
are displayed, moving and zooming of the axes will apply to all channels. If, on the other hand,  
a single channel was zoomed to it's full size by double-clicking it, all toolbar buttons would 
correspond only to this particular channel. You can apply the settings to all channels by clicking 
the Apply to All button. 

Zooming a channel 

All available channels are shown in the parameter display to provide an overall view of the 
ongoing activity. 

 Simply double-click a channel to have a closer look at it. 
The magnifying-glass icon on the top left indicates that you are in zoom mode. The channel 
number is displayed in the display. 

 Double-click the zoomed channel again to restore the overall view. 

Scrolling back and forward 

You can scroll the data forward and backward along the time axis. You are able to look  
for a region of the plot that you are interested in and snapshot the displayed region. 

 On the toolbar, click  to scroll backward and  to scroll forward. 

 Click  to jump to the beginning of the plot. 

 Click  to jump to the end of the plot. 

Scaling the axes 

You can scale the x- and y-axis up and down independently. The left button array on the toolbar 
corresponds to the x-axis and the right button array to the y-axis.  

 Decide which axis you like to scale and click the corresponding button  to zoom the plot  

in and  to zoom it out. The display will be updated accordingly. 

 To reset the scaling of the x-axis to the set ranges, click . 

 Likewise, click  to reset the scaling of the y-axis. 

Measure tool options 

The measure tool allows the user to measure data values in the Parameter Display and Spike 
Parameter Display. The default cursor is a vertical bar with a label showing the x and y value  
of the intersection point with the data trace. There are several advanced features as described  
in the following. 
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 Move the mouse pointer over the clamp control cursor / measure tool until the mouse pointer 
becomes a hand and then press the right mouse button to show the options. 

 

 

Channel Switch between the y value channels. See the Data tabbed page  
of the Spike Parameter display for available channels. 

Style  Value x-y Default option. Label shows x and y values of intersection point. 

Value x Label shows only x value of intersection point. 

Value y  Label shows only y value of intersection point. 

Period Label shows the value of the x distance between the two vertical  
bars. 

Peak-Peak Label shows the value of they y distance between the two  
horizontal bars. 

Frequency Label shows the value of the x distance between the two vertical  
bars as a frequency in Hz.  

Options Hide hint on 
release 

 

The cursor label is displayed only when the mouse pointer rests  
on the cursor and the left mouse button is pressed. 

 Use Channel 
Color 

The measure tool has the same color as the graph. 

 Flip 
Alignment 

The alignment of the cursor label is flipped from left to right  
and vice versa. 

Snap to 
Data 
Point 

The measure tool snaps to the next data point. 
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4.15.8 ASCII Export of Extracted Parameters 

Click  to save the complete data streams of the displayed channels as a tab-delimited ASCII file 
(text without formatting). You may then send this data to an editor or to your custom analyzing 
software, for example. ASCII export is possible with all four parameter plot types. 

Exporting data is only possible when you have stopped the data acquisition / Replayer.  
The Save button will then reappear on the toolbar. 

The created file has the following structure. The screen shot shows an exported parameter  
Trace plot opened with a standard spreadsheet program. 

 

 The header of the ASCII table shows the channel numbers, the parameter type  
and the measuring units. 

 The first column contains the time axis values. 

 The following columns contain the analyzed parameter values. 

 The format is tab-delimited ASCII, so that the file can easily be loaded into other applications. 

Note: Only the channels shown on the display are saved. If you want to save all channels in  
a single file, press the Save button when all channels are displayed. If you want to save the 
parameter values of a single channel only, zoom this channel and then press the Save button. 

4.15.9 Image Capture 

You can take a screen shot of the Parameter Display. On the display toolbar, click the Snapshot 

button  to take screen shots of the displayed channel(s).Each channel is captured separately 
with only one click. The file name is extended by the channel number. 

The pictures are screen shots that means that the resolution of the output file resembles the 
screen resolution, that is, 72 dpi. If you then print the image with a 300 dpi resolution, the size  
of the image will be reduced accordingly. Therefore, you should expand the display as much as 
possible to obtain a big image with a good printing quality. The higher resolution you need,  
the bigger has to be the display. 

The following image file formats are supported. 

 (*.emf), Enhanced Meta File format 

 (*.bmp), Bitmap 

 (*.jpg), JPEG 

Note: Only the channels shown on the display are captured. If you want to save all channels,  
use the image capture tool when all channels are displayed. If you want to capture a single 
channel only, zoom this channel and then press the Snapshot button. 
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4.16 Averager 

4.16.1 Averaging Data Sweeps 

The Averager adds up triggered sweeps successively. You can use the Averager to reduce the 
noise level and to enhance your signals, for example, to detect field potentials or for evoked 
potential analysis. 

Noise usually stems from arbitrary signals, where "real" signals should follow a pattern, that is, 
the signal event is linked to a stimulus or a trigger signal. Therefore, the added up noise signals 
cancel each other out and the response signals become visible. Be aware of the fact, that you  
also will enhance artifact signals that are linked to the trigger event for any reason. 

The Averager works only in a triggered mode. It adds up triggered sweeps successively until 
either the preset numbers of sweeps has been reached, or the reset condition becomes active  
and restarts the Averager. That means the following. The first plotted sweep shows original data. 
The second sweep represents the sum of the first and second sweep. The third sweep adds up the 
first three sweeps, and so on, until either the reset condition becomes active, or the set number  
of sweeps has been reached. The window extent of a sweep is specified on the Settings tabbed 
page of the Averager. 

You can average Electrode Raw Data, Analog Data, and Filtered Data. 

 If you replay triggered data, use the trigger that you used for recording the data file.  
If you average online, or continuously recorded data, you have to set up an Averager Trigger. 
For more information about defining triggers, please refer to "Triggering MC_Rack". 

 You can specify the number of sweeps that will be averaged. For example, you can apply  
a stimulus 100 times and average all sweeps. When the set sweep number has been reached,  
the last sweep is saved (in recording mode). In addition to the averaged data stream, a trigger 
data stream is created (Avg Trigger). This trigger event is the time point of the last sweep.  
This means, if you replay the file, you should start a Display (or any other tool) for processing  
the averaged data on this trigger event. 

 You can define a Reset Trigger that restarts the Averager (Reset Trigger). For more 
information about defining triggers, please refer to "Triggering MC_Rack". 

 You also can manually restart the Averager by clicking Reset. 

Note: The maximum refresh rate of the Averager is determined by the window extent selected  
on the Settings page of the Averager. You should make sure that the window extent corresponds 
to the expected maximum trigger event rate. Example: If you have trigger events at a 10 Hz rate, 
that is, at a 100 ms trigger interval, but the window extent is set to 200 ms, the Averager will miss 
every second event. 
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Note: When recording averaged data, you can save the data only continuously. The averaged  
data stream is recorded "triggered", that means, only the last sweep of the set sweep numbers  
is saved. For example, if you set the sweep number to 100, every 100th averaged sweep is saved.  
If you stop the recording or restart the Averager before the last sweep has been reached,  
no data will be saved at all. 

4.17 Sound Output 

4.17.1 Sound Output with MC_Card 

You can convert signals from one channel into sound. A computer with a sound card and speakers 
or headphones is required. You can use this feature to make Electrode Raw Data hearable, for 
example, or to replay recorded sound. Analog Raw Data, Electrode Raw Data, and Filtered Data 
can be converted into sound. 

You can use an analog channel as a sound input and record any sounds or voice. Thus you can  
add spoken commentary to document the recorded data. Please note that microphones do not 
generate enough voltage to directly connect them to the analog inputs. You need to use some 
kind of amplifier that adapts the output voltage of the microphone to the input voltage range  
of the MC_Card. 

Note: You can add only one Sound instrument to your rack, and you can convert only one channel 
into sound. The sound output is NOT real time. 

Click the "Sound" icon   in the main menu toolbar. The sound device is added in the virtual 
tree view pane. Click "Sound" tab. 
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4.17.2 Audio Out with USB-ME Data Acquisition 

Using a MEA2100-System or an USB-ME device you can additionally transfer electrode activity 
into sound with the "Audio Tool" feature. You can convert signals from one channel into mono 
sound, and signals from two channels into stereo sound. In contrast to the sound audible with the 
usual "Sound" output, the sound of the signals generated with "Audio Tool" are in real time. The 
sound is audible during data acquisition. It is possible to convert Electrode Raw Data and Analog 
Raw Data into sound, but it is not possible to add spoken commentary. 

Add a MEA2100-System, an USB-ME64-, an USB-ME128- or an USB-ME256-System in Data source 
setup. In Virtual Device Configuration choose "1x64, 1x128 or 1x256". Click "Audio" tab.  

Connect the "Audio OUT" of the rear panel of the USB-ME device with an audio system or with 
the speakers of the computer. For more information, please refer to the USB-ME-System manual. 

 

Select "Mono" for converting signals of one electrode channel into mono sound. The dialog will 
be adapted immediately. Select "Stereo" for converting signals of two electrode channels into 
stereo sound. Select the desired electrodes from the "Left Channel" and "Right Channel" drop 
down menu. Drag the slider to adjust the volume. The Audio Out also can be used as a real-time 
Analog Out to transfer the data of up to two channels in analog form to other applications. 

It is possible to add the usual sound output as well. Click the sound icon  in the main menu 
toolbar. 
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5 Data Export 

5.1 About Data Export 

The data acquisition and analysis program from Multi Channel Systems MC_Rack provides tools  
for a user friendly online and offline analysis of basic parameters like peak-to-peak amplitudes, 
spike rates, and so on. For more advanced analysis methods like tetrode analysis, or analyzing 
sorted spikes, you can easily transfer your data files to external analysis programs. Several free  
or commercially available programs support data files generated with MC_Rack (*.mcd files).  
For all other programs, the add-on program MC_DataTool conveniently exports MC_Rack data 
files to universal file formats like ASCII (*.txt), binary format (*.raw), or Axon Binary File 
(*.abf). 

Unless otherwise noted, the mentioned programs are based on a Windows operating system.  
For more information, please refer to the corresponding documentation of the import filters of 
the mentioned programs. Please note that MCS cannot provide support for third party programs. 

Programs for offline analysis 

This table gives you an overview about the wide range of possibilities of further processing your 
data. The list of programs is not complete; and Multi Channel Systems does not intend to favor 
some programs over others. If you do not find your favorite graphing or analysis program in this 
chapter, please ask your local retailer or Multi Channel Systems whether this program would 
support data files generated with MC_Rack. Please note that the feature list may not be up to 
date. Please ask the provider or developer of the program of interest for more information. 

The file format column specifies the file format that can be imported into the program. In many 
cases, the original *.mcd file format is supported. 

For extracting graphs, for example, for presentations, you can use the Image Capture feature  
of the Parameter Display. If you like more features, Multi Channel Systems recommends to use  
a commercially available screen shot program, for example, SnagIt from TechSmith Corporation 
(www.techsmith.com). If you like to change the resolution or the color of the traces, for instance, 
you can export the data as ASCII either directly from the MC_Rack display or from the *.mcd data 
file with MC_DataTool and then import the ASCII file into the graphics program of your choice. 

Program License File format Signal type Data 
source 

Application 
Neuro 

Application 
Cardio 

MeaTools Freeware .mcd 
(MC_Rack) 

Spikes, 
field 
potentials, 
cardiac 
signals 

MEAs Analysis, for 
example spike 
sorting, PSTH, 
correlational 
analyses, 
min/max, 
differentials, 
statistics, 
principal 
component 
analysis, 
 clustering 

3-D movie of 
wave 
propagation, 
local 
activation 
time 
mapping, 
time delays 

Offline Sorter Plexon .mcd 
(MC_Rack) 

Spikes Single 
electrodes 
and 
tetrodes 

Spike sorting, 
tetrode 
analysis 

 

Spiker Freeware binary 
(MC_DataTool) 

Spikes Tetrodes Spike sorting, 
tetrode 
analysis 
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Spike2 CED .mcd 
(MC_Rack) 

Spikes, 
field 
potentials 

 Analysis, for 
example spike 
sorting, PSTH, 
correlational 
analyses, 
filters, tetrode 
analysis, 
waveform 
analysis 

 

 

NeuroExplorer Nex 
Technologies 

.mcd 
(MC_Rack) 

Spikes, 
event data 

 Statistical 
analysis, for 
example PSTH, 
correlational 
analyses, 
histograms, 
rasters, activity 
graphs and 
maps, 

interspike 
intervals, burst 
analysis, 
principal 
component 
analysis 

 

CMC Tools University 
Freiburg 

.mcd 
(MC_Rack) 

Cardiac 
signals 

MEAs  QT duration, 
signal 
frequency, 
RR interval 

Mini Analysis 
Program 

Synaptosoft 
Inc. 

ABF 
(MC_DataTool) 

  Event based 
analysis, for 
example, spike 
detection, 
field 
potentials, 
statistics, 
digital filters, 
mathematical 
operations, 
histograms 

Event based 
analysis, for 
example, 
detection of 
waveform 
patterns like 
QT, inter-
spike-interval 
(beating 
rate), 
statistics, 
digital filters, 
mathematical 
operations, 
histograms 

Excel Microsoft ASCII Parameters  Graphing, 
general 
statistics 

Graphing, 
general 
statistics 

Origin (and 
similar 
programs) 

OriginLab ASCII All  Graphing, 
general 
statistics 

Graphing, 
general 
statistics 

AxoScope Axon ABF 
(MC_DataTool) 

Raw data Up to 16 
electrodes 

Mathematical 
transformation 
of data, 
cursor-related 
measurements, 
report sheets 

 

DataAccess 
Pro 

Bruxton .mcd 
(MC_Rack) 

All  Export filters 
for other 
programs 

Export filters 
for other 
programs 
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5.2 Graphs for Presentations 

5.2.1 Low Resolution Pics (Screen Shots) 

 You can use the Image Capture feature of the Parameter Display for a basic picture of the 
displayed channels. 

 If you want to make a screen shot of the complete program window, you can use the built-in 
snapshot feature of the Windows operating system (press ALT + PRINT SCREEN for copying the 
active program window or PRINT SCREEN alone for the complete screen content). These keyboard 
shortcuts copy the window content as a bitmap graphic to the clipboard, and you can then paste 
the graphic into your custom graphics program. 

 If you like more features, Multi Channel Systems recommends to use a commercially available 
screen shot program, for example, Snagit from TechSmith Corporation (www.techsmith.com).  
This method for acquiring graphic material is very easy to use and sufficient for most applications. 

Screen shots always have the resolution of the screen you use (generally 72 dpi). This resolution  
is fine if the output medium is on screen, too, for example, for Power Point presentations or web 
sites. 

If you need pictures with a higher resolution for printed documentation, you can drag the display 
as big as possible on your screen and then resize the picture afterward with the screen shot or 
graphics program of your choice. Note that 150 dpi is fair enough for most common printers.  
You will not see the difference if you use a higher resolution. You will only need higher resolution 
pictures for offset printing. 

Remember that you can change the color of raw data traces, if you like, before making the screen 
shot. 

Example: 

If you need a picture with a resolution of about 150 dpi, you can enlarge the display to double its 
size and then take a screen shot of the display. Then, you resize the picture to half its size. Make 
sure that you only modify the size, and not resample the picture (which would keep the resolution 
and simply make the image smaller). The picture has now the double resolution (= 144 dpi). 

5.2.2 Working with Graphics Programs 

For most applications, screen shots have a sufficient quality and size. If you need higher quality 
pictures for offset printing or a bigger size of the picture than your screen allows, or if you like  
to modify the graph like changing the background color, and so on, you will need a graphics 
program. There are several programs for scientific applications that allow creating nice graphs 
like Origin from OriginLab Corporation (www.originlab.com), and also several programs for 
designers like Adobe Illustrator, and spreadsheets like Microsoft Excel. 

MCS does not recommend specific programs; it is up to you and your needs which programs you 
prefer. For small graphs with only a few data points (for example parameter plots), graphics 
programs for designers or spreadsheets are fair enough. You may have more control on the 
design of the graph with these programs as well. But for raw data or plots with many data points, 
scientific graphing software like Origin is strongly recommended, because most graphics and 
spreadsheet programs allow only a limited number of data points, 32000 for example. If you use a 
sampling rate of 25 kHz, for example, this means that a raw data stream of a length of only about 
1 second (1.28 second) exceeds this limit! Also, most programs are slowed down if you enter a lot 
of data points, because they have not been designed for handling this amount of data. So make 
sure that the program you are going to use is meant to handle the data you like to show. 

The mentioned programs and most other allow ASCII import. MCS recommends to export  
the data as ASCII either directly from the MC_Rack display or from the *.mcd data file with 
MC_DataTool and then import the ASCII file into the graphics program for creating and 
designing the graph. 
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You can also use the commercially available program DataAccess Pro from Bruxton 
(www.bruxton.com) to open * .mcd files directly and import data streams into several scientific 
graphing and analysis programs. 

5.3 Extracting Spikes 

5.3.1 Spike Sorting 

MEATools and Matlab for data recorded from MEAs 

Prof. Dr. Ulrich Egert from the university in Freiburg, Germany, has designed the MEATools 
(www.brainworks.uni-freiburg.de) based on Matlab for analyzing MC_Rack data files recorded 
from microelectrode arrays (MEAs). MEATools is available for free and has a graphical user 
interface. It is not as easy to use as most commercially available programs, of course. It is especially 
useful if you are interested in programming Matlab routines yourself. MEATools is a collection of 
useful tools for analyzing spikes and field potentials. 

With MEATools, you can sort spikes based on identical principal components, estimate the spike 
rate based on moving window rate estimation, calculate PSTH and dot displays, and calculate 
burst rates and burst positions. 

You can sort spikes based on clustering: 

 Pair wise projections of the principal components and spike minima vs. each other (calculated 
individually from the spikes on each electrode) 

 Projections of the spike minimum vs. time 

 Scaling factor of the mean spike cutout 

You can review the clusters with different colors for spikes from different clusters, and review 
spikes colored for their cluster identity as cutouts against time.  

MEATools allows to open *.mcd files directly. In addition to Matlab version 5.3 or higher, you will 
need the MC_Stream.dll and MCStreamMEX.dll files installed on the computer from which you 
want to run the MEATools. All required files except Matlab are delivered with MC_Rack. Please 
see the documentation in the MCStreamSupport subfolder of the MC_Rack program folder  
for more information. The Common Program Files folder (for example c:\Program Files 
(x86)\Common Files\Multi Channel Systems\) contains the MC_Stream.dll; the Matlab  
subfolder contains the other files that are needed for using the MEATools. 

Offline Sorter for single electrode or tetrode recordings 

Offline Sorter is a commercially available program from Plexon (www.plexoninc.com) for sorting 
spike waveforms collected either from a single electrode or tetrode. The sorting is based on  
a 3-D principal component algorithm. Offline Sorter supports raw data and spike data streams 
from *.mcd files. 

Tetrode analysis with Spiker 

Spiker is a free program with graphical user interface from a research group at the University of 
California, San Francisco, USA (http://millerlab.ucsf.edu/Software/Spiker/spiker.html) for viewing 
and interactive clustering of tetrode (multielectrode) recordings. 

You can load raw data files generated with MC_Rack in a binary file format with Spiker.  
Use the MC_DataTool to convert MC_Rack data streams into binary file format. 

Spike2 for spike sorting and tetrode analysis 

Spike2 is a commercially available spike analysis program with a graphical user interface and 
scripting language from Cambridge Electronic Design Limited (www.ced.co.uk). 
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Spike2 automatically creates templates from raw spike data based on user-defined parameters. 
Spike2 can cluster spike data using principle component analysis or user-defined spike waveform 
measurements. Clusters can be formed automatically with the K-means algorithm or by cutting 
clusters manually using ellipses. 3-D rotation of clusters and replay of activity enables better 
viewing of cluster formations. 

Spike2 allows to open *.mcd files directly. 

5.3.2 General Spike Analysis 

Spike2 

Spike2 is a commercially available spike analysis program with a graphical user interface  
and scripting language from Cambridge Electronic Design Limited (www.ced.co.uk). 

Waveform analysis includes averaging, power spectra, waveform discrimination and 
measurements of areas, spike sorting and clustering, means, gradients, RMS amplitudes, SD etc, 
based on cursor positions or automatic feature detection. Event processing includes INTH, PSTH, 
rasters, sorted rasters, filtering options, and event correlations. 

Spike2 allows to open .mcd files directly. 

NeuroExplorer (NEX) 

NeuroExplorer is a commercially available program with a graphical user interface from Nex 
Technologies (www.neuroexplorer.com) for analyzing neurophysiological data. It features 
standard histogram, raster, and correlational analyses for both point events (for example spikes, 
behavioral events) and continuous variables (e.g. field potentials), joint PSTH, burst analysis and 
many more analysis options and functions. It is available from local distributors for MCS products. 

5.4 Analyzing Cardiac Signals 

5.4.1 Wave Propagation 

Exporting spike rates or spike event times to Excel or Origin 

For analyzing the contraction rate and spatio-temporal patterns of arrhythmia, the MC_Rack Spike 
Sorter and Analyzer are usually sufficient. You can then extract the spike rate or the spike events 
directly from the display or with the MC_DataTool and import them into Excel or Origin. Basic 
two-dimensional false color plots are also supported by MC_Rack. 

MeaTools and Matlab for data recorded from MEAs 

For more detailed analysis or graphics, like more advanced false color or delay contour plots, 
3-D movies of the propagation, local activation time mappings, or analysis of time delays, 
you can use the free MEA Tools. 

Prof. Dr. Ulrich Egert from the University of Freiburg, Germany, has designed the MEATools 
(www.brainworks.uni-freiburg.de) based on Matlab for analyzing MC_Rack data files recorded 
from microelectrode arrays (MEAs). MEATools is available for free and has a graphical user 
interface. It is not as easy to use as most commercially available programs, of course. However,  
it is especially useful if you have interest in programming Matlab routines yourself. MEATools  
is a collection of useful tools for analyzing spikes and field potentials. 

MEATools allows to open “*.mcd” files directly. In addition to Matlab version 5.3 or higher,  
you will need the MC_Stream.dll and MCStreamMEX.dll files installed on the computer from 
which you want to run the MEATools. Both files are delivered with MC_Rack. Please see the 
documentation in the MCStreamSupport subfolder of the MC_Rack program folder for more 
information. 
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5.4.2 Waveform Shape and QT-like Interval 

For drug screenings, the analysis of the waveform, especially of the field potential duration,  
is of main interest. The field potential duration corresponds to the action potential duration,  
that is, the QT interval in an electrocardiogram. It is generally measured from minimum of the 
Na+ peak to the maximum / minimum of the IKr current peak. 

Matlab based Cardiomyocyte Toolbox (CMC Tools) 

This toolbox programmed by Prof. Dr. Ulrich Egert (www.brainworks.uni-freiburg.de) from  
the University of Freiburg, Germany, allows an automated detection of the Na+ peak to the 
maximum / minimum of the IKr current peak, and thus automates the measurement of the  
field potential duration, the QT-like interval. Also, the RR interval, and the signal frequency 
can be analyzed. 

The CMC Tools are based on Matlab, and are commercially available under licence of the 
University Freiburg. Please contact Prof. Dr Ulrich Egert for details. 

Mini Analysis Program (Synaptosoft Inc.) 

The commercially available program Mini Analysis Program analyzes signal events and time stamps,  
for example, the automated detection of the Na+ peak and the extraction of the inter-spike-
interval, providing information on the signal frequency and on arrhythmies, or the extraction  
of the QT-like interval. 

You can convert the recorded MC_Rack file into the ABF format and then load it directly into  
Mini Analysis Program. 

 

5.5 Extracting Parameters 

5.5.1 Exporting Parameter Streams to Excel 

You can use the ASCII export features of the MC_Rack displays or of MC_DataTool to  
export parameter streams to an ASCII file and then import the ASCII file to Microsoft Excel. 

You can also use the commercially available program DataAccess Pro from Bruxton 
(www.bruxton.com) to open .mcd files directly and import data streams into Excel. 

 

5.6 MC_DataTool 

5.6.1 About MC_DataTool 

MC_DataTool is an add-on program exporting data retrieved with the MC_Rack program. With 
MC_DataTool, you can fast and conveniently convert MC_Rack data files (*.mcd files) into other 
file formats. 

Supported are the following input data streams: Electrode Raw Data, Analog Raw Data, 
Filtered Data, Spikes, Parameter, Trigger, Digital Data. Specific traces can be selected and 
saved for further processing as an Axon Binary File (*.abf), an ASCII file (*.txt), or a binary file 
(*.raw). The Averager input stream can be saved as ASCII file only. 
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6 Troubleshooting 

6.1 Technical Support 

Please read the Troubleshooting part of the MC_Rack Manual / Help first. Most problems are 
caused by minor handling errors. Contact your local retailer immediately if the cause of trouble 
remains unclear. Please understand that information on your hardware and software 
configuration is necessary to analyze and finally solve the problem you encounter. 

If you have any questions or if any problem occurs that is not mentioned in this document, please 
contact your local retailer. A list of local retailers for MCS products can be found on the MCS web 
site. http://www.multichannelsystems.com. The highly qualified staff will be glad to help you. 

Please keep information on the following at hand 

 Description of the error (the error message text or any other useful information) and of the 
context in which the error occurred. Try to remember all steps you had performed immediately 
before the error occurred. The more information on the actual situation you can provide, the 
easier it is to track the problem. 

 The serial number of the MC_Card. Click Data Source Setup on the Edit menu to display the serial 
number. 

 The MC_Rack software version you are currently using. On the Help menu, click About.  
The displayed dialog box shows the version number. 

 Your operating system (Windows 7, Vista or XP). 

 The hardware configuration (microprocessor, frequency, main memory, hard disk) of the 
connected computer. This information is especially important if you have modified the delivered 
computer or installed new hardware. 

 Any programs that you have installed on the data acquisition computer. 

 Other instruments connected to the data acquisition computer, like amplifiers, stimulators, 
temperature controllers. 

The Multi Channel Systems User Forum provides the opportunity for you to exchange your 
experience or thoughts with other users worldwide. 

If you have subscribed to the General Electrophysiology Mailing List, you will be automatically 
informed about new software releases, upcoming events, and other news on MCS products.  
You can subscribe to the list on the contact form of the MCS web site. 
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6.2 Error Messages 

6.2.1 Computer Performance 

 

Performance limit messages occur if the computer performance does not support the current 
rack configuration. The more virtual instruments (especially displays and digital filters) you use, 
the higher is the CPU usage. Open the Windows Task Manager and watch the CPU usage.  
Try the following. 

 Do not run any programs (especially no virus scanning program or firewall) in parallel on the  
data acquisition computer. Check that MC_Rack is the only active application in the Windows  
Task Manager. Close all other applications if not. 

 Switch off the Peak Detection in the displays. 

 Remove any unused virtual instruments or displays. 

 Select only the channels of interest for recording and online analysis. 

 Use a lower sampling rate. For most signals, 25 kHz is fine. For slower signals like field potentials 
or cardiac signals, you may even use lower sampling rates like 10 kHz. 

 If you are using the spike detection feature in Threshold mode, check the spike detection level 
on all channels. If the threshold on a noisy but unattended (i. e. not shown in the Spike Sorter 
display) electrode is set too low, all the noise signals recorded by this electrode are detected as 
spikes and this will lead to a high CPU usage. Please remember that the display layout is 
independent from the electrodes that are selected for spike extraction. 

 If this does not help, consider recording the raw data and doing offline analysis. 

 Some Windows services are also known to cause performance limits or program instabilities.  
They were turned off by the manufacturer. You may want to confirm their status if you observe 
problems with unknown cause. Please see Installing MC_Rack for details. 
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6.2.2 Replayer 

 

Occurs when a rack file is opened and the file path of the data file loaded into the Replayer  
is not valid. The Open dialog box will open automatically. Please select an appropriate data  
file (*.mcd) and click Open. The file name of the file that was loaded into the Replayer will  
be suggested to you. 

 

The data file that is linked to the Replayer in the current rack file is not compatible with the 
current rack configuration, for example, any channel is different or missing, or the data is 
triggered, but the rack was based on a continuous data file. This can happen when you overwrite 
or rename an existing data file, or when the file path of the data file loaded into the Replayer  
is not valid, and you open an incompatible data file instead of the original data file the rack was 
based on. Please create a new rack file, add a Replayer and load the desired data file again into 
the Replayer. 

 

Occurs when you try to load an incompatible data file into the Replayer of an existing rack file. 
Please create a new rack file, add a Replayer and load the desired data file again into the 
Replayer. 

 

Occurs when a Replayer rack is opened. The data file that was loaded into the Replayer was 
recorded after loading a background picture. The linked image file was either removed, renamed, 
or moved to another folder after recording. You can ignore the error message, or restore the file 
path as given in the error message if you want to load the background picture automatically 
together with the data file 

 



MC_Rack Manual 

178 

6.2.3 Recorder 

 

Occurs when the "Window Extent" setting in "Windows" tab of the Recorder is out of range. 
Please read chapter "Triggering MC_Rack on a Stimulus" for more information about "Window 
Extent" settings. 

 

6.2.4 Running more than one instance of MC_Rack in parallel 

 

When using more than one instance of MC_Rack in parallel an error message will be displayed  
if the user tries to open more than the defined numbers of instances of MC_Rack. 

 

6.2.5 Hardware Errors 

Hardware error #5, 
hardware error #6 

An incompatible processor was installed onto the data 
acquisition computer. Please contact your local retailer 
for further assistance. 
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6.3 Data is not Written to Hard Disk 

You started the recording by pressing the Start button. You see the recorded data in the 
MC_Rack displays, but no data is written to the hard disk. 

Possible causes: 

? The red Record button was not pressed in. MC_Rack was designed like a tape deck. You can start 
and stop the recording without writing data to the hard disk, for example, if you want to do some 
test recordings, or if you want to wait until the activity of the brain slice has reached the baseline 
level. Data files are generated only when the red Record button is activated. 

1. Stop the recording. 

2. Make sure the red Record button is pressed in and start the recording again. 

 

? The hard disk is full. MC_Rack may stop to respond in this case. 

 Make a backup copy of the data files on your hard disk, and delete data on the disk until enough 
disk space is available before you restart the recording. 

 Empty the Recycle Bin of the Windows operating system on a regular basis. 

6.4 Channels Not Visible or Available 

Analog channels not visible in Data Display 

An analog signal is applied to one of the additional analog inputs. You started the recording  
by pressing the Start button, but you do not see the analog raw data stream in the display. 

Possible causes: 

? The Analog Raw data stream was not selected for the display. The display graphs only the data 
streams that were assigned to it. 

1. In the tree view pane of the virtual rack, select the Data Display. 

2. Click the Data tabbed page and select the Analog Raw data stream. 

? The selected channel map does not support the analog channel of interest. 

Similar to other virtual instruments in MC_Rack, displays do not recognize active channels by 
themselves, but you have to set up a channel map for each display separately. A channel map 
defines the layout in which the channels of a display appear, that is, information about the 
channel numbers and their positions. There are several standard maps provided in the MC_Rack 
program folder, for example the 8x8 MEA layout, but you can set up and save your own custom 
maps as well. That means, to display for example the additional analog channel A2, you need  
to set up a channel map that includes channel A2. Channel A1 is already preconfigured in the 
standard "8x8mea.cmp" channel map. For more information on how to set up a channel map, 
please see Setting Up a Display Layout in the MC_Rack Features section. 

? The y-axis range is not suitable for the displayed data. 
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Signals on the analog channels are recorded "as is", with no respect to the gain specified in 
MC_Rack, as the true gain is generally completely different on the electrode inputs and on the 
additional analog inputs. Therefore, you generally need different y-axis ranges (and therefore 
separate displays) for seeing the data traces in an appropriate scale. 

Only 64 channels of a 128 channel MC_Card available 

After a new installation of MC_Rack or of the MC_Card, only the first 64 channels (or MEA A)  
are visible in the displays or on the channel selection pages of the virtual instruments, though  
the Hardware tabbed page of the MC_Card confirms 128 channels. 

Possible causes: 

? The data source setup was configured for a 64-channel system. 

1. On the Edit menu, click Data Source Setup. 

Configure the setup according to your hardware setup. For example, for a MEA 120-System,  
select 2 dim. (MEA). For more information on the data source setup, see Data Source Setup  
in the MC_Rack Features section. 

? The selected channel map does not support the channels of interest. 

Displays in MC_Rack do not recognize active channels by themselves, but you have to set up  
a channel map for each display separately. A channel map defines the layout in which the 
channels of a display appear, that is, information about the channel numbers and their positions. 
There are several standard maps provided in the MC_Rack program folder, for example the  
8x8 MEA layout, but you can set up and save your own custom maps as well. That means,  
to display for example the electrode channels of the second MEA B, load the preconfigured  
channel map"8x8meaB.cmp". For more information on how to set up a channel map, please  
see “Setting Up a Display Layout” in the MC_Rack Features section. 
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7 Appendix 

7.1 Contact Information 

Local retailer 

Please see the list of official MCS distributors on the MCS web site. 

User forum 

The Multi Channel Systems User Forum provides the opportunity for you to exchange  
your experience or thoughts with other users worldwide. 

Mailing list 

If you have subscribed to the Mailing List, you will be automatically informed about  
new software releases, upcoming events, and other news on the product line.  
You can subscribe to the list on the MCS web site. 

www.multichannelsystems.com 
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8 Glossary 

A 
aliasing: Frequencies (noise) that are above half the sampling rate (for example above 2.5 kHz  
at a 5 kHz sampling rate) will be transformed into lower frequencies. 

anti-aliasing: Using an analog Low Pass filter for removing high frequency noise, which would 
lead to aliasing if a sampling frequency lower than twice the bandwidth of the input signal is 
used. 

B 
Bandstop Resonator: In signal processing, a bandstop filter is a filter that passes most 
frequencies unaltered, but attenuates those in a specific range to very low levels. A bandstop 
filter with a high Q factor has a narrow stopband. 

Bessel Filter: A Bessel filter is a type of linear filter with a maximally flat group delay (maximally 
linear phase response). Analog Bessel filters are characterized by almost constant group delay 
across the entire passband, thus preserving the wave shape of filtered signals in the passband. 

bit: A bit is a binary digit, taking a value of either 0 or 1. The digital data stream of the MC_Card 
has 16 input and 16 output bits. A single bit can be used, for example, to trigger the recording 
(based on a TTL output of a stimulator) or an external device. Multiple bits can be used to set up 
more complex trigger patterns (where several requirements need to be met) or to encode a 
decimal number, for example, from an external measuring instrument. In a number, bits are 
always counted starting with 0, i. e. the 16 bits are numbered from 0 to 15. 

Bitmap (BMP): Standard Windows bitmap image format, file extension *.bmp 

Butterworth Filter: The Butterworth filter is one type of filter design. The frequency response  
of the Butterworth filter is maximally flat (has no ripples) in the passband, and rolls off towards 
zero in the stopband. For a second-order Butterworth filter, the response decreases at -12 dB per 
octave. 

C 
Chebyshev Filter: Chebyshev filters are analog or digital filters having a steeper roll-off than 
Butterworth filters. Chebyshev filters have the property that they minimize the error between  
the idealized filter characteristic and the actual over the range of the filter, but with ripples in  
the passband. Because of the passband ripple inherent in Chebyshev filters, filters which have a 
smoother response in the passband but a more irregular response in the stopband are preferred 
for some applications. 

continuous recording: Opposite of triggered recording. Recording is started once and the data 
is saved continuously to the hard disk until the recording is stopped. Note that a triggered data 
analysis or display (online or offline) is possible independent of the recording mode. 

D 
Device Independent Bitmap (DIB): Windows clipboard format, file extension *.dib. 

Digital Data: The Digital Data stream is the input data stream from the 16-bit digital input of the 
MC_Card. In a standard MEA- or ME-System, only three of the 16 digital input bits are available 
via BNC connectors. A digital in/out extension is available as an accessory for accessing all 16 input 
and output bits. The Digital Data stream can only have values of 0 and 1. It can be displayed with 
the Digital Data Display. 

Downsampling: The downsampling feature offers the possibility to generate raw and filtered 
data streams with different sampling frequencies to avoid huge amounts of resulting data when 
recording more than one data stream. 



MC_Rack Manual 

184 

E 
Enhanced Meta File (EMF): Intermediate format for exchanging vector graphics data, file 
extension *.emf. 

EPSP: Excitatory postsynaptic potential, an electrical change (depolarisation) in the membrane of 
a postsynaptic neuron caused by the binding of an excitatory neurotransmitter from a presynaptic 
cell to a postsynaptic receptor. 

F 
fEPSP: Field excitatory postsynaptic potential 

G 
Graphics Interchange Format (GIF): Indexed-color bitmap graphics, LZW-compressed format 
designed to minimize file size, binary transparency, file extension *.gif 

H 
High: Logical active state of a bit, also known as state 1 or On. For TTL pulses, a High state means 
a voltage level of usually 5 Volts. 

high pass filter: A filter that passes high frequency waveforms. For example, a 300 Hz high pass 
filter passes spikes, but no LFPs. 

I 
ICO: Bitmap format used for Windows icons (in programs and on desktop), file extension *.ico. 

J 
Joint Photographic Experts Group (JPEG): Bitmap format, compressed by selectively discarding 
data, no transparency, file extension *.jpg. 

L 
LFP: Local Field Potentials are sum field potentials of the activity within a volume of tissue. The 
amplitude reflects the number of active neurons that are contributing to the LFP. In comparison 
with single spiking activity, it is a lower frequency signal. To obtain only LFPs (without single 
spikes), a 300 Hz low-pass filter can be used. 

Low: Logical inactive state of a bit, also known as state 0 or Off. For TTL pulses, a Low state means 
0 Volts. 

low pass filter: A filter that passes low frequency waveforms. For example, a 300 Hz low pass 
filter passes LFPs, but no spikes. 

lower cutoff frequency: Between the lower cutoff frequency and the upper cutoff frequency  
of a frequency band is the resonant frequency, at which the gain of the filter is at its maximum. 
Signal components with a lower frequency than the lower cutoff frequency of a band pass filter 
are attenuated. 

LTD: Long Term Depression 

LTP: Long Term Potentiation 

M 
MB (megabyte): One megabyte is equal to 1,048,576 bytes, or 1,024 kilobytes. 
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O 
OTC: Organotypic Culture: An MEA experiment where the slice is cultured on the MEA for weeks 
or months, in contrast to an acute slice experiment. 

P 
peak-peak: Interval from maximum to minimum signal 

PPD: Paired Pulse Depression 

PPF: Paired Pulse Facilitation 

R 
Real-time Feedback: The real-time feature allows the user to generate TTL signals in response to 
defined signal patterns detected by one or several electrodes. These TTL signals in turn can control 
a stimulus generator (STG) to deliver feedback stimulation to the biological sample within a time 
frame of one millisecond after the actual event. 

ROI: Region of interest: In triggered operation mode, the Analyzer extracts parameters from  
a user-defined region of interest. 

S 
Savitzky Golay Filter: IThe parameters of the Savitzky-Golay filter are the order (2 or 4) and the 
number of points which are included from the right and the left side of a data point for averaging 
the calculated data point (2, 4, 8, 16, 32, 48). This filter can be used to smooth a noisy signal. 
However, it is possible to accidental filter out fast signals, like spikes. those in a specific range  
to very low levels. A bandstop filter with a high Q factor has a narrow stopband. 

spike: A field potential that is the extracellular representation of an action potential. The spike 
rate reflects the intensity of activity. In comparison with LFPs, it is a higher frequency signal. To 
obtain only spikes (without LFPs), a 300 Hz high-pass filter can be used. 

T 
triggered recording: A non-continuous recording of cutouts around a trigger event, for 
example, for recording evoked responses. The cutout size is selected in the Recorder. Note that 
the data in-between the cutouts is lost permanently. 

TTL: Transistor-Transistor Logic. Digital signal for communication between two devices. A voltage 
between 0 V and 0.8 V is considered as a logical state of 0 (LOW), and a voltage between 2 V and 
5 V means a 1 (HIGH). 

U 
upper cutoff frequency: Between the lower cutoff frequency and the upper cutoff frequency  
of a frequency band is the resonant frequency, at which the gain of the filter is at its maximum. 
Signal components with a higher frequency than the upper cutoff frequency of a band pass filter 
are attenuated. 

W 
Windows Meta File (WMF): Intermediate exchange format for 16-bit Windows applications, 
limited vector graphics support, file extension *.wmf.
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1 
1-dimensional 

data source setup .............................. 73 

2 
2-dimensional 

data source setup .............................. 73 

A 
Add Digital Output 130 

Advanced Configuration 23 

Aliasing 154 

Analog Raw Data 
about ................................................. 95 
additional analog channel ............... 23 
averaging ......................................... 185 
detecting triggers ........................... 125 
displaying ........................................ 118 
filtering ............................................ 146 
Plot Types (Data Display) ................ 118 
recording ......................................... 102 
triggering on ................................... 127 

Analyzer 
about ............................................... 172 
displaying parameters .................... 178 
extracting parameters .................... 173 
Maximum ......................................... 173 
Minimum ......................................... 173 
Number ............................................ 173 
Parameter Display ........................... 178 
Peak to Peak Amplitude ................. 173 
Rate .................................................. 173 
Slope ................................................ 173 
t-Max ................................................ 173 
t-Min ................................................ 173 

Analyzing 
spikes ............................................... 193 

Anti-aliasing 154 

ASCII Export 
about ................................................ 194 
ASCII export of displayed data ....... 117 
exporting overlaid traces ............... 118 
exporting parameter plots ............. 184 
exporting raster plot....................... 119 
exporting raw/analog data traces . 118 
of parameter streams ..................... 194 

Audio Tool 187 

Automatic mode 108 

Automatic Trigger 129 

Average 
analyzing mean value in time window
 .......................................................... 173 
Averager data streams ............... 95, 99 
Averager Trigger ............................. 185 
averaging sweeps ............................ 185 
Avg Trigger ........................................ 99 
extracting the mean ....................... 173 

recording averaged data ................. 99 
replaying averaged data .................. 99 

B 
Background 

Background Picture ........................ 116 
change display background color . 112 

Beating 
monitoring beating rhythm ........... 178 

Bin 
bin size ............................................ 177 

Binary 
binary data and code ..................... 101 

Bit 
binary data and code ..................... 101 
digital display .................................. 121 
numeric display ............................... 122 
triggering on input bits ................. 125 

Black 
reverse background color .............. 112 

Buffer Info 108 

Burst Analyzer 166 

Butterworth Low and High Pass filter149 

C 
Capture 185 

Channel Tool 35, 91 

Channels 
Channel Layout (Hardware) ............. 73 
Channel Map (Display) ................... 111 
Channel Selection (Instruments) ...... 97 
MC_Card settings .............................. 88 

Color 
Color Maps ...................................... 179 
Color vs. Time plot .......................... 180 
False Color plot ............................... 180 

Color vs. Time 180 

Configuration 9 

Coninuous 
Continuous Data ............................. 108 
recording ........................................... 98 

Cool color map 179 

Create new file 
create new files on trigger ............ 105 
creating data files ........................... 105 

Create new file on trigger 102 

Cutoff Frequency 146, 149 

D 
Data 

creating data files ........................... 105 
data file name and path ................ 105 
data stream types ............................. 95 
replaying data ................................. 108 

Data Display 
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Longterm Display .............................. 36 
plot types ......................................... 118 
settings ............................................ 112 

Data export 189 

Data Source Setup 
Configuration ...................................... 9 
setting up the data source ............... 73 
Simulation mode ............................... 93 

Dead Time 164 

Decimal number 101, 122 

Delay 
digital output .................................. 130 

Detection 
analyzing detection events ............ 178 
detecting spikes ............. 160, 162, 163 
detecting triggers ........................... 125 

Digital channel 
triggering on TTL pulses ................. 125 

Digital Data 
about ......................................... 95, 101 
displaying ........................................ 121 
triggering on TTL pulses ................. 125 

Digital Display 121, 122 

Digital Output 130 

Display 
about ............................................... 110 
ASCII Export ............................. 118, 119 
channel layout ................................. 111 
Color vs. Time .................................. 180 
custom display layout ....................... 36 
customizing display settings .......... 115 
Data Display .................................... 118 
decimal number ............. 101, 121, 122 
Digital Display ......................... 121, 122 
exporting pictures ........................... 190 
False Color ....................................... 180 
layout ................................................. 36 
loading a background picture ....... 116 
Longterm Display .............................. 36 
Number ............................................ 181 
Overlay ............................................. 118 
Parameter Display ........................... 178 
parameter trace .............................. 179 
Peak Detection ................................ 114 
Raster Plot ....................................... 119 
settings ............................................ 112 
spike detection ................................ 165 
spike sorting .................................... 165 

Downsampling 156 
cutoff frequency ............................. 156 
high pass filter ................................. 156 
low pass filter .................................. 156 
Nyquist-Shannon ..................... 154, 156 

Driver 
for MC_Card ........................................ 4 

E 
Electrode Raw Data 

about ................................................. 95 
analyzing ......................................... 172 
averaging ........................................ 185 
displaying ........................................ 118 
filtering ........................................... 146 
recording ......................................... 102 
spike detection ............................... 160 
spike sorting .................................... 165 
triggering on ................................... 127 

Event 
analyzing event rate and interval . 178 
event based analysis ....................... 172 

Event Marker 123 

Exporting 
about ............................................... 189 
MC_DataTool ................................... 194 

Extraction 
of parameters of interest ............... 172 

F 
False Color 179, 180 

Feedback 
digital output .................................. 130 

File 
data file location ............................ 105 
File Info ........................................... 108 
loading a data file .......................... 107 
replaying data files ......................... 108 
reuse existing file in multiple instances 
of MC_Rack ....................................... 23 
saving a data file ............................ 102 

Filter 
about ............................................... 146 
aliasing ............................................ 154 
anti-aliasing .................................... 154 
filter types ....................................... 149 
sampling rate .................................. 154 

Filter Types 149 
Bandstop Resonator ....................... 149 
Bessel 2nd Order ............................. 149 
Bessel 4th Order .............................. 149 
Butterworth .................................... 149 
Chebyshev 2nd Order ..................... 149 
HighPass / Low Pass ........................ 149 
Savitzky Golay ................................. 149 

Filtered Data 
about ................................................. 95 
analyzing ......................................... 172 
displaying ........................................ 118 
filter types ....................................... 149 
filtering data ................................... 146 
spike detection ............................... 160 
spike sorting .................................... 165 
triggering on ................................... 127 

Frequency 
sampling ............................................ 88 

G 
Graphs 



Index 

191 

for presentations ............................. 190 
high resolution ................................ 191 

Grouping 
Multitrode ......................................... 93 

Guided Tour 7 

H 
Hardware 

data source setup .............................. 73 
MC_Card settings .............................. 88 

High 
high pass filter ................................. 149 
logical state ..................................... 101 

I 
Image 

background picture ........................ 116 
image capture ................................. 185 

Input 
bits ................................................... 125 
data streams ...................................... 95 
voltage range .................................... 88 

Installation 
of MC_Card .......................................... 4 
of MC_Rack .......................................... 4 

Interspike Interval 178 

Interval 
automatic trigger ............................ 129 
interspike or RR interval ................. 178 

J 
Jet Color Map 180 

L 
Layout 

display layout .................................. 111 
Simulation mode ............................... 93 

Level 
spike detection level ....................... 162 
trigger detection level for triggering 
on a parameter ............................... 128 
trigger detection level for triggering 
on raw data ..................................... 127 

Linear fit 173 

Loading 
data into MC_Rack .......................... 107 
Load Image ...................................... 116 

Logic 101 

Low 
logical state ..................................... 101 
Low Pass filter ................................. 149 

M 
Manual Trigger 123 

continuous mode ............................ 123 
masking events manually ............... 123 

Mask 

masking digital input bits .............. 125 

Matlab 
using MC_Rack files ........................ 191 

Maximal sampling frequecy 23 

Maximum 173 

MC_Card 88 
data source setup ............................. 73 
triggering on TTL pulses ................ 125 

MC_DataTool 
about ................................................ 194 

MC_Rack 
multiple instances ............................. 23 

ME-System 
data source setup ............................. 73 

MEA Layout 36 
button ............................................... 36 
custom MEA layout .......................... 36 

MEA Signal Generator 7 

MEA-System 
data source setup ............................. 73 
MEA2100-System .................. 33, 73, 88 

MEA2100 
Data Source Setup ............................ 54 
Digital Channel Layout .................... 54 
Hardware Settings ............................ 54 
MEA2100-System .............................. 54 
Real-time Feedback .......................... 54 
Stimulus Generator........................... 54 

MEA2100-32System 9 

Mean 
extracting the mean ....................... 173 

MEA-SG 7 

MEATools 
using MC_Rack files ........................ 191 

Minimum 173 

Multiple 
multiple instances of MC_Rack ........ 23 

Multitrode 
analysis ............................................ 191 
grouping channels ............................ 93 

N 
Negative Slope 

trigger detection .................... 127, 128 

New 
data files .......................................... 105 

Number 
extracted parameters ..................... 173 
Number plot type ........................... 181 
Numeric Display .............................. 122 
of available channels ........................ 73 

Nyquist-Shannon 154 
 



MC_Rack Manual 

192 

O 
Offset 

defining a channel offset in channel 
maps for non-rectangular grids ..... 111 

Offset Correction 88 

On Trigger 105 

Oscilloscope 
Data Display .................................... 118 
Digital Display ................................. 121 
display types .................................... 110 
Parameter Display ........................... 178 

Overlay Mode 118 

P 
Parameter 

extracting interspike or RR interval178 
extracting signal rate ...................... 178 
triggering on a parameter ............. 128 

Parameter Display 
plot types ......................................... 178 
trace plot ......................................... 179 

Parameters 
about ................................................. 95 
Analyzer parameters ...................... 173 
extracting ........................................ 172 
plotting ............................................ 178 

Peak Detection 114 

Peak to Peak Amplitude 173 

Periodic 
generating time based trigger events
 .......................................................... 129 

Plot Types 
about ............................................... 178 
Color vs. Time .................................. 180 
False Color ....................................... 180 
Number Plot .................................... 181 
Overlay ............................................. 118 
Raster Plot ....................................... 119 
Trace ................................................ 179 

Positive Slope 
trigger detection ..................... 127, 128 

Post Trigger 
of spike cutouts ............................... 164 
recording triggered data ................ 102 
showing post-trigger times ............ 112 

Pre Trigger 
of spike cutouts ............................... 164 
recording triggered data ................ 102 
showing pre-trigger times .............. 112 

R 
Range 

of axes .............................................. 112 

Raster Plot 119 

Rate 
analyzing signal rate....................... 178 

display refresh rate ......................... 112 
sampling ............................................ 88 
spike rate ......................................... 173 

Raw Data 95 

Real-time Feedback 131 
And / Or option ............................... 131 
Digital hardware filter ................... 131 
DSP ................................................... 131 
feedback logic ................................. 131 
feedback stimulation ..................... 131 
Spike detection ............................... 131 

Record 102 

Recording 
Auto Stop ........................................ 105 
averaged data ................................... 99 
data in general ............................... 102 
Recorder settings ............................ 105 
Triggering Recorder ....................... 105 

Refresh 
display refresh rate ......................... 112 
refreshing spike detector ............... 162 

Region of interest 172 

Replaying data 
averaged data ................................... 99 
Replayer settings ............................ 108 
Replayer speed ................................ 108 

Reset 
Replayer .......................................... 108 

Reverse Display 112 

ROI 172 

RR Interval 178 

S 
Sampling 

aliasing ............................................ 154 
filtering ........................................... 154 
rate .................................................... 88 

Sampling frequency 23, 88 

Save 
saving averaged data ....................... 99 
saving data ...................................... 102 
saving data to hard disk ................. 105 
saving displayed data as ASCII ....... 117 
saving parameters as ASCII ............ 184 

Savitzky-Golay filter 149 

Screen shot 182, 185, 190 

Several MEAs 
channel layout ................................ 111 
data source setup ............................. 73 

Show Data Points 179 

Show Image 116 

Signal 
rate or interval ................................ 178 

Simulation 
enabling simulation mode ............... 93 



Index 

193 

File Source ......................................... 93 

Sine Waves 
Simulation mode ............................... 93 

Slope 
analyzing slope ............................... 173 
spike detection (slope) ................... 163 
spike detection (threshold) ............ 162 
trigger detection ............................. 127 

Snapshot 182, 185 

Sound 187 

Spike Analyzer 178 
about ............................................... 172 

Spikes 
about ................................................. 95 
analyzing ......................................... 193 
analyzing spike rate or interspike 
interval ............................................. 178 
analyzing spikes .............................. 173 
burst ................................................. 166 
exporting ................................. 191, 193 
overlaying spikes ............................. 118 
Raster plot ....................................... 119 
sorting .............................................. 191 
spike cutouts ................................... 164 
spike detection ................................ 160 
spike sorting .................................... 165 
spikeform ......................................... 165 
triggering on the spike rate ........... 128 

Spreadsheet 
exporting data ................................ 194 
exporting parameters ..................... 194 

Start 
on a trigger ..................................... 127 
recording on trigger ....................... 105 
Start and End on Trigger .................. 98 
Start on Trigger ................................. 98 
start time for triggered data ............ 98 
start time of replayer ...................... 108 

Statistics 
analyzing statistical parameters .... 172 

Step 
Single stepping through data file .. 108 

Stereotrodes 93 

STG 
internal STG of MEA2100-System .... 88 

Stimulation 88 

Stop 
Stop On Trigger ............................... 105 
Stop Time ........................................... 98 
stopping recording on trigger ....... 105 

Stop on trigger 102 

Sweeps 
averaging ......................................... 185 
overlaying ........................................ 118 
Raster plot ....................................... 119 
sweep number ................................. 108 

Synchronize 
recording ......................................... 105 

SyncOut 125 

T 
Tetrodes 

analysis ............................................ 191 
grouping channels ............................ 93 

Threshold 
spike detection ............................... 162 
trigger detection ............................ 127 

Time bin 172 

t-Max 173 

t-Min 173 

Trace Plot 110, 118, 179 

Trigger 
about ................................................. 95 
averaging triggered sweeps .... 99, 185 
creating new files ........................... 105 
digital output .................................. 130 
Manual Trigger ............................... 123 
show pre-trigger times ................... 112 
stop recording on trigger .............. 105 
Trigger Detector ............................. 125 
trigger event list ............................. 129 
Triggered Data .................................. 98 
Triggered recording ......................... 98 
triggering on biological signals ..... 127 
triggering on TTL pulses ................ 125 

Triggered recorder 102 
create new file on trigger .............. 102 
stop on trigger ................................ 102 

TTL 
digital output .................................. 130 
triggering on TTL pulses ................ 125 

U 
Unload Image 116 

USB 
data acquisition ................................ 73 
USB-ME128-System ............................. 9 
USB-ME16-FAI-System ........................ 9 
USB-ME256-System ............................. 9 
USB-ME32-FAI-System ........................ 9 
USB-ME64-System ............................... 9 
USB-MEA256-System .................... 9, 23 
 
Wireless System ................................. 70 

V 
View 

Data Display .................................... 118 
Digital Display ................................. 121 
Longterm Display .............................. 36 
Parameter Display ........................... 178 

Voltage 
range ................................................. 88 

W 



MC_Rack Manual 

194 

W8-System 33, 73 

Wait 
automatic trigger ............................ 129 

White 
display background color ............... 112 

Window 
spike sorting .................................... 165 

time window ............................. 98, 173 
Window Extent ........................... 47, 98 

Wireless Recording System 33, 73 

Wireless System 
Wireless System W4 .......................... 70 
Wireless System W8 .......................... 70 



 

195 

 


